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Configuring vRealize Automation

Configuring vRealize Automation provides information about configuring vRealize Automation
and your external environments to prepare for vRealize Automation provisioning and catalog
management.

Intended Audience

This information is intended for IT professionals who are responsible for configuring vRealize
Automation environment, and for infrastructure administrators who are responsible for preparing
elements in their existing infrastructure for use in vRealize Automation provisioning. The
information is written for experienced Windows and Linux system administrators who are familiar
with virtual machine technology and datacenter operations.

VMware Technical Publications Glossary

VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For
definitions of terms as they are used in VMware technical documentation, go to http://
www.vmware.com/support/pubs.
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Updated Information

This Configuring vRealize Automation is updated with each release of the product or when
necessary.

This table provides the update history of the Configuring vRealize Automation.

Revision Description
16 NOV 2018  Minor edits.
05 OCT 2018  Minor edits.

15 JUN 2018

Updated Configure an OpenLDAP Directory Connection

m  Updated Configure Directories Management for High Availability and added Enable Directory Sync on
a Secondary Connector to provide more information about working with connectors in a high
availability configuration.

m  Updated Create a Puppet Endpoint.

m Minor edits.

03 MAY 2018 Minor edits.

m  Added information about Azure Supported Regions.

12 APR 2018 Initial release.
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External Preparations for
Blueprint Provisioning

You may need to create or prepare some elements outside of vRealize Automation to support
catalog item provisioning. For example, if you want to provide a catalog item for provisioning a
clone machine, you need to create a template on your hypervisor to clone from.

This chapter includes the following topics:

m  Preparing Your Environment for vRealize Automation Management
m  Configure Network-to-Azure VPC Connectivity

m  Preparing for Machine Provisioning

m  Preparing for Software Provisioning

Preparing Your Environment for vRealize Automation
Management
Depending on your integration platform, you might have to make some configuration changes

before you can bring your environment under vRealize Automation management, or before you
can leverage certain features.

Table 1-1. Preparing Your Environment for vRealize Automation Integration

Environment Preparations
WTTIVEITES If you want to leverage NSX to manage
"q S x NSX networking and security features of

machines provisioned with vRealize

Automation, prepare your NSX instance for

integration. See Checklist for Preparing

NSX Network and Security Configuration.
& vCloud Director Install and configure your vCloud Director
instance, set up your vSphere and cloud
resources, and identify or create
appropriate credentials to provide vRealize
Automation with access to your vCloud
Director environment. See Preparing Your
vCloud Director Environment for vRealize
Automation .
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Table 1-1. Preparing Your Environment for vRealize Automation Integration (continued)

Environment

0 vCloud Air

- Amazon AWS

Microsoft Azure

0 Red Hat OpenStack

¥ scvmm

External IPAM Providers

All other environments

Preparations

Register for your vCloud Air account, set
up your vCloud Air environment, and
identify or create appropriate credentials to
provide vRealize Automation with access to
your environment. See Preparing for
vCloud Air and vCloud Director
Provisioning.

Prepare elements and user roles in your
Amazon AWS environment for use in
VvRealize Automation, and understand how
Amazon AWS features map to vRealize
Automation features. See Preparing Your
Amazon AWS Environment.

Configure networking to use VPN tunneling
to support Software components on Azure
blueprints. See Configure Network-to-
Azure VPC Connectivity.

If you want to leverage Red Hat OpenStack
to manage networking and security
features of machines provisioned with
vRealize Automation, prepare your Red Hat
OpenStack instance for integration. See
Preparing Red Hat OpenStack Network and
Security Features.

Configure storage, networking, and
understand template and hardware profile
naming restrictions. See Preparing Your
SCVMM Environment.

Register an external IPAM provider
package or plug-in, run the configuration
workflows, and register the IPAM solution
as a new VRealize Automation endpoint.
See Checklist For Providing Third-Party
IPAM Provider Support.

You do not need to make changes to your
environment. You can begin preparing for
machine provisioning by creating
templates, boot environments, or machine
images. See Preparing for Machine
Provisioning.

Checklist for Preparing NSX Network and Security Configuration

Before you can use NSX network and security options in vRealize Automation, you must
configure the external NSX network and security environment that you intend to use.

VMware, Inc.
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Beginning in vRealize Automation 7.3, you no longer need to install the NSX plug-in to obtain
integrated NSX functionality. All integrated NSX functionality is now sourced directly from the
NSX APIs, rather than from the NSX plug-in. However, if you want to use XaaS to extend your
vRealize Automation and NSX integration, you must install the NSX plug-in in vRealize
Orchestrator as described here.

In preparation for using NSX network, security, and load balancing capabilities in vRealize
Automation, when using NSX Manager credentials you must use the NSX Manager administrator
account.

For related information about NSX, see NSX documentation at https://www.vmware.com/
support/pubs/nsx_pubs.html and public blogs and articles such as Integrating NSX with vRealize
Automation.

Much of the vRealize Automation support for network and security configuration that you specify
in blueprints and reservations is configured externally and made available to vRealize Automation
after data collection is run on the compute resources.

For more information about NSX settings that you can configure for vRealize Automation
blueprints, see Configuring Network and Security Component Settings.

Table 1-2. Preparing NSX Networking and Security Checklist

Task Location Details

U Configure NSX Configure network settings in NSX. See the NSX Administration Guide.
network settings,

including gateway

and transport

zone settings.

U Create NSX Configure security settings in NSX. See the NSX Administration Guide.
security policies,
tags, and groups.

U Configure NSX Configure an NSX load balancer to work with vRealize See the NSX Administration Guide.
load balancer Automation. Also see Custom Properties for
settings. Networking in Custom Properties
Reference.
O For cross-virtual  vRealize Automation provisioning requires that the See Administrator Requirements for
center compute NSX manager for the region in which the Provisioning NSX Universal Objects.
deployments, machines reside has the primary NSX manager role. See the NSX Installation Guide and
verify that the NSX Administration Guide for
compute NSX information about cross-virtual center
manager has the deployment, universal objects, and the
primary NSX primary NSX manager role.

manager role.

Install the NSX Plug-In on vRealize Orchestrator

Installing the NSX plug-in requires that you download the vRealize Orchestrator installer file, use
the vRealize Orchestrator Configuration interface to upload the plug-in file, and install the plug-in
on a vRealize Orchestrator server.

VMware, Inc. 10
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For general plug-in update and troubleshooting information, see vRealize Orchestrator
documentation.

Prerequisites

Beginning in vRealize Automation 7.3, you no longer need to install the NSX plug-in to obtain
integrated NSX functionality. All integrated NSX functionality is now sourced directly from the
NSX APIs, rather than from the NSX plug-in. However, if you want to use XaaS to extend your
vRealize Automation and NSX integration, you must install the NSX plug-in in vRealize
Orchestrator as described here.

If you are using an embedded vRealize Orchestrator that already contains an installed NSX plug-
in, you can skip this procedure.

m  Verify that you are running a supported vRealize Orchestrator instance.

For information about setting up vRealize Orchestrator, see Installing and Configuring
VMware vRealize Orchestrator.

m  Verify that you have credentials for an account with permission to install vRealize
Orchestrator plug-ins and to authenticate through vCenter Single Sign-On.

m  Verify that you installed the vRealize Orchestrator client and that you can log in with
Administrator credentials.

m  Confirm the correct version of the NSX plug-in in the vRealize Automation support matrix.

Procedure
1 Download the plug-in file to a location accessible from the vRealize Orchestrator server.

The plug-in installer file name format, with appropriate version values, is o11nplugin-
nsx-1.n.n.vmoapp. Plug-in installation files for the NSX networking and security product are
available from the VMware product download site at http://vmware.com/web/vmware/
downloads.

2 Open a browser and start the vRealize Orchestrator configuration interface.
An example of the URL format is https://orchestrator_server.com:8283.

3 Click Plug-Ins in the left pane and scroll down to the Install new plug-in section.

4 In the Plug-In file text box, browse to the plug-in installer file and click Upload and install.
The file must be in .vmoapp format.

5 At the prompt, accept the license agreement in the Install a plug-in pane.

6 In the Enabled plug-ins installation status section, confirm that the correct NSX plug-in name
is specified.

See vRealize Automation Support Matrix for version information.
The status Plug-in will be installed at next server startup, appears.

7 Restart the vRealize Orchestrator server service.

VMware, Inc. n
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8 Restart the vRealize Orchestrator configuration interface.
9 Click Plug-Ins and verify that the status changed to Installation OK.

10 Start the vRealize Orchestrator client application, log in, and use the Workflow tab to
navigate through the library to the NSX folder.

You can browse through the workflows that the NSX plug-in provides.

What to do next
Create a vRealize Orchestrator endpoint in vRealize Automation to use for running workflows.

See Create a vRealize Orchestrator Endpoint.

Run a vRealize Orchestrator and NSX Security Workflow

Before you use the NSX security policy features from vRealize Automation, an administrator must
run the Enable security policy support for overlapping subnets workflow in vRealize
Orchestrator.

Security policy support for the overlapping subnets workflow is applicable to an NSX 6.1 and later
endpoint. Run this workflow only once to enable this support.

Prerequisites

m  Verify that a vSphere endpoint is registered with an NSX endpoint. See Create a vSphere
Endpoint.

m  Login to the vRealize Orchestrator client as an administrator.

m  Verify that you ran the Create NSX endpoint vRO work flow.

Procedure
1 Click the Workflow tab and select NSX > NSX workflows for VCAC.

2 Run the Create NSX endpoint workflow and respond to prompts.

3 Run the Enable security policy support for overlapping subnets workflow.
4 Select the NSX endpoint as the input parameter for the workflow.

Use the IP address you specified when you created the vSphere endpoint to register an NSX
instance.

Results

After you run this workflow, the distributed firewall rules defined in the security policy are applied
only on the vNICs of the security group members to which this security policy is applied.

What to do next

Apply the applicable security features for the blueprint.

VMware, Inc. 12



Configuring vRealize Automation

Administrator Requirements for Provisioning NSX Universal Objects

To provision machines in a cross vCenter NSX environment when using NSX universal objects,
you must provision to a vCenter in which the NSX compute manager has the primary role.

In a cross vCenter NSX environment, you can have multiple vCenter servers, each of which must
be paired with its own NSX manager. One NSX manager is assigned the role of primary NSX
manager, and the others are assigned the role of secondary NSX manager.

The primary NSX manager can create universal objects, such as universal logical switches. These
objects are synchronized to the secondary NSX managers. You can view these objects from the
secondary NSX managers, but you cannot edit them there. You must use the primary NSX
manager to manage universal objects. The primary NSX manager can be used to configure any
of the secondary NSX managers in the environment.

For more information about the NSX cross-vCenter environment, see Overview of Cross-vCenter
Networking and Security in the NSX Administration Guide in the NSX product documentation.

For a vSphere (vCenter) endpoint that is associated to the NSX endpoint of a primary NSX
manager, vVRealize Automation supports NSX local objects, such as local logical switches, local
edge gateways, and local load balancers, security groups, and security tags. It also supports NAT
one-to-one and one-to-many networks with universal transport zone, routed networks with
universal transport zone and universal distributed logical routers (DLRs), and a load balancer with
any type of network.

vRealize Automation does not support NSX existing and on-demand universal security groups or
tags.

To provision local on-demand networks as the primary NSX manager, use a vCenter-specific local
transport zone. You can configure vRealize Automation reservations to use the local transport
zone and virtual wires for deployments in that local vCenter.

If you connect a vSphere (vCenter) endpoint to a corresponding secondary NSX manager
endpoint, you can only provision and use local objects.

You can only associate an NSX endpoint to one vSphere endpoint. This association constraint
means that you cannot provision a universal on-demand network and attach it to vSphere
machines that are provisioned on different vCenters.

vRealize Automation can consume an NSX universal logical switch as an external network. If a
universal switch exists, it is data-collected and then attached to or consumed by each machine in
the deployment.

m  Provisioning an on-demand network to a universal transport zone can create a new universal
logical switch.

m  Provisioning an on-demand network to a universal transport zone on the primary NSX
manager creates a universal logical switch.

m  Provisioning an on-demand network to a universal transport zone on a secondary NSX
manager fails, as NSX cannot create a universal logical switch on a secondary NSX manager.

VMware, Inc. 13
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See the VMware Knowledge Base article Deployment of vRealize Automation blueprints with
NSX objects fail (2147240) at http://kb.vmware.com/kb/2147240 for more information about NSX
universal objects.

Checklist For Providing Third-Party IPAM Provider Support

You can obtain IP addresses and ranges for use in network profile definition from a supported
third-party IPAM provider, such as Infoblox.

Before you can create and use an external IPAM provider endpoint in a vRealize Automation
network profile, you must download or otherwise obtain a vRealize Orchestrator IPAM provider
plug-in or package, import the plug-in or package and run required workflows in vRealize
Orchestrator, and register the IPAM solution as a vRealize Automation endpoint.

For an overview of the provisioning process for using an external IPAM provider to supply a
range of possible IP addresses, see Provisioning a vRealize Automation Deployment Using a
Third-Party IPAM Provider.

Table 1-3. Preparing for External IPAM Provider Support Checklist

Task

U Obtain and
import the
supported
external IPAM
Provider vRealize
Orchestrator plug-
in.

U Run the
required
configuration
workflows and
register the
external IPAM
solution as a
vRealize
Automation
endpoint.

VMware, Inc.

Description

Download the IPAM provider plug-in or package, for
example The Infoblox IPAM Plug-in for vRealize
Orchestrator plug-in and supporting documentation, from
the VMware Solution Exchange (https://
solutionexchange.vmware.com/store/category_groups/
cloud-management) and import the plug-in or package to
VRealize Orchestrator.

If the VMware Solution Exchange does not contain the
IPAM provider package that you need, you can create
your own by using a third-party IPAM Solution Provider
SDK and supporting documentation.

A vRealize Automation version-specific third-party IPAM
Solution Provider SDK, supporting documentation, and
associated starter package for vRealize Orchestrator and
VvRealize Automation is available at https://
code.vmware.com/sdks or https://code.vmware.com/
samples.

Run the vRealize Orchestrator configuration workflows
and register the IPAM provider endpoint type in vRealize
Orchestrator.

Details

See Obtain and Import a Third-Party
IPAM Provider Package in vRealize
Orchestrator.

See Run Workflow to Register Third-
Party IPAM Endpoint Type in vRealize
Orchestrator.
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Obtain and Import a Third-Party IPAM Provider Package in vRealize Orchestrator

To prepare to define and use an third-party IPAM provider endpoint, you must first obtain the
third-party IPAM provider package and import the package in vRealize Orchestrator.

You can download and use an existing third-party IP Address Management provider plug-in, such
as Infoblox IPAM. You can also create your own third-party IPAM plug-in or package by using a
VMware-supplied starter package and accompanying SDK documentation for use with another
third-party IPAM solution provider, such as BlueCat.

= Obtain the existing Infoblox IPAM Plug-in for vRealize Orchestrator plug-in and supporting
documentation from marketplace.vmware.com. The download also contains documentation
for installing and using the plug-in.

m  Create your own third-party IPAM solution by obtaining and using a third-party IPAM Solution
Provider SDK, supporting documentation, and an associated starter package for vRealize
Orchestrator and vRealize Automation. See the vRealize Automation Example Third-Party
IPAM Package page at code.vmware.com/web/sdk.

After you import the third-party IPAM provider plug-in or package in vRealize Orchestrator, you
must run the required workflows, and register the IPAM endpoint type in vRealize Orchestrator.

For more information about importing plug-ins and packages and running vRealize Orchestrator
workflows, see Using the VMware vRealize Orchestrator Client. For more information about
extending vRealize Automation with vRealize Orchestrator plug-ins, packages, and workflows,
see Life Cycle Extensibility.

This step sequence uses the Infoblox IPAM plug-in as an example. Your step sequence may differ
depending on your vRealize Automation or plug-in version.

Prerequisites
m  Download the package or plug-in from marketplace.vmware.com.

m  Login to vRealize Orchestrator with administrator privileges for importing, configuring, and
registering a vRealize Orchestrator plug-in or package.

Procedure
1 Open the marketplace.vmware.com site.
2 Locate and download the plug-in or package.

For example, import the Infoblox plug-in that supports the Infoblox third-party IPAM endpoint
in VRealize Orchestrator and vRealize Automation 7.1 and later.

a In the Publisher category, select Infoblox and click Apply.
b Select The Infoblox Plug-in for vRealize Orchestrator.

¢ Click Tech Specs and review the prerequisites.

VMware, Inc. 15


https://marketplace.vmware.com/vsx/solutions/infoblox-ipam-for-vrealize-automation
https://code.vmware.com/web/sdk/7.3%20or%20later/vrealize-automation-third-party-ipam-integration
https://code.vmware.com/web/sdk/7.3%20or%20later/vrealize-automation-third-party-ipam-integration
http://code.vmware.com/web/sdk
https://marketplace.vmware.com/vsx/
https://marketplace.vmware.com/vsx/
https://marketplace.vmware.com/vsx/solutions/the-infoblox-ipam-plug-in-for-vrealize-orchestrator

Configuring vRealize Automation

4

5

d Click Try for additional information and to receive an email that contains a link to the
download.

e Download the zip file as specified in the emailed instructions.

Version 4.0 and greater of the plug-in supports vRealize Automation 7.1 and greater. The
zip file also contains documentation about the plug-in.

In vRealize Orchestrator, click the Administrator tab and click Import package.
Select the package to import.

Select all workflows and artifacts and click Import selected elements.

What to do next

Run Workflow to Register Third-Party IPAM Endpoint Type in vRealize Orchestrator.

Run Workflow to Register Third-Party IPAM Endpoint Type in vRealize
Orchestrator

Run the registration workflow in vRealize Orchestrator to support vRealize Automation use of the
third-party IPAM provider and register the IPAM endpoint type for use in vRealize Automation.

Prerequisites

Obtain and Import a Third-Party IPAM Provider Package in vRealize Orchestrator

Verify that you are logged in to vRealize Orchestrator with the authority to run registration
workflows.

Be prepared to enter the vRealize Automation administrator credentials when prompted by
the registration workflow. When you register IPAM endpoint types in vRealize Orchestrator,
you are prompted to enter vRealize Automation administrator credentials.

Procedure

1

In vRealize Orchestrator, click the Design tab, select Administrator > Library, and select IPAM
Service Package SDK.

Each IPAM provider package is uniquely named and contains unique workflows. Each
provider supplies their own registration workflow. While the workflow names might be similar
between provider packages, the location of the workflows in vRealize Orchestrator can be
different and is provider-specific.

For this example, run the Register IPAM Endpoint registration workflow and specify the
IPAM Infloblox endpoint type.
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3 At the prompt for vRealize Automation credentials, enter your vRealize Automation
administrator credentials, for example fabric administrator credentials.

You must supply the registration workflow with vRealize Automation system administrator
credentials. Even if a non-system administrator user is logged in to the vRealize Orchestrator
client, if the vRealize Automation system administrator credentials are provided to the
workflow the registration will succeed.

Results

In this example, the package registers Infoblox as a new IPAM endpoint type in the vRealize
Automation endpoint service and makes the endpoint type available when you create or edit
endpoints in vRealize Automation.

Note If the Infoblox IPAM connection disappears from the vRealize Orchestrator Inventory tab
after you restart the vRealize Orchestrator server in the vRealize Orchestrator Control Center. To
resolve this issue, run the Create IPAM Connection workflow from the vRO admin > Library >
Infoblox > VRA > Helpers menu sequence. You can then the vRealize Orchestrator Inventory tab,
select Infoblox IPAM, and refresh the page to display the Infoblox IPAM connection.

What to do next

You can now create an IPAM Infloblox type endpoint, or and endpoint for whatever third-party
package or plug-in you have just registered, in vRealize Automation. See Create a Third-Party
IPAM Provider Endpoint.

Checklist for Configuring Containers for vRealize Automation

To get started with Containers, you must configure the feature to support vRealize Automation
user roles.

After you configure container definitions in Containers you can add and configure container
components in a blueprint.

Table 1-4. Checklist for Configuring Containers for vRealize Automation

Task Details

Assign the container administrator and container architect roles. See Container roles information in Foundations
and Concepts.

Define container definitions in the Containers tab in vRealize See Configuring vRealize Automation.
Automation.

Add container components and container networking components to  See Configuring vRealize Automation.
blueprints in the Design tab in vRealize Automation.

Configuring Containers Using the vRealize Automation Appliance

Xenon service information is accessible in the vRealize Automation vRealize Automation
appliance (VRA Settings > Xenon.
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It contains information about the Xenon host VM, listening port, and service status. It also
displays information about clustered Xenon nodes.

You can manage the Xenon Linux service with the following CLI commands in the vRealize
Automation appliance.

Command Description

service xenon-service status Shows the status of the service as either running or stopped.
service xenon-service start Starts the service.

service xenon-service stop Stops the service.

service xenon-service restart Restarts the service.

service xenon-service get_host Shows the hostname on which the service is running.
service xenon-service get_port Shows the service port.

service xenon-service status_cluster Shows information about all clustered nodes in JSON format.

service xenon-service reset Deletes the directory where Xenon keeps all configuration files and restarts
the service.
Clustering Containers

You can use the Xenon service in conjunction with Containers for vRealize Automation to join
nodes to a cluster. If the nodes are clustered, the Xenon service connects other nodes
automatically when it starts.

You can monitor the cluster status on the Xenon tab in the vRealize Automation appliance or by
running the following command in a CLI:

service xenon-service status_cluster

Xenon works on quorum-based clustering. The quorum is calculated by using the (number of
nodes / 2) + 1 formula.

Preparing Your vCloud Director Environment for vRealize
Automation

Before you can integrate vCloud Director with vRealize Automation, you must install and
configure your vCloud Director instance, set up your vSphere and cloud resources, and identify
or create appropriate credentials to provide vRealize Automation with access to your vCloud
Director environment.

Configure Your Environment

Configure your vSphere resources and cloud resources, including virtual datacenters and
networks. For more information, see the vCloud Director documentation.
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Required Credentials for Integration

Create or identify either organization administrator or system administrator credentials that your
vRealize Automation laaS administrators can use to bring your vCloud Director environment
under vRealize Automation management as an endpoint.

User Role Considerations

vCloud Director user roles in an organization do not need to correspond with roles in vRealize
Automation business groups. If the user account does not exist in vCloud Director, vCloud
Director performs a lookup in the associated LDAP or Active Directory and creates the user
account if the user exists in the identity store. If it cannot create the user account, it logs a
warning but does not fail the provisioning process. The provisioned machine is then assigned to
the account that was used to configure the vCloud Director endpoint.

For related information about vCloud Director user management, see the vCloud Director
documentation.

Preparing Your vCloud Air Environment for vRealize Automation

Before you integrate vCloud Air with vRealize Automation, you must register for your vCloud Air
account, set up your vCloud Air environment, and identify or create appropriate credentials to
provide vRealize Automation with access to your environment.

Configure Your Environment

Configure your environment as instructed in the vCloud Air documentation.

Required Credentials for Integration

Create or identify either virtual infrastructure administrator or account administrator credentials
that your vRealize Automation laaS administrators can use to bring your vCloud Air environment
under vRealize Automation management as an endpoint.

User Role Considerations

vCloud Air user roles in an organization do not need to correspond with roles in vRealize
Automation business groups. For related information about vCloud Air user management, see the
vCloud Air documentation.

Preparing Your Amazon AWS Environment

Prepare elements and user roles in your Amazon AWS environment, prepare Amazon AWS to
communicate with the guest agent and Software bootstrap agent, and understand how Amazon
AWS features map to vRealize Automation features.

Amazon AWS User Roles and Credentials Required for vRealize Automation

You must configure credentials in Amazon AWS with the permissions required for vRealize
Automation to manage your environment.
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vRealize Automation requires access keys for endpoint credentials and does not support user
names and passwords.

m  Role and Permission Authorization in Amazon Web Services

While the Power User role in AWS provides an AWS Directory Service user or group with full
access to AWS services and resources, it is not required. Lower privileged user roles are also
supported. The AWS security policy that meets the needs of vRealize Automation
functionality is:

"Version": "2012-10-17",

"Statement": [{
"Effect": "Allow",
"Action": [

ec2:DescribeInstances",

ec2:DescribeImages”,

ec2:DescribeKeyPairs",

ec2:DescribeVpcs",

ec2:DescribeSubnets",

ec2:DescribeSecurityGroups"”,

ec2:DescribeVolumes",

ec2:DescribeVpcAttribute",

ec2:DescribeAddresses",

ec2:DescribeAvailabilityZones",

ec2:DescribeImageAttribute”,

ec2:DescribeInstanceAttribute",

ec2:DescribeVolumeStatus",

ec2:DescribeVpnConnections”,

ec2:DescribeRegions”,

ec2:DescribeTags",

ec2:DescribeVolumeAttribute",

ec2:DescribeNetworkInterfaces",

ec2:DescribeNetworkInterfaceAttribute",

ec2:DisassociateAddress",

ec2:GetPasswordData",

ec2:ImportKeyPair",

ec2:ImportVolume",

ec2:CreateVolume",

ec2:DeleteVolume",
"ec2:AttachVolume",
"ec2:ModifyVolumeAttribute",
ec2:DetachVolume",

ec2:AssignPrivateIpAddresses"”,

ec2:UnassignPrivateIpAddresses”,

ec2:CreateKeyPair",

ec2:DeleteKeyPair",
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"ec2:CreateTags",
"ec2:AssociateAddress",
"ec2:ReportInstanceStatus",
"ec2:StartInstances"”,
"ec2:StopInstances",
"ec2:ModifyInstanceAttribute",
"ec2:MonitorInstances",
"ec2:RebootInstances",
"ec2:RunInstances",
"ec2:TerminateInstances",

"elasticloadbalancing:RegisterInstancesWithLoadBalancer",
"elasticloadbalancing:DeregisterInstancesFromLoadBalancer",
"elasticloadbalancing:DescribelLoadBalancerAttributes",
"elasticloadbalancing:DescribelLoadBalancers",
"elasticloadbalancing:DescribeInstanceHealth"

1,

"Resource":

ngn

13

m  Authentication Credentials in Amazon Web Services

For management of Amazon Identity and Access Management (IAM) users and groups, you
must be configured with AWS Full Access Administrator credentials.

When you create an AWS endpoint in VRA, you're prompted to enter a key and secret key. To
obtain the access key needed to create the Amazon endpoint, the administrator must either
request a key from a user who has AWS Full Access Administrator credentials or be additionally
configured with the AWS Full Access Administrator policy. See Create an Amazon Endpoint.

For information about enabling policies and roles, see the AWS Identity and Access Management
(IAM) section of Amazon Web Services product documentation.

Allow Amazon AWS to Communicate with the Software Bootstrap Agent and
Guest Agent

If you intend to provision application blueprints that contain Software, or if you want the ability to
further customize provisioned machines by using the guest agent, you must enable connectivity
between your Amazon AWS environment, where your machines are provisioned, and your
vRealize Automation environment, where the agents download packages and receive
instructions.

When you use vRealize Automation to provision Amazon AWS machines with the vRealize
Automation guest agent and Software bootstrap agent, you must set up network-to-Amazon
VPC connectivity so your provisioned machines can communicate back to vRealize Automation
to customize your machines.

For more information about Amazon AWS VPC connectivity options, see the Amazon AWS
documentation.
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Using Optional Amazon Features

vRealize Automation supports several Amazon features, including Amazon Virtual Private Cloud,
elastic load balancers, elastic IP addresses, and elastic block storage.

Using Amazon Security Groups

Specify at least one security group when creating an Amazon reservation. Each available region
requires at least one specified security group.

A security group acts as a firewall to control access to a machine. Every region includes at least
the default security group. Administrators can use the Amazon Web Services Management
Console to create additional security groups, configure ports for Microsoft Remote Desktop
Protocol or SSH, and set up a virtual private network for an Amazon VPN.

When you create an Amazon reservation or configure a machine component in the blueprint, you
can choose from the list of security groups that are available to the specified Amazon account
region. Security groups are imported during data collection.

For information about creating and using security groups in Amazon Web Services, see Amazon

documentation.

Understanding Amazon Web Service Regions

Each Amazon Web Services account is represented by a cloud endpoint. When you create an
Amazon Elastic Cloud Computing endpoint in vRealize Automation, regions are collected as
compute resources. After the laaS administrator selects compute resources for a business group,
inventory and state data collections occur automatically.

Inventory data collection, which occurs automatically once a day, collects data about what is on a
compute resource, such as the following data:

m Elastic IP addresses
m  Elastic load balancers
m Elastic block storage volumes

State data collection occurs automatically every 15 minutes by default. It gathers information
about the state of managed instances, which are instances that vRealize Automation creates. The
following are examples of state data:

s Windows passwords
m  State of machines in load balancers
m Elastic IP addresses

A fabric administrator can initiate inventory and state data collection and deactivate or change
the frequency of inventory and state data collection.
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Using Amazon Virtual Private Cloud

Amazon Virtual Private Cloud allows you to provision Amazon machine instances in a private
section of the Amazon Web Services cloud.

Amazon Web Services users can use Amazon VPC to design a virtual network topology
according to your specifications. You can assign an Amazon VPC in vRealize Automation.
However, vRealize Automation does not track the cost of using the Amazon VPC.

When you provision using Amazon VPC, vRealize Automation expects there to be a VPC subnet
from which Amazon obtains a primary IP address. This address is static until the instance is
terminated. You can also use the elastic IP pool to also attach an elastic IP address to an instance
in vRealize Automation. That would allow the user to keep the same IP if they are continually
provisioning and tearing down an instance in Amazon Web Services.

Use the AWS Management Console to create the following elements:

= An Amazon VPC, which includes Internet gateways, routing table, security groups and
subnets, and available IP addresses.

m  An Amazon Virtual Private Network if users need to log in to Amazon machines instances
outside of the AWS Management Console.

vRealize Automation users can perform the following tasks when working with an Amazon VPC:

m A fabric administrator can assign an Amazon VPC to a cloud reservation. See Create an
Amazon EC2 Reservation.

m A machine owner can assign an Amazon machine instance to an Amazon VPC.

For more information about creating an Amazon VPC, see Amazon Web Services documentation.

Using Elastic Load Balancers for Amazon Web Services

Elastic load balancers distribute incoming application traffic across Amazon Web Services
instances. Amazon load balancing enables improved fault tolerance and performance.

Amazon makes elastic load balancing available for machines provisioned using Amazon EC2
blueprints.

The elastic load balancer must be available in the Amazon Web Services, Amazon Virtual Private
Network and at the provisioning location. For example, if a load balancer is available in us-eastic
and a machine location is us-eastlb, the machine cannot use the available load balancer.

vRealize Automation does not create, manage, or monitor the elastic load balancers.

For information about creating Amazon elastic load balancers by using the Amazon Web
Services Management Console, see Amazon Web Services documentation.

Using Elastic IP Addresses for Amazon Web Services

Using an elastic IP address allows you to rapidly fail over to another machine in a dynamic
Amazon Web Services cloud environment. In vRealize Automation, the elastic IP address is
available to all business groups that have rights to the region.
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An administrator can allocate elastic IP addresses to your Amazon Web Services account by
using the AWS Management Console. There are two groups of elastic IP addresses in any given a
region, one range is allocated for non-Amazon VPC instances and another range is for Amazon
VPCs. If you allocate addresses in a non-Amazon VPC region only, the addresses are not
available in an Amazon VPC. The reverse is also true. If you allocate addresses in an Amazon VPC
only, the addresses are not available in a non-Amazon VPC region.

The elastic IP address is associated with your Amazon Web Services account, not a particular
machine, but only one machine at a time can use the address. The address remains associated
with your Amazon Web Services account until you choose to release it. You can release it to map
it to a specific machine instance.

An laa$S architect can add a custom property to a blueprint to assign an elastic IP address to
machines during provisioning. Machine owners and administrators can view the elastic IP
addresses assigned to machines, and machine owners or administrators with rights to edit
machines can assign an elastic IP addresses after provisioning. However, if the address is already
associated to a machine instance, and the instance is part of the Amazon Virtual Private Cloud
deployment, Amazon does not assign the address.

For more information about creating and using Amazon elastic IP addresses, see Amazon Web
Services documentation.

Using Elastic Block Storage for Amazon Web Services

Amazon elastic block storage provides block level storage volumes to use with an Amazon
machine instance and Amazon Virtual Private Cloud. The storage volume can persist past the life
of its associated Amazon machine instance in the Amazon Web Services cloud environment.

When you use an Amazon elastic block storage volume in conjunction with vRealize Automation,
the following caveats apply:

m  You cannot attach an existing elastic block storage volume when you provision a machine
instance. However, if you create a new volume and request more than one machine at a time,
the volume is created and attached to each instance. For example, if you create one volume
named volume_1 and request three machines, a volume is created for each machine. Three
volumes named volume_1 are created and attached to each machine. Each volume has a
unique volume ID. Each volume is the same size and in the same location.

m  The volume must be of the same operating system and in the same location as the machine
to which you attach it.

m  VvRealize Automation does not manage the primary volume of an elastic block storage-backed
instance.

For more information about Amazon elastic block storage, and details on how to enable it by
using Amazon Web Services Management Console, see Amazon Web Services documentation.
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Configure Network-to-Amazon VPC Connectivity for a Proof of Concept
Environment

As the IT professional setting up an environment to evaluate vRealize Automation, you want to
temporarily configure network-to-Amazon VPC connectivity to support the vRealize Automation
Software feature.

Network-to-Amazon VPC connectivity is only required if you want to use the guest agent to
customize provisioned machines, or if you want to include Software components in your
blueprints. For a production environment, you would configure this connectivity officially through
Amazon Web Services, but because you are working in a proof of concept environment, you
want to create temporary network-to-Amazon VPC connectivity. You establish the SSH tunnel
and then configure an Amazon reservation in vRealize Automation to route through your tunnel.

Prerequisites

m  Create an Amazon AWS security group called TunnelGroup and configure it to allow access
on port 22.

m  Create or identify a CentOS machine in your Amazon AWS TunnelGroup security group and
note the following configurations:

= Administrative user credentials, for example root.
m  Public IP address.
m  Private IP address.

m Create or identify a CentOS machine on the same local network as your vRealize Automation
installation.

m  Install OpenSSH SSHD Server on both tunnel machines.

Procedure
1 Loginto your Amazon AWS tunnel machine as the root user or similar.

2 Deactivate iptables.
# service iptables save

# service iptables stop
# chkconfig iptables off

3 Edit /etc/ssh/sshd_config to enable Al1lowTCPForwarding and GatewayPorts.

4 Restart the service.

/etc/init.d/sshd restart

5 Loginto the CentOS machine on the same local network as your vRealize Automation
installation as the root user.
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6 Invoke the SSH Tunnel from the local network machine to the Amazon AWS tunnel machine.
ssh =N —-v -0 "ServerAliveInterval 30" -o "ServerAliveCountMax 40" -o "TCPKeepAlive yes” \

—R 1442:vRealize_automation_appliance_1fqdn:5480 \

—-R 1443:vRealize_automation_appliance_fqdn:443 \

—-R 1444:manager_service_fqgdn:443 \

User of Amazon tunnel machine@Public IP Address of Amazon tunnel machine

You configured port forwarding to allow your Amazon AWS tunnel machine to access
vRealize Automation resources, but your SSH tunnel does not function until you configure an
Amazon reservation to route through the tunnel.

What to do next

1 Install the software bootstrap agent and the guest agent on a Windows or Linux reference
machine to create an Amazon Machine Image that your laaS architects can use to create
blueprints. See Preparing for Software Provisioning.

2 Configure your Amazon reservation in vRealize Automation to route through your SSH tunnel.
See Scenario: Create an Amazon Reservation for a Proof of Concept Environment.

Preparing Red Hat OpenStack Network and Security Features

vRealize Automation supports several features in OpenStack including security groups and
floating IP addresses. Understand how these features work with vRealize Automation and
configure them in your environment.

Using OpenStack Security Groups

Security groups allow you to specify rules to control network traffic over specific ports.

You can specify security groups in a reservation when requesting a machine. You can also
specify an existing or on-demand NSX security group in the design canvas.

Security groups are imported during data collection.

Each available region requires at least one specified security group. When you create a
reservation, the available security groups that are available to you in that region are displayed.
Every region includes at least the default security group.

Additional security groups must be managed in the source resource. For more information about
managing security groups for the various machines, see the OpenStack documentation.

Using Floating IP Addresses with OpenStack

You can assign floating IP addresses to a running virtual instance in OpenStack.

To enable assignment of floating IP addresses, you must configure IP forwarding and create a
floating IP pool in Red Hat OpenStack. For more information, see the Red Hat OpenStack
documentation.
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You must entitle the Associate Floating IP and Disassociate Floating IP actions to machine
owners. The entitled users can then associate a floating IP address to a provisioned machine
from the external networks attached to the machine by selecting an available address from the
floating IP address pool. After a floating IP address has been associated with a machine, a
vRealize Automation user can select a Disassociate Floating IP option to view the currently
assigned floating IP addresses and disassociate an address from a machine.

Preparing Your SCVMM Environment

Before you begin creating SCVMM templates and hardware profiles for use in vRealize
Automation machine provisioning, you must understand the naming restrictions on template and
hardware profile names, and configure SCVMM network and storage settings.

For related information about preparing your environment, see SCVMM requirements information
in Installing vRealize Automation.

For related information about machine provisioning, see Create a Hyper-V (SCVMM) Endpoint.

vRealize Automation does not support a deployment environment that uses an SCVMM private
cloud configuration. vRealize Automation cannot currently collect from, allocate to, or provision
based on SCVMM private clouds.

Template and Hardware Profile Naming

Because of naming conventions that SCVMM and vRealize Automation use for templates and
hardware profiles, do not start your template or hardware profile names with the words
temporary or profile. For example, the following terms are ignored during data collection:

m  TemporaryTemplate
m  Temporary Template
m  TemporaryProfile
m  Temporary Profile

m  Profile

Required Network Configuration for SCVMM Clusters

SCVMM clusters only expose virtual networks to vRealize Automation, so you must have a 1.1
relationship between your virtual and logical networks. Using the SCVMM console, map each
logical network to a virtual network and configure your SCVMM cluster to access machines
through the virtual network.

Required Storage Configuration for SCVMM Clusters

On SCVMM Hyper-V clusters, vRealize Automation collects data and provisions on shared
volumes only. Using the SCVMM console, configure your clusters to use shared resource volumes
for storage.
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Required Storage Configuration for Standalone SCVMM Hosts

For standalone SCVMM hosts, vRealize Automation collects data and provisions on the default
virtual machine path. Using the SCVMM console, configure default virtual machine paths for your
standalone hosts.

Configure Network-to-Azure VPC Connectivity

You must configure network-to-Azure connectivity if you want to use Software components in

Azure blueprints.

Prerequisites

Create an Azure security group called TunnelGroup and configure it to allow access on port
22.

Create or identify a machine, such as a CentOS machine, in your Azure TunnelGroup security
group and note the following configurations:

= Administrative user credentials, for example root.
m  Public IP address.
m  Private IP address.

Create or identify a CentOS machine on the same local network as your vRealize Automation
installation.

Install OpenSSH SSHD Server on both tunnel machines.

Procedure
1 Loginto your Azure tunnel machine as the root user or similar.
2 Deactivate iptables.
# service iptables save
# service iptables stop
# chkconfig iptables off
3 Edit /etc/ssh/sshd_config to enable AllowTCPForwarding and GatewayPorts.
4 Restart the service.
/etc/init.d/sshd restart
5 Login to the CentOS machine on the same local network as your vRealize Automation
installation as the root user.
6 Invoke the SSH Tunnel from the local network machine to the Azure tunnel machine.

ssh -N —v -0 "ServerAlivelnterval 30" -o "ServerAliveCountMax 40" -o "TCPKeepAlive yes” \
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—-R 1442:vRealize_automation_appliance_1fqdn:5480 \

—-R 1443:vRealize_automation_appliance_fqdn:443 \

—-R 1444:manager_service_fqgdn:443 \

User of Azure tunnel machine@Public IP Address of Azure tunnel machine

You configured port forwarding to allow your Azure tunnel machine to access vRealize
Automation resources, but your SSH tunnel does not function until you configure an Azure
reservation to route through the tunnel.

What to do next

1 Install the software bootstrap agent and the guest agent on a Windows or Linux reference
machine to create an Azure Machine Image that your laaS architects can use to create
blueprints. See Preparing for Software Provisioning.

2 Configure your Azure reservation in vRealize Automation to route through your SSH tunnel.

See Create a Reservation for Microsoft Azure .

Preparing for Machine Provisioning

Depending on your environment and your method of machine provisioning, you might need to
configure elements outside of vRealize Automation.

For example, you might need to configure machine templates or machine images. You might also

need to configure NSX settings or run vRealize Orchestrator workflows.

For related information about specifying ports when preparing to provision machines, see Secure

Configuration Guide and Reference Architecture at VMware vRealize Automation Information.

Choosing a Machine Provisioning Method to Prepare

For most machine provisioning methods, you must prepare some elements outside of vRealize
Automation.

VMware, Inc.

29


https://www.vmware.com/support/pubs/vrealize-automation-pubs.html

Configuring vRealize Automation

Table 1-5. Choosing a Machine Provisioning Method to Prepare

Scenario

Configure vRealize
Automation to run
custom Visual Basic
scripts as additional
steps in the machine life
cycle, either before or
after machine
provisioning. For
example, you could use a
pre-provisioning script to
generate certificates or
security tokens before
provisioning, and then a
post-provisioning script
to use the certificates
and tokens after machine
provisioning.

Provision application
blueprints that automate
the installation,
configuration, and life
cycle management of
middleware and
application deployment
components such as
Oracle, MySQL, WAR,
and database Schemas.

Further customize
machines after
provisioning by using the
guest agent.

Provision machines with
no guest operating
system. You can install
an operating system
after provisioning.
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Supported
Endpoint

You can
run Visual
Basic
scripts with
any
supported
endpoint
except
Amazon
AWS.

m  vSpher
e

m  vCloud
Air

m  vCloud
Directo
r

B Amazo
n AWS

All virtual
endpoints
and
Amazon
AWS.

All virtual
machine
endpoints.

Agent Support

Depends on the

provisioning
method you
choose.

m (Required)
Guest agent

m  (Required)
Software
bootstrap
agent and
guest agent

m (Required)
Guest agent

m  (Optional)
Software
bootstrap
agent and
guest agent

Not supported

Provisioning
Method

Supported as an
additional step in
any provisioning
method, but you
cannot use Visual
Basic scripts with
Amazon AWS
machines.

Clone

m  Clone (for
vCloud Air or
vCloud Director)

m Linked clone

m  Amazon Machine
Image

Supported for all
provisioning
methods except
Virtual Machine
Image.

Basic

Pre-provisioning Preparations

Checklist for Running Visual Basic
Scripts During Provisioning

If you want the ability to use
Software components in your
blueprints, prepare a provisioning
method that supports the guest
agent and Software bootstrap
agent. For more information about
preparing for Software, see
Preparing for Software
Provisioning.

If you want the ability to
customize machines after
provisioning, select a provisioning
method that supports the guest
agent. .

No required pre-provisioning
preparations outside of vRealize
Automation.
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Table 1-5. Choosing a Machine Provisioning Method to Prepare (continued)

Scenario

Provision a space-
efficient copy of a virtual
machine called a linked
clone. Linked clones are
based on a snapshot of a
VM and use a chain of
delta disks to track
differences from a
parent machine.

Provision a space-
efficient copy of a virtual
machine by using Net
App FlexClone
technology.

Provision machines by
cloning from a template
object created from an
existing Windows or
Linux machine, called the
reference machine, and a
customization object.

Provision vCloud Air or
vCloud Director
machines by cloning
from a template and
customization object.

Provision a machine by
booting from an ISO
image, using a kickstart
or autoYaSt
configuration file and a
Linux distribution image
to install the operating
system on the machine.
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Supported

Endpoint

vSphere

vSphere

m  vSpher
e

m KVM
(RHEV)

m SCVMM

m  vCloud
Air

m  vCloud
Directo
r

= All
virtual
endpoi
nts

m  Red Hat
OpenSt
ack

Agent Support

m  (Optional)
Guest agent

m  (Optional)
Software
bootstrap
agent and
guest agent

(Optional) Guest
agent

m  (Optional)
Guest agent

m  (Optional for
vSphere only)
Software
bootstrap
agent and
guest agent

m  (Optional)
Guest agent

m  (Optional)
Software
bootstrap
agent and
guest agent

Guest agent is
installed as part of
the preparation
instructions.

Provisioning
Method

Linked Clone

NetApp FlexClone

Clone

vCloud Air or vCloud

Director Cloning

Linux Kickstart

Pre-provisioning Preparations

You must have an existing
vSphere virtual machine.

If you want to support Software,
you must install the guest agent
and software bootstrap agent on
the machine you intend to clone.
The VM snapshot identified in the
blueprint should be powered off
before you provision the linked
clone VMs.

See Checklist for Preparing to
Provision by Cloning.

See Checklist for Preparing to
Provision by Cloning.

If you want to support Software,
you must install the guest agent
and software bootstrap agent on
the vSpheremachine you intend to
clone.

See Preparing for vCloud Air and
vCloud Director Provisioning.

If you want to support Software,
create a template that contains
the guest agent and software
bootstrap agent. For vCloud Air,
configure network connectivity
between your vRealize
Automation environment and your
vCloud Air environment.

Preparing for Linux Kickstart
Provisioning
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Table 1-5. Choosing a Machine Provisioning Method to Prepare (continued)

Scenario

Provision a machine and
pass control to an SCCM
task sequence to boot
from an ISO image,
deploy a Windows
operating system, and
install the vRealize
Automation guest agent.

Provision a machine by
booting into a WIinPE
environment and
installing an operating
system using a Windows
Imaging File Format
(WIM) image of an
existing Windows
reference machine.

Launch an instance from
a virtual machine image.

Launch an instance from
an Amazon Machine
Image.

Supported
Endpoint

All virtual
machine
endpoints.

Al
virtual
endpoi
nts

m  Red Hat
OpensSt
ack

Red Hat
OpenStack

Amazon
AWS

Provisioning

Agent Support Method
Guest agent is SCCM
installed as part of

the preparation

instructions.

Guest agent is WIM

required. When
you create the
WIinPE image, you
must manually
insert the guest
agent.

Not supported Virtual Machine

Image
m  (Optional) Amazon Machine
Guest agent Image
m  (Optional)
Software
bootstrap
agent and

guest agent

Pre-provisioning Preparations

Preparing for SCCM Provisioning

Preparing for WIM Provisioning

See Preparing for Virtual Machine
Image Provisioning.

Associate Amazon machine
images and instance types with
your Amazon AWS account.

If you want to support Software,
create an Amazon Machine Image
that contains the guest agent and
software bootstrap agent, and
configure network-to-VPC
connectivity between your
Amazon AWS and vRealize
Automation environments.

Checklist for Running Visual Basic Scripts During Provisioning

You can configure vRealize Automation to run your custom Visual Basic scripts as additional
steps in the machine life cycle, either before or after machine provisioning. For example, you
could use a pre-provisioning script to generate certificates or security tokens before
provisioning, and then a post-provisioning script to use the certificates and tokens after machine
provisioning. You can run Visual Basic scripts with any provisioning method, but you cannot use
Visual Basic scripts with Amazon AWS machines.

VMware, Inc.
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Table 1-6. Running Visual Basic Scripts During Provisioning Checklist

Task

U Install and configure the EPI agent
for Visual Basic scripts.

U Create your visual basic scripts.

U Gather the information required to
include your scripts in blueprints.

Location

Typically the Manager Service host

Machine where EPI agent is installed

Capture information and transfer to
your infrastructure architects

Note A fabric administrator can
create a property group by using the
property sets
ExternalPreProvisioningVbScript and
ExternalPostProvisioningVbScript to
provide this required information.

Doing so makes it easier for blueprint

architects to include this information
correctly in their blueprints.

Details

See Installing vRealize Automation.

VRealize Automation includes a sample
Visual Basic script
PrePostProvisioningExample.vbs in
the Scripts subdirectory of the EPI
agent installation directory. This script
contains a header to load all
arguments into a dictionary, a body in
which you can include your functions,
and a footer to return updated custom
properties to vRealize Automation.

When executing a Visual Basic script,
the EPI agent passes all machine
custom properties as arguments to the
script. To return updated property
values to vRealize Automation, place
these properties in a dictionary and
call a function provided by vRealize
Automation.

m  The complete path to the Visual
Basic script, including the filename
and extension. For example,
%System DrivesProgram Files
(x86)\VMware\vCAC Agents
\EPI_Agents\Scripts
\SendEmail.vbs.

B To run a script before provisioning,
instruct infrastructure architects to
enter the complete path to the
script as the value of the custom
property
ExternalPreProvisioningVbScrip
t. To run a script after provisioning,
they need to use the custom
property
ExternalPostProvisioningVbScri
pt.

Using VRealize Automation Guest Agent in Provisioning

You can install the guest agent on reference machines to further customize a machine after
deployment. You can use the reserved guest agent custom properties to perform basic
customizations such as adding and formatting disks, or you can create your own custom scripts
for the guest agent to run within the guest operating system of a provisioned machine.
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After the deployment is completed and the customization specification is run (if you provided
one), the guest agent creates an XML file that contains all of the deployed machine's custom
properties c:\VRMGuestAgent\site\workitem.xml, completes any tasks assigned to it with the
guest agent custom properties, and then deletes itself from the provisioned machine.

You can write your own custom scripts for the guest agent to run on deployed machines, and
use custom properties on the machine blueprint to specify the location of those scripts and the
order in which to run them. You can also use custom properties on the machine blueprint to pass
custom property values to your scripts as parameters.

For example, you could use the guest agent to make the following customizations on deployed
machines:

m  Change the IP address

m  Add or format drives

m  Run security scripts

m Initialize another agent, for example Puppet or Chef

You can also provide an encrypted string as a custom property in a command line argument. This
allows you to store encrypted information that the guest agent can decrypt and understand as a
valid command line argument.

Note The Linux guest agent assigns static IPs during the create and cloning actions for Linux
Kickstart and PXE provisioning relative to vRealize Automation custom properties in work items.
The guest agent is unable to accommodate the newer consistent network naming scheme, such
as in Ubuntu 16.x, when it assigns static IPs.

Your custom scripts do not have to be locally installed on the machine. As long as the
provisioned machine has network access to the script location, the guest agent can access and
run the scripts. This lowers maintenance costs because you can update your scripts without
having to rebuild all of your templates.

You can configure security settings for the virtual machines to be provisioned by specifying
information in a reservation, blueprint, or guest agent script. If the machines to be provisioned
requires a guest agent, you must add a security rule that contains that requirement to the
reservation or the blueprint. For example, if you use a default security policy that denies
communication between all machines, and rely on a separate security policy to allow
communication between specific machines, the guest agent might be unable to communicate
with vRealize Automation during the customization phase. To avoid this problem during machine
provisioning, use a default security policy that allows communication during the customization
phase.

If you choose to install the guest agent to run custom scripts on provisioned machines, your
blueprints must include the appropriate guest agent custom properties. For example, if you install
the guest agent on a template for cloning, create a custom script that changes the provisioned
machine's IP address, and place the script in a shared location, you need to include a number of
custom properties in your blueprint.
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Table 1-7. Custom Properties for Changing IP Address of a Provisioned Machine with a Guest
Agent

Custom Property Description

VirtualMachine.Admin.UseGuestAgent Set to true to initialize the guest agent when the
provisioned machine is started.

VirtualMachine.Customize.WaitComplete Set to True to prevent the provisioning workflow from
sending work items to the guest agent until all
customizations are complete.
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Table 1-7. Custom Properties for Changing IP Address of a Provisioned Machine with a Guest

Agent (continued)

Custom Property

VirtualMachine.SoftwareN.ScriptPath

VirtualMachine.ScriptPath.Decrypt

VMware, Inc.

Description

Specifies the full path to an application's install script. The
path must be a valid absolute path as seen by the guest
operating system and must include the name of the script
filename.

You can pass custom property values as parameters to the
script by inserting {CustomPropertyName} in the path
string. For example, if you have a custom property named
ActivationKey whose value is 1234, the script path is
D:\InstallApp.bat -key {ActivationKey}. The guest
agent runs the command D:\InstallApp.bat -key 1234.
Your script file can then be programmed to accept and use
this value.

Insert {Owner} to pass the machine owner name to the
script.

You can also pass custom property values as parameters
to the script by inserting {YourCustomProperty} in the path
string. For example, entering the value
\\vra-scripts.mycompany.com\scripts\changeIP.bat
runs the changeIP.bat script from a shared location, but
entering the value
\\vra-scripts.mycompany.com\scripts\changeIP.bat
{VirtualMachine.Network®.Address} runs the changelP
script but also passes the value of the
VirtualMachine.Network®.Address property to the script
as a parameter.

Allows vRealize Automation to obtain an encrypted string
that is passed as a properly formatted
VirtualMachine.SoftwareN.ScriptPath custom property
statement to the gugent command line.

You can provide an encrypted string, such as your
password, as a custom property in a command-line
argument. This allows you to store encrypted information
that the guest agent can decrypt and understand as a valid
command-line argument. For example, the
VirtualMachine.Software0.ScriptPath = c:\dosomething.bat
password custom property string is not secure as it contains
an actual password.

To encrypt the password, you can create a vRealize

Automation custom property, for example MyPassword =

password, and enable encryption by selecting the available

check box. The guest agent decrypts the [MyPassword]
entry to the value in the custom property MyPassword and
runs the script as c:\dosomething.bat password.

m  Create custom property MyPassword = password where
password is the value of your actual password. Enable
encryption by selecting the available check box.

m  Set custom property
VirtualMachine.ScriptPath.Decrypt as
VirtualMachine.ScriptPath.Decrypt = true.
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Table 1-7. Custom Properties for Changing IP Address of a Provisioned Machine with a Guest
Agent (continued)

Custom Property Description

m  Set custom property
VirtualMachine.Software0.ScriptPath as
VirtualMachine.SoftwareQ.ScriptPath =
c:\dosomething.bat [MyPassword].

If you set VirtualMachine.ScriptPath.Decrypt to false, or
do not create the VirtualMachine.ScriptPath.Decrypt
custom property, then the string inside the square brackets
([ and ]) is not decrypted.

For more information about custom properties you can use with the guest agent, see Custom
Properties Reference.
Configuring the Guest Agent to Trust a Server

Installing the public key PEM file for the vRealize Automation Manager Service Host in the correct
guest agent folder is the most secure approach to configuring the guest agent to trust a server.

Locate the guest agent folder on each template for the cert.pem PEM file for the Manager
Service Host to trust a server:

s Windows guest agent folder on each template that uses the gugent
C:\VRMGuestAgent\cert.pem

m  Linux guest agent folder on each template that uses the gugent
/usr/share/gugent/cert.pem

If you do not put the cert.penm file in this location, the template reference machine cannot use
the guest agent. For example, if you try to collect the public key information after the VM is
started for by altering scripts, you break the security condition.

Additional considerations apply, depending on your configured environment:

= For WIM installations, you must add the public key PEM file contents to the console
executable and user interface. The console flag is /cert filename.

m  For RedHat kickstart installations, you must cut and paste the public key into the sample file,
otherwise the guest agent fails to run.

m  For SCCM installation, the cert.pem file must reside in the VRMGuestAgent folder.
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For Linux vSphere installs, the cert.pem file must reside in the /usr/share/gugent folder.

Note You can optionally install software and guest agents together by downloading the
following script from https://APPLIANCE/software/index.html. The script allows you to handle
acceptance of SSL certificate fingerprints as you create the templates.

Linux
prepare_vra_template.sh
Windows

prepare_vra_template.psl

If you install the software and guest agent together, you do not need to use the instructions in
Install the Guest Agent on a Linux Reference Machine or Install the Guest Agent on a Windows

Reference Machine .

Install the Guest Agent on a Linux Reference Machine

Install the Linux guest agent on your reference machines to further customize machines after
deployment.

Prerequisites

Identify or create the reference machine.

The guest agent files you download contain both tar.gz and RPM package formats. If your
operating system cannot install tar.gz or RPM files, use a conversion tool to convert the
installation files to your preferred package format.

Establish secure trust between the guest agent and your Manager Service machine. See
Configuring the Guest Agent to Trust a Server.

Procedure

1

Navigate to the vRealize Automation appliance management console page.
For example: https://va-hostname. domain. com.

Click Guest and software agents page in the vRealize Automation component installation
section of the page.

For example: https://va-hostname.domain. com/software/index.html.

The Guest and Software Agent Installers page opens, displaying links to available
downloads.

Click Linux guest agent packages in the guest agent installers section of the page to
download and save the LinuxGuestAgentPkgs.zip file.

Unpack the downloaded LinuxGuestAgentPkgs.zip file to create the VralLinuxGuestAgent
folder.
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5 Install the guest agent package that corresponds to the guest operating system you are
deploying during provisioning.

a Navigate to the VralLinuxGuestAgent subdirectory that corresponds to the guest
operating system to deploy during provisioning, for example rhel32.

b Locate your preferred package format or convert a package to your preferred package
format.

¢ Install the guest agent package on your reference machine.

For example, to install the files from the RPM package, run rpm -i gugent-
gugent-7.1.0-4201531.1386. rpm.

6 Configure the guest agent to communicate with the Manager Service by running

installgugent.sh Manager_Service_Hostname_fdgn: portnumber ssl1 platform.

The default port number for the Manager Service is 443. Accepted platform values are ec2,

vcd, vca, and vsphere.

Option Description

If you are using a load balancer Enter the fully qualified domain name and port number of your Manager
Service load balancer. For example:

cd /usr/share/gugent
./installgugent.sh
load_balancer_manager_service.mycompany.com:443 ssl ec2

With no load balancer Enter the fully qualified domain name and port number of your Manager
Service machine. For example:

cd /usr/share/gugent
./installgugent.sh manager_service_machine.mycompany.com:443
ssl vsphere

7 If deployed machines are not already configured to trust the Manager Service SSL certificate,

you must install the cert.pem file on your reference machine to establish trust.

m  For the most secure approach, obtain the cert.pem certificate and manually install the file

on the reference machine.
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m For a more convenient approach, you can connect to the manager service load balancer
or manager service machine and download the cert.pem certificate.

Option

If you are using a load balancer

With no load balancer

8 If you are installing the guest agent on a Ubuntu operating system, create symbolic links for

Description
As the root user on the reference machine, run the following command:

echo | openssl s_client —connect
manager_service_load_balancer.mycompany.com:443 | sed -ne '/-
BEGIN CERTIFICATE-/,/-END CERTIFICATE-/p' > cert.pem

As the root user on the reference machine, run the following command:

echo | openssl s_client -connect
manager_service_machine.mycompany.com:443 | sed —-ne '/-BEGIN
CERTIFICATE-/,/—-END CERTIFICATE-/p' > cert.pem

shared objects by running one of the following command sets.

Option

64-bit systems

32-bit systems

What to do next

Description

cd /1ib/x86_64-1inux—gnu
sudo 1n -s 1libss1l.s0.1.0.0 libssl.so.10
sudo 1n -s libcrypto.so0.1.0.0 libcrypto.so.10

cd /1ib/i386-1inux—gnu
sudo 1n -s 1libssl.s0.1.0.0 libssl.so0.10
sudo 1n -s libcrypto.so0.1.0.0 libcrypto.so.10

Convert your reference machine into a template for cloning, an Amazon Machine Image, or a
snapshot that your laaS architects can use when creating blueprints.

Install the Guest Agent on a Windows Reference Machine

Install the vRealize Automation Windows guest agent on a Windows reference machine to run as
a Windows service and enable further customization of machines.

Prerequisites

m Identify or create the reference machine.

m  Establish secure trust between the guest agent and your Manager Service machine. See
Configuring the Guest Agent to Trust a Server.

Procedure

1 Navigate to the vRealize Automation appliance Guest and Software Agent Installers page:

https://vrealize-automation-appliance-FQDN/software
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2 Under Guest Agent Installers, download and save the 32-bit or 64-bit executable to the root
of the C: drive.

Note There is a command-line alternative to this procedure for guest agent installation.
Instead of downloading the executables, you may go to Windows Software Installers on the
Guest and Software Agent Installers page. There, you can download and run the
prepare_vra_template.psl PowerShell script:

PowerShell -NoProfile -ExecutionPolicy Bypass —-Command prepare_vra_template.psl

3 Extract the Windows guest agent files by running the executable.
Extraction creates C:\VRMGuestAgent and adds the files.
Do not rename C:\VRMGuestAgent.

4 Configure the guest agent to communicate with the Manager Service.
a Open an elevated command prompt.
b Navigate to C:\VRMGuestAgent.

c Put the trusted Manager Service PEM file in the C:\VRMGuestAgent\ directory to configure
the guest agent to trust your Manager Service machine.

d Runwinservice —-i -h Manager_Service_Hostname_fdgn: portnumber —p ssl.

The default port number for the Manager Service is 443.

Option Description

If you are using a load balancer Enter the fully qualified domain name and port number of your Manager
Service load balancer. For example, winservice -i -h

load_balancer_manager_service.mycompany.com:443 —p ssl.

With no load balancer Enter the fully qualified domain name and port number of your Manager
Service machine. For example, winservice -i -h

manager_service_machine.mycompany.com:443 —p ssl.

If you are preparing an Amazon You need to specify that you are using Amazon. For example, winservice
machine image -1 -h manager_service_machine.mycompany.com:443:443 —p ssl -c ec2

Results

The name of the Windows service is VCACGuestAgentService. You can find the installation log
VCAC-GuestAgentService.log in C:\VRMGuestAgent.

What to do next

Convert your reference machine into a template for cloning, an Amazon machine image, or a
snapshot so your laaS architects can use your template when creating blueprints.
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Checklist for Preparing to Provision by Cloning

You must perform some preparation outside of vRealize Automation to create the template and
the customization objects used to clone Linux and Windows virtual machines.

Cloning requires a template to clone from, created from a reference machine.

Identify or create
a reference machine.

Are you working in

e S Install VMware Tools.

Do you want
to support software
components in
your blueprints?

Install the guest agent and
the software bootstrap
agent.

Do you want
the ability to
customize Install the guest agent.
machines after
deployment?

Convert your reference
machine to a template.
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If you are provisioning a Windows machine by cloning, the only way to join the provisioned
machine to an Active Directory domain is by using the customization specification from vCenter
Server or by including a guest operating system profile with your SCVMM template. Machines
provisioned by cloning cannot be placed in an Active Directory container during provisioning.
You must do this manually after provisioning.

Table 1-8. Checklist for Preparing to Provision by Cloning

Task Location Details

U Identify or create the reference machine. Hypervisor See the documentation provided by your
hypervisor.

U (Optional) If you want your clone template to  Reference machine For Windows reference machines, see

support Software components, install the Prepare a Windows Reference Machine to

vRealize Automation guest agent and software Support Software.

bootstrap agent on your reference machine. For Linux reference machines, see Prepare a
Linux Reference Machine to Support
Software.

U (Optional) If you do not need your clone Reference machine See Using vRealize Automation Guest Agent

template to support Software components, but in Provisioning.

you do want the ability to customize deployed
machines, install the vRealize Automation guest
agent on your reference machine.

O If you are working in a vCenter Server vCenter Server See the VMware Tools documentation.
environment, install VMware Tools on the
reference machine.

U Use the reference machine to create a Hypervisor The reference machine may be powered on

template for cloning. or off. If you are cloning in vCenter Server,
you can use a reference machine directly
without creating a template.

See the documentation provided by your

hypervisor.
U Create the customization object to configure Hypervisor If you are cloning for Linux you can install
cloned machines by applying System the Linux guest agent and provide external
Preparation Utility information or a Linux customization scripts instead of creating a
customization. customization object. If you are cloning with

vCenter Server, you must provide the
customization specification as the
customization object.

See the documentation provided by your

hypervisor.
U Gather the information required to create Capture information See Worksheet for Virtual Provisioning by
blueprints that clone your template. and transfer to your Cloning.

laasS architects.

Worksheet for Virtual Provisioning by Cloning

Complete the knowledge transfer worksheet to capture information about the template,
customizations, and custom properties required to create clone blueprints for the templates you
prepared in your environment. Not all of this information is required for every implementation.
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Use this worksheet as a guide, or copy and paste the worksheet tables into a word processing

tool for editing.

Required Template and Reservation Information

Table 1-9. Template and Reservation Information Worksheet

Required Information
Template name

Reservations on which the
template is available, or
reservation policy to apply

(vSphere only) Type of cloning
requested for this template

Customization specification name
(Required for cloning with static
IP addresses)

(SCVMM only) ISO name
(SCVMM only) Virtual hard disk

(SCVMM only) Hardware profile
to attach to provisioned
machines

Required Property Groups

My Value

Details

To avoid errors during provisioning, ensure
that the template is available on all
reservations or create reservation policies
that architects can use to restrict the
blueprint to reservations where the template
is available.

m  Clone

m  Linked Clone
m  NetApp FlexClone
You cannot perform customizations of

Windows machines without a customization
specification object.

You can complete the custom property information sections of the worksheet, or you can create
property groups and ask architects to add your property groups to their blueprints instead of

numerous individual custom properties.

Required vCenter Server Operating System

You must supply the guest operating system custom property for vCenter Server provisioning.
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Table 1-10. vCenter Server Operating System

Custom Property My Value Description
VMware.VirtualCenter.OperatingSy Specifies the vCenter Server guest
stem operating system version

(VirtualMachineGuestOsIdentifier)
with which vCenter Server creates the
machine. This operating system version
must match the operating system
version to be installed on the
provisioned machine. Administrators
can create property groups using one
of several property sets, for example,
VMware[0S_Version]Properties, that
are predefined to include the correct
VMware.VirtualCenter.OperatingSyst
em values. This property is for virtual
provisioning.

Visual Basic Script Information

If you configured vRealize Automation to run your custom Visual Basic scripts as additional steps
in the machine life cycle, you must include information about the scripts in the blueprint.

Note A fabric administrator can create a property group by using the property sets
ExternalPreProvisioningVbScript and ExternalPostProvisioningVbScript to provide this required
information. Doing so makes it easier for blueprint architects to include this information correctly
in their blueprints.

Table 1-11. Visual Basic Script Information

Custom Property My Value Description

ExternalPreProvisioningVbScript Run a script before provisioning. Enter
the complete path to the script
including the filename and extension.
%System DrivesProgram Files
(x86)\VMware\vCAC Agents
\EPI_Agents\Scripts\SendEmail.vbs.

ExternalPostProvisioningVbScript Run a script after provisioning. Enter
the complete path to the script
including the filename and extension.
%System DrivesProgram Files
(x86)\VMware\vCAC Agents
\EPI_Agents\Scripts\SendEmail.vbs

Linux Guest Agent Customization Script Information

If you configured your Linux template to use the guest agent for running customization scripts,
you must include information about the scripts in the blueprint.
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Table 1-12. Linux Guest Agent Customization Script Information Worksheet

Custom Property My Value Description

Linux.ExternalScript.Name Specifies the name of an optional
customization script, for example
config.sh, that the Linux guest agent
runs after the operating system is
installed. This property is available for
Linux machines cloned from templates
on which the Linux agent is installed.
If you specify an external script, you
must also define its location by using
the
Linux.ExternalScript.LocationType
and Linux.ExternalScript.Path

properties.
Linux.ExternalScript.LocationTy Specifies the location type of the
pe customization script named in the

Linux.ExternalScript.Name
property. This can be either local or
nfs.

You must also specify the script
location using the
Linux.ExternalScript.Path
property. If the location type is nfs,
also use the
Linux.ExternalScript.Server
property.

Linux.ExternalScript.Server Specifies the name of the NFS server,
for example lab-ad.lab.local, on which
the Linux external customization script
named in Linux.ExternalScript.Name
is located.

Linux.ExternalScript.Path Specifies the local path to the Linux
customization script or the export
path to the Linux customization on the
NFS server. The value must begin with
a forward slash and not include the file
name, for example /scripts/linux/
config.sh.

Other Guest Agent Custom Properties

If you installed the guest agent on your reference machine, you can use custom properties to
further customize machines after deployment.
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Table 1-13. Custom Properties for Customizing Cloned Machines with a Guest Agent Worksheet

Custom Property

VirtualMachine.Admin.AddOwnerToAd
mins

VirtualMachine.Admin.AllowLogin

VirtualMachine.Admin.UseGuestAgen
t

VirtualMachine.DiskN.Active

VirtualMachine.DiskN.Label

VirtualMachine.DiskN.Letter

VMware, Inc.

My Value

Description

Set to True (default) to add the
machine’s owner, as specified by the
VirtualMachine.Admin.Owner property,
to the local administrators group on the
machine.

Set to True (default) to add the machine
owner to the local remote desktop users
group, as specified by the

VirtualMachine.Admin.Owner property.

If the guest agent is installed as a service
on a template for cloning, set to True on
the machine blueprint to enable the
guest agent service on machines cloned
from that template. When the machine is
started, the guest agent service is
started. Set to False to deactivate the
guest agent. If set to False, the
enhanced clone workfow will not use the
guest agent for guest operating system
tasks, reducing its functionality to
VMwareCloneWorkflow. If not specified or
set to anything other than False, the
enhanced clone workflow sends work
items to the guest agent.

Set to True (default) to specify that the
machine's disk N is active. Set to False to
specify that the machine's disk N is not
active.

Specifies the label for a machine’s disk
N. The disk label maximum is 32
characters. Disk numbering must be
sequential. When used with a guest
agent, specifies the label of a machine's
disk N inside the guest operating
system.

Specifies the drive letter or mount point
of a machine’s disk N. The default is C.
For example, to specify the letter D for
Disk 1, define the custom property as
VirtualMachine.Diskl.Letter and
enter the value D. Disk numbering must
be sequential. When used in conjunction
with a guest agent, this value specifies
the drive letter or mount point under
which an additional disk N is mounted by
the guest agent in the guest operating
system.
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Table 1-13. Custom Properties for Customizing Cloned Machines with a Guest Agent Worksheet

(continued)

Custom Property

VirtualMachine.Admin.CustomizeGue
stOSDelay

VirtualMachine.Customize.WaitComp
lete

VirtualMachine.SoftwareN.Name

VirtualMachine.SoftwareN.ScriptPa
th
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My Value

Description

Specifies the time to wait after
customization is complete and before
starting the guest operating system
customization. The value must be in
HH:MM:SS format. If the value is not set,
the default value is one minute
(00:01:00). If you choose not to include
this custom property, provisioning can
fail if the virtual machine reboots before
guest agent work items are completed,
causing provisioning to fail.

Set to True to prevent the provisioning
workflow from sending work items to the
guest agent until all customizations are
complete.

Specifies the descriptive name of a
software application N or script to install
or run during provisioning. This is an
optional and information-only property.
It serves no real function for the
enhanced clone workflow or the guest
agent but it is useful for a custom
software selection in a user interface or
for software use reporting.

Specifies the full path to an application's
install script. The path must be a valid
absolute path as seen by the guest
operating system and must include the
name of the script filename.

You can pass custom property values as
parameters to the script by inserting
{CustomPropertyName} in the path
string. For example, if you have a
custom property named ActivationKey
whose value is 1234, the script path is
D:\InstallApp.bat -key
{ActivationKey}. The guest agent runs
the command D:\InstallApp.bat -key
1234. Your script file can then be
programmed to accept and use this
value.
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Table 1-13. Custom Properties for Customizing Cloned Machines with a Guest Agent Worksheet
(continued)

Custom Property My Value Description

VirtualMachine.SoftwareN.ISOName Specifies the path and filename of the
ISO file relative to the datastore root.
The formatis /folder_name/
subfolder_name/file_name.1iso. If a
value is not specified, the ISO is not

mounted.
VirtualMachine.SoftwareN.ISOLocat Specifies the storage path that contains
ion the ISO image file to be used by the

application or script. Format the path as
it appears on the host reservation, for
example netapp-1:it_nfs_1.If a value is
not specified, the ISO is not mounted.

Networking Custom Properties

You can specify configuration for specific network devices on a machine by using custom
properties.

Common networking-related custom properties are listed in the following table. For additional
and related custom properties, see Custom Properties for Clone Blueprints and Custom
Properties for Networking in Custom Properties Reference.

Table 1-14. Custom Properties for Networking Configuration

Custom Property My Value Description

VirtualMachine.NetworkN.Address Specifies the IP address of network
device N in a machine provisioned
with a static IP address.

VirtualMachine.NetworkN.MacAddr Indicates whether the MAC address of

essType network device N is generated or
user-defined (static). This property is
available for cloning.
The default value is generated. If the
value is static, you must also use
VirtualMachine.NetworkN.MacAddres
s to specify the MAC address.

VirtualMachine.NetworkN custom
properties are specific to individual
blueprints and machines. When a
machine is requested, network and IP
address allocation is performed before
the machine is assigned to a
reservation. Because blueprints are
not guaranteed to be allocated to a
specific reservation, do not use this
property on a reservation. This
property is not supported for on-
demand NAT or on-demand routed
networks.
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Table 1-14. Custom Properties for Networking Configuration (continued)

Custom Property My Value

VirtualMachine.NetworkN.MacAddr
ess
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Description

Specifies the MAC address of a
network device N. This property is
available for cloning.

If the value of
VirtualMachine.NetworkN.MacAddres
sType is generated, this property
contains the generated address.

If the value of
VirtualMachine.NetworkN.MacAddres
sType is static, this property specifies
the MAC address. For virtual machines
provisioned on ESX server hosts, the
address must be in the range specified
by VMware. For details, see vSphere
documentation.
VirtualMachine.NetworkN custom
properties are specific to individual
blueprints and machines. When a
machine is requested, network and IP
address allocation is performed before
the machine is assigned to a
reservation. Because blueprints are
not guaranteed to be allocated to a
specific reservation, do not use this
property on a reservation. This
property is not supported for on-
demand NAT or on-demand routed
networks.
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Table 1-14. Custom Properties for Networking Configuration (continued)

Custom Property My Value

VirtualMachine.NetworkN.Name
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Description

Specifies the name of the network to
connect to, for example the network
device N to which a machine is
attached. This is equivalent to a
network interface card (NIC).

By default, a network is assigned from
the network paths available on the
reservation on which the machine is
provisioned. Also see
VirtualMachine.NetworkN.AddressTy
pe.

You can ensure that a network device
is connected to a specific network by
setting the value of this property to
the name of a network on an available
reservation. For example, if you give
properties for N= 0 and 1, you get 2
NICs and their assigned value,
provided the network is selected in
the associated reservation.

VirtualMachine.NetworkN custom
properties are specific to blueprints
and machines. When a machine is
requested, network and IP address
allocation is performed before the
machine is assigned to a reservation.
Because blueprints are not
guaranteed to be allocated to a
specific reservation, do not use this
property on a reservation. This
property is not supported for on-
demand NAT or on-demand routed
networks.

For an example of how to use this
custom property to dynamically set
VirtualMachine.Network®.Name
based on a consumer's selection from
a list of predefined available networks,
see the Adding a Network Selection
Drop-Down in VRA 7 blog post.
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Table 1-14. Custom Properties for Networking Configuration (continued)

Custom Property

VirtualMachine.NetworkN.PortID

VirtualMachine.NetworkN.Network
ProfileName

®  VirtualMachine.NetworkN.Subn
etMask

B VirtualMachine.NetworkN.Gate
way

B VirtualMachine.NetworkN.Prim
aryDns

®  VirtualMachine.NetworkN.Seco
ndaryDns

B VirtualMachine.NetworkN.Prim
aryWins

®  VirtualMachine.NetworkN.Seco
ndaryWins

m  VirtualMachine.NetworkN.DnsS
uffix

®  VirtualMachine.NetworkN.DnsS
earchSuffixes

VMware, Inc.

Description

Specifies the port ID to use for
network device N when using a dvPort
group with a vSphere distributed
switch.

VirtualMachine.NetworkN custom
properties are specific to individual
blueprints and machines. When a
machine is requested, network and IP
address allocation is performed before
the machine is assigned to a
reservation. Because blueprints are
not guaranteed to be allocated to a
specific reservation, do not use this
property on a reservation. This
property is not supported for on-
demand NAT or on-demand routed
networks.

Specifies the name of a network
profile from which to assign a static IP
address to network device N or from
which to obtain the range of static IP
addresses that can be assigned to
network device N of a cloned
machine, where N=0 for the first
device, 1for the second, and so on.

The network profile that the property
points to is used to allocate an IP
address. The property determines the
network that the machine attaches to,
based on the reservation.

Appending a name allows you to

create multiple versions of a custom

property. For example, the following

properties might list load balancing

pools set up for general use and

machines with high, moderate, and

low performance requirements:

m  VCNS.LoadBalancerEdgePool.Name
s

®  VCNS.LoadBalancerEdgePool.Name
s.moderate

m  VCNS.LoadBalancerEdgePool.Name
s.high

m  VCNS.LoadBalancerEdgePool.Name
s.low

Configures attributes of the network

profile specified in

VirtualMachine.NetworkN.NetworkPr

ofileName.
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Table 1-14. Custom Properties for Networking Configuration (continued)

Custom Property

VCNS. LoadBalancerEdgePool.Names.
name

VMware, Inc.

Description

Specifies the NSX load balancing
pools to which the virtual machine is
assigned during provisioning. The
virtual machine is assigned to all
service ports of all specified pools.
The value is an edge/pool name or a
list of edge/pool names separated by
commas. Names are case-sensitive.
Appending a name allows you to
create multiple versions of a custom
property. For example, the following
properties might list load balancing
pools set up for general use and
machines with high, moderate, and
low performance requirements:
m  VCNS.LoadBalancerEdgePool.Name
s
B VCNS.LoadBalancerEdgePool.Name
s.moderate
m  VCNS.LoadBalancerEdgePool.Name
s.high
B VCNS.LoadBalancerEdgePool.Name
s.low
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Table 1-14. Custom Properties for Networking Configuration (continued)

Custom Property My Value

VCNS.SecurityGroup.Names.name

VCNS.SecurityTag.Names.name

Description

Specifies the NSX security group or
groups to which the virtual machine is
assigned during provisioning. The
value is a security group name or a list
of names separated by commas.
Names are case-sensitive.

Appending a name allows you to
create multiple versions of the
property, which can be used
separately or in combination. For
example, the following properties can
list security groups intended for
general use, for the sales force, and
for support:

m  VCNS.SecurityGroup.Names
m  VCNS.SecurityGroup.Names.sales

m  VCNS.SecurityGroup.Names.suppo
rt

Specifies the NSX security tag or tags
to which the virtual machine is
associated during provisioning. The
value is a security tag name or a list of
names separated by commas. Names
are case-sensitive.

Appending a name allows you to
create multiple versions of the
property, which can be used
separately or in combination. For
example, the following properties can
list security tags intended for general
use, for the sales force, and for
support:

m  VCNS.SecurityTag.Names
m  VCNS.SecurityTag.Names.sales
m  VCNS.SecurityTag.Names.support

Preparing for vCloud Air and vCloud Director Provisioning

To prepare for provisioning vCloud Air and vCloud Director machines by using vRealize
Automation, you must configure the organization virtual data center with templates and

customization objects.

To provision vCloud Air and vCloud Director resources using vRealize Automation, the
organization requires a template to clone from that consists of one or more machine resources.

VMware, Inc.
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Templates that are to be shared across organizations must be public. Only reserved templates
are available to vRealize Automation as a cloning source.

Note When you create a blueprint by cloning from a template, that template's unique identifier
becomes associated with the blueprint. When the blueprint is published to the vRealize
Automation catalog and used in the provisioning and data collection processes, the associated
template is recognized. If you delete the template in vCloud Air or vCloud Director, subsequent
vRealize Automation provisioning and data collection fails because the associated template no
longer exists. Instead of deleting and recreating a template, for example to upload an updated
version, replace the template using the vCloud Air vCloud Director template replacement
process. Using vCloud Air or vCloud Director to replace the template, rather than deleting and
recreating the template, keeps the template's unique ID intact and allows provisioning and data
collection to continue functioning.

The following overview illustrates the steps you need to perform before you use vRealize
Automation to create endpoints and define reservations and blueprints. For more information
about these administrative tasks, see vCloud Air and vCloud Director product documentation.

1 In vCloud Air or vCloud Director, create a template for cloning and add it to the organization
catalog.

2 In vCloud Air or vCloud Director, use the template to specify custom settings such as
passwords, domain, and scripts for the guest operating system on each machine.

You can use VvRealize Automation to override some of these settings.
Customization can vary depending on the guest operating system of the resource.

3 In vCloud Air or vCloud Director, configure the catalog to be shared with everyone in the
organization.

In vCloud Air or vCloud Director, configure account administrator access to applicable
organizations to allow all users and groups in the organization to have access to the catalog.
Without this sharing designation, the catalog templates are not be visible to endpoint or
blueprint architects in vRealize Automation.

4 Gather the following information so that you can include it in blueprints:
= Name of the vCloud Air or vCloud Director template.

m  Amount of total storage specified for the template.

Preparing for Linux Kickstart Provisioning

Linux Kickstart provisioning uses a configuration file to automate a Linux installation on a newly
provisioned machine. To prepare for provisioning you must create a bootable ISO image and a
Kickstart or autoYaST configuration file.
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The following is a high-level overview of the steps required to prepare for Linux Kickstart
provisioning:

1

Verify that a DHCP server is available on the network. vRealize Automation cannot provision
machines by using Linux Kickstart provisioning unless DHCP is available.

Prepare the configuration file. In the configuration file, you must specify the locations of the
vRealize Automation server and the Linux agent installation package. See Prepare the Linux
Kickstart Configuration Sample File.

Edit the isolinux/isolinux.cfg or loader/isolinux.cfg to specify the name and location
of the configuration file and the appropriate Linux distribution source.

Create the boot ISO image and save it to the location required by your virtualization platform.
See the documentation provided by your hypervisor for information about the required
location.

(Optional) Add customization scripts.

a To specify post-installation customization scripts in the configuration file, see Specify
Custom Scripts in a kickstart/autoYaST Configuration File.

b To call Visual Basic scripts in blueprint, see Checklist for Running Visual Basic Scripts
During Provisioning.

Gather the following information so that blueprint architects can include it in their blueprints:
a The name and location of the ISO image.
b For vCenter Server integrations, the vCenter Server guest operating system version with

which vCenter Server is to create the machine.

Note You can create a property group with the property set BootlsoProperties to include
the required ISO information. This makes it easier to include this information correctly on
blueprints.

Prepare the Linux Kickstart Configuration Sample File

vRealize Automation provides sample configuration files that you can modify and edit to suit your
needs. There are several changes required to make the files usable.

Procedure

1

Navigate to the vRealize Automation appliance management console page.
For example: https://va-hostname. domain. com.

Click Guest and software agents page in the vRealize Automation component installation
section of the page.

For example: https://va-hostname.domain. com/software/index.html.

The Guest and Software Agent Installers page opens, displaying links to available
downloads.
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3 Click Linux guest agent packages in the guest agent installers section of the page to
download and save the LinuxGuestAgentPkgs.zip file.

4 Unpack the downloaded LinuxGuestAgentPkgs.zip file to create the VralLinuxGuestAgent
folder.

5 Navigate to the VralLinuxGuestAgent subdirectory that corresponds to the guest operating
system to deploy during provisioning.

For example: rhel32.
6 Open a file in the samples subdirectory that corresponds to your target system.
For example, samples/sample-https-rhel6-x86.cfg.

7 Replace all instances of the string host=dcac.example.net with the IP address or fully qualified
domain name and port number for the Manager Service or the load balancer for the Manager

Service.

Platform Required Format

vSphere ESXi IP Address, for example: ——host=172.20.9.59

vSphere ESX IP Address, for example: ——host=172.20.9.58

SUSE 10 IP Address, for example: ——host=172.20.9.57

All others FQDN, for example: ——host=mycompany-hostl.mycompany.local:443

8 Locate each instance of gugent.rpm or gugent.tar.gz and replace the URL rpm.example.net with
the location of the guest agent package.

For example:

rpm —-i nfs:172.20.9.59/suseagent/gugent.rpm

9 Save the file to a location accessible to newly provisioned machines.

Specify Custom Scripts in a kickstart/autoYaST Configuration File

You can modify the configuration file to copy or install custom scripts onto newly provisioned
machines. The Linux agent runs the scripts at the specified point in the workflow.

Your script can reference any of the . /properties.xml files in the /usr/share/gugent/site/
workitem directories.

Prerequisites

m  Prepare a kickstart or autoYaST configuration file. See Prepare the Linux Kickstart
Configuration Sample File.

m  Your script must return a non-zero value on failure to prevent machine provisioning failure.
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Procedure
1 Create or identify the script you want to use.
2 Save the script as NN_scriptname.

NN is a two digit number. Scripts are run in order from lowest to highest. If two scripts have
the same number, the order is alphabetical based on scriptname.

3 Make your script runnable.
4 Locate the post-installation section of your kickstart or autoYaST configuration file.
In kickstart, this is indicated by %post. In autoYaST, this is indicated by post-scripts.

5 Modify the post-installation section of the configuration file to copy or install your script into
the /usr/share/gugent/site/workitem directory of your choice.

Custom scripts are most commonly run for virtual kickstart/autoYaST with the work items
SetupOS (for create provisioning) and CustomizeOS (for clone provisioning), but you can run
scripts at any point in the workflow.

For example, you can modify the configuration file to copy the script 11_addusers.sh to
the /usr/share/gugent/site/SetupOS directory on a newly provisioned machine by using
the following command:

cp nfs:172.20.9.59/1linuxscripts/11_addusers.sh /usr/share/gugent/site/Setup0S

Results

The Linux agent runs the script in the order specified by the work item directory and the script
file name.

Preparing for SCCM Provisioning

vRealize Automation boots a newly provisioned machine from an ISO image, and then passes
control to the specified SCCM task sequence.

SCCM provisioning is supported for the deployment of Windows operating systems. Linux is not
supported. Software distribution and updates are not supported.

The following is a high-level overview of the steps required to prepare for SCCM provisioning:
1 Communication with SCCM requires the NetBIOS name of the SCCM server.

Work with your network administrator to ensure that at least one Distributed Execution
Manager (DEM) can resolve the FQDN of the SCCM server to its NetBIOS name.

You do not need to place DEMs directly on the same network as the SCCM server, but DEMs
need to be able to reach the SCCM server over IP.

2 Create a software package that includes the vRealize Automation guest agent. See Create a
Software Package for SCCM Provisioning.
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In SCCM, create the desired task sequence for provisioning the machine. The final step must
be to install the software package you created that contains the vRealize Automation guest
agent. For information about creating task sequences and installing software packages, see
SCCM documentation.

Create a zero touch boot ISO image for the task sequence. By default, SCCM creates a light
touch boot ISO image. For information about configuring SCCM for zero touch ISO images,
see SCCM documentation.

Copy the ISO image to the location required by your virtualization platform. If you do not
know the appropriate location, refer to the documentation provided by your hypervisor.

Gather the following information so that blueprint architects can include it on blueprints:
a The name of the collection containing the task sequence.

b The fully qualified domain name of the SCCM server on which the collection containing
the sequence resides.

c The site code of the SCCM server.
d Administrator-level credentials for the SCCM server.

e (Optional) For SCVMM integrations, the ISO, virtual hard disk, or hardware profile to
attach to provisioned machines.

Create a Software Package for SCCM Provisioning

The final step in your SCCM task sequence must be to install a software package that includes
the vRealize Automation guest agent.

Procedure

1

Navigate to the vRealize Automation appliance management console page.
For example: https://va-hostname. domain. com.

Click Guest and software agents page in the vRealize Automation component installation
section of the page.

For example: https://va-hostname.domain. com/software/index.html.

The Guest and Software Agent Installers page opens, displaying links to available
downloads.

Click Windows guest agent files (32-bit) or (64-bit) in the component installation section of
the page to download and save the GuestAgentInstaller.exe or
GuestAgentInstaller_x64.exe file.

Extract the Windows guest agent files to a location available to SCCM.
This produces the directory C:\VRMGuestAgent. Do not rename this directory.
Create a software package from the definition file SCCMPackageDefinitionFile.sms.

Make the software package available to your distribution point.
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7 Select the contents of the extracted Windows guest agent files as your source files.

Preparing for WIM Provisioning

Provision a machine by booting into a WIinPE environment and then install an operating system
using a Windows Imaging File Format (WIM) image of an existing Windows reference machine.

The following is a high-level overview of the steps required to prepare for WIM provisioning:

1 Identify or create the staging area. The staging area should be a network directory that can
be specified as a UNC path or mounted as a network drive by

m  The reference machine.
m  The system where you build the WIinPE image.
m  The virtualization host where you provision the machines.

2 Ensure that the network has a DHCP server. vRealize Automation cannot provision machines
with a WIM image unless DHCP is available.

3 Identify or create the reference machine in the virtualization platform you intend to use for
provisioning. For vRealize Automation requirements, see Reference Machine Requirements
for WIM Provisioning. For information about creating a reference machine, see the
documentation provided by your hypervisor.

4 Using the System Preparation Utility for Windows, prepare the reference machine's operating
system for deployment. See SysPrep Requirements for the Reference Machine.

5 Create the WIM image of the reference machine. Do not include any spaces in the WIM image
file name or provisioning fails.

6 Create a WInPE image that contains the vRealize Automation guest agent.

m  (Optional) Create any custom scripts you want to use to customize provisioned machines
and place them in the appropriate work item directory.

m |f you are using VirtlO for network or storage interfaces, you must ensure that the
necessary drivers are included in your WIinPE image and WIM image. See Preparing for
WIM Provisioning with VirtlO Drivers.

When you create the WInPE image, you must manually insert the vRealize Automation guest
agent. See Manually Insert the Guest Agent into a WIinPE Image.

7 Place the WInPE image in the location required by your virtualization platform. If you do not
know the location, see your hypervisor documentation.

8 Gather the following information to include in the blueprint:
a The name and location of the WInPE ISO image.

b The name of the WIM file, the UNC path to the WIM file, and the index used to extract the
desired image from the WIM file.
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¢ The user name and password under which to map the WIM image path to a network drive
on the provisioned machine.

d (Optional) If you do not want to accept the default, K, the drive letter to which the WIM
image path is mapped on the provisioned machine.

e For vCenter Server integrations, the vCenter Server guest operating system version with
which vCenter Server is to create the machine.

f  (Optional) For SCVMM integrations, the ISO, virtual hard disk, or hardware profile to

attach to provisioned machines.

Note You can create a property group to include all of this required information. Using a
property group makes it easier to include all the information correctly in blueprints.

Procedure

Reference Machine Requirements for WIM Provisioning

WIM provisioning involves creating a WIM image from a reference machine. The reference
machine must meet basic requirements for the WIM image to work for provisioning in
vRealize Automation.

SysPrep Requirements for the Reference Machine

A SysPrep answer file contains several required settings that are used for WIM provisioning.

Preparing for WIM Provisioning with VirtlO Drivers

If you are using VirtlO for network or storage interfaces, you must ensure that the necessary
drivers are included in your WiIinPE image and WIM image. VirtlO generally offers better
performance when provisioning with KVM (RHEV).

Manually Insert the Guest Agent into a WIinPE Image

You must manually insert the vRealize Automation guest agent into your WiIinPE image.

Reference Machine Requirements for WIM Provisioning

WIM provisioning involves creating a WIM image from a reference machine. The reference
machine must meet basic requirements for the WIM image to work for provisioning in vRealize
Automation.

The following is a high-level overview of the steps to prepare a reference machine:

1

If the operating system on your reference machine is Windows Server 2008 R2, Windows
Server 2012, Windows 7, or Windows 8, the default installation creates a small partition on
the system's hard disk in addition to the main partition. vRealize Automation does not support
the use of WIM images created on such multi-partitioned reference machines. You must
delete this partition during the installation process.

Install NET 4.5 and Windows Automated Installation Kit (AIK) for Windows 7 (including WinPE
3.0) on the reference machine.
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3 If the reference machine operating system is Windows Server 2003 or Windows XP, reset the
administrator password to be blank. (There is no password.)

4 (Optional) If you want to enable XenDesktop integration, install and configure a Citrix Virtual
Desktop Agent.

5 (Optional) A Windows Management Instrumentation (WMI) agent is required to collect certain
data from a Windows machine managed by vRealize Automation, for example the Active
Directory status of a machine’s owner. To ensure successful management of Windows
machines, you must install a WMI agent (typically on the Manager Service host) and enable
the agent to collect data from Windows machines. See Installing vRealize Automation.

SysPrep Requirements for the Reference Machine
A SysPrep answer file contains several required settings that are used for WIM provisioning.

Table 1-15. Windows Server or Windows XP reference machine SysPrep required settings

GuiUnattended Settings Value
Autologon Yes
AutoLogonCount 1
AutoLogonUsername username

(username and password are the credentials used for auto
logon when the newly provisioned machine boots into the
guest operating system. Administrator is typically used.)

AutolLogonPassword password corresponding to the AutoLogonUsername.

Table 1-16. Required SysPrep Settings for reference machine that are not using Windows Server
2003 or Windows XP:

AutolLogon Settings Value
Enabled Yes
LogonCount 1
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Table 1-16. Required SysPrep Settings for reference machine that are not using Windows Server
2003 or Windows XP: (continued)

AutoLogon Settings Value

Username username
(username and password are the credentials used for auto
logon when the newly provisioned machine boots into the
guest operating system. Administrator is typically used.)
Password password

(username andpassword are the credentials used for auto
logon when the newly provisioned machine boots into the
guest operating system. Administrator is typically used.)

Note For reference machines that use a Windows
platform newer than Windows Server 2003/Windows XP,
you must set the autologon password by using the custom
property Sysprep.Guilnattended.AdminPassword. A
convenient way to ensure this is done is to create a
property group that includes this custom property so that
tenant administrators and business group managers can
include this information correctly in their blueprints.

Preparing for WIM Provisioning with VirtlO Drivers

If you are using VirtlO for network or storage interfaces, you must ensure that the necessary
drivers are included in your WInPE image and WIM image. VirtlO generally offers better
performance when provisioning with KVM (RHEV).

Windows drivers for VirtlO are included as part of the Red Hat Enterprise Virtualization and are
located in the /usr/share/virtio-win directory on the file system of the Red Hat Enterprise
Virtualization Manager. The drivers are also included in the Red Hat Enterprise Virtualization
Guest Tools located /usr/share/rhev-guest-tools-iso/rhev-tools-setup.iso.

The high-level process for enabling WIM-based provisioning with VirtlO drivers is as follows:

1 Create a WIM image from a Windows reference machine with the VirtlO drivers installed or
insert the drivers into an existing WIM image.

2 Copy the VirtlO driver files and insert the drivers into a WIinPE image.

3 Upload the WInPE image ISO to the Red Hat Enterprise Virtualization ISO storage domains
using the rhevm-iso-uploader command. For more information about managing ISO images in
RHEV refer to the Red Hat documentation.

4 Create a KVM (RHEV) blueprint for WIM provisioning and select the WInPE ISO option. The
custom property VirtualMachine.Admin.DiskInterfaceType must be included with the value
VirtlIO. A fabric administrator can include this information in a property group for inclusion on
blueprints.

The custom properties Image.IS0O.Location and Image.ISO.Name are not used for KVM (RHEV)
blueprints.
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Manually Insert the Guest Agent into a WIinPE Image

You must manually insert the vRealize Automation guest agent into your WiIinPE image.

Prerequisites

Select a Windows system from which the staging area you prepared is accessible and on
which .NET 4.5 and Windows Automated Installation Kit (AIK) for Windows 7 (including
WinPE 3.0) are installed.

Create a WInPE.

Procedure

Install the Guest Agent in a WInPE

You must manually copy the guest agent files to your WIinPE image.

2 Configure the doagent.bat File

You must manually configure the doagent.bat file.
3 Configure the doagentc.bat File

You must manually configure the doagentc.bat file.
4 Configure the Guest Agent Properties Files

You must manually configure the guest agent properties files.
Procedure
1 Install the Guest Agent in a WInPE.
2 Configure the doagent.bat File.
3 Configure the doagentc.bat File.
4 Configure the Guest Agent Properties Files.

Install the Guest Agent in a WinPE

You must manually copy the guest agent files to your WIinPE image.

Prerequisites

Select a Windows system from which the staging area you prepared is accessible and on
which .NET 4.5 and Windows Automated Installation Kit (AIK) for Windows 7 (including
WiInPE 3.0) are installed.

Create a WInPE.
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Procedure

¢ Download and install the vRealize Automation guest agent from https://
vRealize_VA_Hostname_fqgdn/software/index.html.

a

Download GugentZip_versionto the C drive on the reference machine.

Select either GuestAgentInstaller.exe (32-bit) or GuestAgentInstaller_x64.exe (64-
bit) depending on which is appropriate for your operating system.

Right-click the file and select Properties.
Click General.

Click Unblock.

Extract the files to C:\.

This produces the directory C:\VRMGuestAgent. Do not rename this directory.

What to do next

Configure the doagent.bat File.

Configure the doagent.bat File

You must manually configure the doagent.bat file.

Prerequisites

Install the Guest Agent in a WInPE.

Procedure

1 Navigate to the VRMGuestAgent directory within your WIinPE Image.

For example: C:\Program Files (x86)\VMware\Plugins\VRM Agent\VRMGuestAgent.

2 Make a copy of the file doagent-template.bat and name it doagent.bat.

3 Open doagent.bat in a text editor.

4 Replace all instances of the string #Dcac Hostname# with the fully qualified domain name and
port number of the laaS Manager Service host.

Option Description

If you are using a load balancer Enter the fully qualified domain name and port of the load balancer for the

laaS Manager Service. For example,

manager_service_LB.mycompany.com:443

With no load balancer Enter the fully qualified domain name and port of the machine on which the

laaS Manager Service is installed. For example,

manager_service.mycompany.com:443

5 Replace all instances of the string #Protocol# with the string /ss1.
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6 Replace all instances of the string #Comment# with REM (REM must be followed by a trailing
space).

7 (Optional) If you are using self-signed certificates, uncomment the openSSL command.
echo QUIT | c:\VRMGuestAgent\bin\openssl s_client -connect

8 Save and close the file.

9 Edit the Startnet.cmd script for your WInPE to include the doagent.bat as a custom script.

What to do next

Configure the doagentc.bat File.

Configure the doagentc.bat File

You must manually configure the doagentc.bat file.

Prerequisites

Configure the doagent.bat File.

Procedure

1 Navigate to the VRMGuestAgent directory within your WIinPE Image.

For example: C:\Program Files (x86)\VMware\Plugins\VRM Agent\VRMGuestAgent.
Make a copy of the file doagentsvc-template.bat and name it doagentc.bat.

Open doagentc.bat in a text editor.

Remove all instance of the string #Comment#.

aua b~ W N

Replace all instances of the string #Dcac Hostname# with the fully qualified domain name and
port number of the Manager Service host.

The default port for the Manager Service is 443.

Option Description

If you are using a load balancer Enter the fully qualified domain name and port of the load balancer for the
Manager Service. For example,

load_balancer_manager_service.mycompany.com:443

With no load balancer Enter the fully qualified domain name and port of the Manager Service. For
example,

manager_service.mycompany.com:443

6 Replace all instances of the string #errorlevel# with the character 1.
7 Replace all instances of the string #Protocol# with the string /ss1.

8 Save and close the file.
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What to do next

Configure the Guest Agent Properties Files.

Configure the Guest Agent Properties Files
You must manually configure the guest agent properties files.
Prerequisites

Configure the doagentc.bat File.

Procedure

1 Navigate to the VRMGuestAgent directory within your WIinPE Image.

For example: C:\Program Files (x86)\VMware\Plugins\VRM Agent\VRMGuestAgent.

Make a copy of the file gugent.properties and name it gugent.properties.template.

Make a copy of the file gugent.properties.template and name it gugentc.properties.

Open gugent.properties in a text editor.

Replace all instances of the string GuestAgent.log the string X:/VRMGuestAgent/GuestAgent.log.
Save and close the file.

Open gugentc.properties in a text editor.

Replace all instances of the string GuestAgent.log the string C:/VRMGuestAgent/GuestAgent.log.

W 0 N o U1 b W N

Save and close the file.

Preparing for Virtual Machine Image Provisioning

Before you provision instances with OpenStack, you must have virtual machine images and
flavors configured in the OpenStack provider.

Virtual Machine Images

You can select an virtual machine image from a list of available images when creating blueprints
for OpenStack resources.

A virtual machine image is a template that contains a software configuration, including an
operating system. Virtual machine images are managed by the OpenStack provider and are
imported during data collection.

If an image that is used in a blueprint is later deleted from the OpenStack provider, it is also
removed from the blueprint. If all the images have been removed from a blueprint, the blueprint
is deactivated and cannot be used for machine requests until it is edited to add at least one
image.

OpenStack Flavors

You can select one or more flavors when creating OpenStack blueprints.
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OpenStack flavors are virtual hardware templates that define the machine resource specifications
for instances provisioned in OpenStack. Flavors are managed by the OpenStack provider and are
imported during data collection.

vRealize Automation supports several flavors of OpenStack. For the most current information
about OpenStack flavor support, see the vRealize Automation Support Matrix at https://
www.vmware.com/support/pubs/vcac-pubs.html.

Preparing for Amazon Machine Image Provisioning

Prepare your Amazon Machine Images and instance types for provisioning in vRealize
Automation.

Understanding Amazon Machine Images

You can select an Amazon machine image from a list of available images when creating Amazon
machine blueprints.

An Amazon machine image is a template that contains a software configuration, including an
operating system. They are managed by Amazon Web Services accounts. vRealize Automation
manages the instance types that are available for provisioning.

The Amazon machine image and instance type must be available in an Amazon region. Not all
instance types are available in all regions.

You can select an Amazon machine image provided by Amazon Web Services, a user
community, or the AWS Marketplace site. You can also create and optionally share your own
Amazon machine images. A single Amazon machine image can be used to launch one or many
instances.

The following considerations apply to Amazon machine images in the Amazon Web Services
accounts from which you provision cloud machines:

m  Each blueprint must specify an Amazon machine image.

A private Amazon machine image is available to a specific account and all its regions. A public
Amazon machine image is available to all accounts, but only to a specific region in each
account.

. When the blueprint is created, the specified Amazon machine image is selected from regions
that have been data-collected. If multiple Amazon Web Services accounts are available, the
business group manager must have rights to any private Amazon machine images. The
Amazon machine image region and the specified user location restrict provisioning request to
reservations that match the corresponding region and location.

m  Use reservations and policies to distribute Amazon machine images in your Amazon Web
Services accounts. Use policies to restrict provisioning from a blueprint to a particular set of
reservations.
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m VRealize Automation cannot create user accounts on a cloud machine. The first time a
machine owner connects to a cloud machine, she must log in as an administrator and add her
vRealize Automation user credentials or an administrator must do that for her. She can then
log in using her vRealize Automation user credentials.

If the Amazon machine image generates the administrator password on every boot, the Edit
Machine Record page displays the password. If it does not, you can find the password in the
Amazon Web Services account. You can configure all Amazon machine images to generate
the administrator password on every boot. You can also provide administrator password
information to support users who provision machines for other users.

m  To allow remote Microsoft Windows Management Instrumentation (WMI) requests on cloud
machines provisioned in Amazon Web Services accounts, enable a Microsoft Windows
Remote Management (WinRM) agent to collect data from Windows machines managed by
vRealize Automation. See Installing vRealize Automation.

m A private Amazon machine image can be seen across tenants.

For related information, see Amazon Machine Images (AMI) topics in Amazon documentation.

Understanding Amazon Instance Types

An laaS architect selects one or more Amazon instance types when creating Amazon EC2
blueprints. An laaS administrator can add or remove instance types to control the choices
available to the architects.

An Amazon EC2 instance is a virtual server that can run applications in Amazon Web Services.
Instances are created from an Amazon machine image and by choosing an appropriate instance

type.

To provision a machine in an Amazon Web Services account, an instance type is applied to the
specified Amazon machine image. The available instance types are listed when architects create
the Amazon EC2 blueprint. Architects select one or more instance types, and those instance
types become choices available to the user when they request to provision a machine. The
instance types must be supported in the designated region.

For related information, see Selecting Instance Types and Amazon EC2 Instance Details topics in
Amazon documentation.
Add an Amazon Instance Type

Several instance types are supplied with vRealize Automation for use with Amazon blueprints. An
administrator can add and remove instance types.

The machine instance types managed by laaS administrators are available to blueprint architects
when they create or edit an Amazon blueprint. Amazon machine images and instance types are
made available through the Amazon Web Services product.

Prerequisites

Log in to vRealize Automation as an laaS administrator.
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Procedure

1 Click Infrastructure > Administration > Instance Types.

2 Click New.

3 Add anew instance type, specifying the following parameters.

Information about the available Amazon instances types and the setting values that you can
specify for these parameters is available from Amazon Web Services documentation in EC2
Instance Types - Amazon Web Services (AWS) at aws.amazon.com/ec2 and Instance Types
at docs.aws.amazon.com.

= Name

s APl name

m  Type Name

m |O Performance Name
m  CPUs

s Memory (GB)

m  Storage (GB)

s Compute Units
4 Click the Save icon (©).

Results

When laaS architects create Amazon Web Services blueprints, they can use your custom
instance types.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.
Scenario: Prepare vSphere Resources for Machine Provisioning in
Rainpole

As the vSphere administrator creating templates for vRealize Automation, you want to use the
vSphere Web Client to prepare for cloning CentOS machines in vRealize Automation.

Prepare Install Prepare Request Initial
Installation Template Content

@You are here
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You want to convert an existing CentOS reference machine into a vSphere template so you and
your Rainpole architects can create blueprints for cloning CentOS machines in vRealize
Automation. To prevent any conflicts that might arise from deploying multiple virtual machines
with identical settings, you also want to create a general customization specification that you and
your architects can use to create clone blueprints for Linux templates.

Procedure

1 Scenario: Convert Your CentOS Reference Machine into a Template for Rainpole

Using the vSphere Client, you convert your existing CentOS reference machine into a
vSphere template for your vRealize Automation laaS architects to reference as the base for
their clone blueprints.

2 Scenario: Create a Customization Specification for Cloning Linux Machines in Rainpole

Using the vSphere Client, you create a standard customization specification for your
vRealize Automation laaS architects to use when they create clone blueprints for Linux
machines.

Scenario: Convert Your CentOS Reference Machine into a Template for Rainpole

Using the vSphere Client, you convert your existing CentOS reference machine into a vSphere
template for your vRealize Automation laaS architects to reference as the base for their clone
blueprints.

Procedure
1 Login to your reference machine as the root user and prepare the machine for conversion.

a Remove udev persistence rules.
/bin/rm -f /etc/udev/rules.d/70%*
b Enable machines cloned from this template to have their own unique identifiers.

/bin/sed -i '/A\(HWADDR\ |UUID\)=/d"'
/etc/sysconfig/network-scripts/ifcfg-etho

¢ Power down the machine.
shutdown -h now

Log in to the vSphere Web Client as an administrator.
Click the VM Options tab.

Right-click your reference machine and select Edit Settings.

a b~ W N

Enter Rainpole_centos_63_x86 in the VM Name text box.
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6 Even though your reference machine has a CentOS guest operating system, select Red Hat
Enterprise Linux 6 (64-bit) from the Guest OS Version drop-down menu.

If you select CentOS, your template and customization specification might not work as
expected.

7 Right-click your Rainpole_centos_63_x86 reference machine in the vSphere Web Client and
select Template > Convert to Template.

Results

vCenter Server marks your Rainpole_centos_63_x86 reference machine as a template and
displays the task in the Recent Tasks pane.

What to do next

To prevent any conflicts that might arise from deploying multiple virtual machines with identical
settings, you create a general customization specification that you and your Rainpole architects
can use to create clone blueprints for Linux templates.

Scenario: Create a Customization Specification for Cloning Linux Machines in
Rainpole

Using the vSphere Client, you create a standard customization specification for your vRealize
Automation laaS architects to use when they create clone blueprints for Linux machines.

Procedure
1 On the home page, click Customization Specification Manager to open the wizard.
2 Click the New icon.
3 Specify properties.
a Select Linux from the Target VM Operating System drop-down menu.
b Enter Linux in the Customization Spec Name text box.
c Enter Rainpole Linux cloning with vRealize Automation in the Description text box.
d Click Next.
4 Set computer name.
a Select Use the virtual machine name.

b Enter the domain on which cloned machines are going to be provisioned in the Domain
name text box.

For example, rainpole.local.
¢ Click Next.
5 Configure time zone settings.

6 Click Next.
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7 Select Use standard network settings for the guest operating system, including enabling
DHCP on all network interfaces.

8 Follow the prompts to enter the remaining required information.

9 On the Ready to complete page, review your selections and click Finish.

Results

You have a general customization specification that you can use to create blueprints for cloning
Linux machines.

What to do next

Log in to the vRealize Automation console as the configuration administrator you created during
the installation and request the catalog items that quickly set up your proof of concept.

Preparing for Software Provisioning

Use Software to deploy applications and middleware as part of the vRealize Automation
provisioning process for vSphere, vCloud Director,vCloud Air, and Amazon AWS machines.

You can deploy Software on machines if your blueprint supports Software and if you install the
guest agent and software bootstrap agent on your reference machines before you convert them
into templates, snapshots, or Amazon Machine Images.

For related information about specifying ports when preparing for provisioning, see Secure
Configuration Guide and Reference Architecture at VMware vRealize Automation Information.

Table 1-17. Provisioning Methods that Support Software

Provisioning
Machine Type Method Required Preparation

vSphere Clone A clone blueprint provisions a complete and independent virtual machine based on a
vCenter Server virtual machine template. If you want your templates for cloning to
support Software components, install the guest agent and software bootstrap agent
on your reference machine as you prepare a template for cloning. See Checklist for
Preparing to Provision by Cloning.

vSphere Linked Clone A linked clone blueprint provisions a space-efficient copy of a vSphere machine
based on a snapshot, using a chain of delta disks to track differences from the
parent machine. If you want your linked clone blueprints to support Software
components, install the guest agent and software bootstrap agent on the machine
before you take the snapshot.

If your snapshot machine was cloned from a template that supports Software, the
required agents are already installed.

vCloud Director Clone A clone blueprint provisions a complete and independent virtual machine based on a
vCenter Server virtual machine template. If you want your templates for cloning to
support Software components, install the guest agent and software bootstrap agent
on your reference machine as you prepare a template for cloning. See Checklist for
Preparing to Provision by Cloning.
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Table 1-17. Provisioning Methods that Support Software (continued)

Provisioning
Machine Type Method Required Preparation

vCloud Air Clone A clone blueprint provisions a complete and independent virtual machine based on a
vCenter Server virtual machine template. If you want your templates for cloning to
support Software components, install the guest agent and software bootstrap agent
on your reference machine as you prepare a template for cloning. See Checklist for
Preparing to Provision by Cloning.

Amazon AWS Amazon An Amazon machine image is a template that contains a software configuration,
Machine including an operating system. If you want to create an Amazon machine image that
Image supports Software, connect to a running Amazon AWS instance that uses an EBS

volume for the root device. Install the guest agent and software bootstrap agent on
the reference machine, then create an Amazon Machine Image from your instance.
For instruction on creating Amazon EBS-backed AMIs, see the Amazon AWS
documentation.

For the guest agent and Software bootstrap agent to function on provisioned
machines, you must configure network-to-VPC connectivity.

Preparing to Provision Machines with Software

To support Software components, you must install the guest agent and Software bootstrap
agent on your reference machine before you convert to a template for cloning, create an
Amazon machine image, or take a snapshot.

Prepare a Windows Reference Machine to Support Software

You use a single script to install the Java Runtime Environment, guest agent, and Software
bootstrap agent on a Windows reference machine. From the reference machine, you can create
a template for cloning, a snapshot, or an Amazon machine image that supports Software
components.

Software supports scripting with Windows CMD and PowerShell 2.0.

Important The startup process must not be interrupted. Configure the virtual machine so that
nothing pauses the virtual machine startup process before reaching the login prompt. For
example, verify that no processes or scripts prompt for user interaction while the virtual machine
starts.

Prerequisites

m Identify or create a Windows reference machine.

m  Establish secure trust between the reference machine and your laaS Manager Service host.
See Configuring the Guest Agent to Trust a Server.

= |f you plan to remotely access the machine for troubleshooting or other reasons, install
Remote Desktop Services (RDS).

m  Remove network configuration artifacts from the network configuration files.
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Procedure

1 Login to the Windows reference server as an administrator.

2 Open a browser to the software download page on the vRealize Automation appliance.
https://vrealize-automation-appliance-FQDN/software

3 Save the template ZIP to the Windows server.
prepare_vra_template_windows.zip

4 Extract the ZIP contents to a folder, and run the batch file.
.\prepare_vra_template.bat

5 Follow the prompts.

6 When finished, shut down the Windows virtual machine.

Results

The script removes any previous guest or Software bootstrap agents, and installs the supported
versions of the Java Runtime Environment, the guest agent, and the Software bootstrap agent.

What to do next

Convert the reference machine into a template for cloning, a snapshot, or an Amazon machine
image. Each supports Software components, and infrastructure architects can use them when
creating blueprints.

Prepare a Linux Reference Machine to Support Software

You use a single script to install the Java Runtime Environment, guest agent, and Software
bootstrap agent on your Linux reference machine. From the reference machine, you can create a
template for cloning, a snapshot, or an Amazon machine image that supports Software
components.

Software supports scripting with Bash.
Important The boot process must not be interrupted. Configure the virtual machine so that
nothing pauses the virtual machine boot process before reaching the login prompt. For example,
verify that no processes or scripts prompt for user interaction while the virtual machine starts.
Prerequisites
m |dentify or create a Linux reference machine.
m  Verify that the following commands are available, depending on your Linux system:

®m  yumor apt-get

m  wget orcurl

= python
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m dmidecode as required by cloud providers

s Common requirements such as sed, awk, perl, chkconfig, unzip, and grep depending on
your Linux distribution

You might also use an editor to inspect the downloaded prepare_vra_template.sh script,
which exposes the commands that it uses.

If you plan to remotely access the machine for troubleshooting or other reasons, install
OpenSSH.

Remove network configuration artifacts from the network configuration files.

Procedure

1 Login to your reference machine as root.

2 Download the template tar.gz package from the vRealize Automation appliance.
wget https://vrealize-automation-appliance-FQDN/software/download/
prepare_vra_template.tar.gz
If your environment is using self-signed certificates, you might need the ——no-check-
certificate option.
wget —-no-check-certificate https://vrealize-automation-appliance-FQDN/software/download/
prepare_vra_template.tar.gz

3 Untar the package.
tar -xvf prepare_vra_template.tar.gz

4 In the untar output, find the installer script, and make it executable.
chmod +x prepare_vra_template.sh

5 Run the installer script.
./prepare_vra_template.sh
If you need information about non-interactive options and expected values, see the script
help.
./prepare_vra_template.sh —-help

6 Follow the prompts.
A confirmation appears when installation succeeds. If errors and logs appear, resolve the
errors and rerun the script.

7 When finished, shut down the Linux virtual machine.

Results

The script removes any previous guest or Software bootstrap agents, and installs the supported
versions of the Java Runtime Environment, the guest agent, and the Software bootstrap agent.
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What to do next

On your hypervisor or cloud provider, turn the reference machine into a template for cloning, a
snapshot, or an Amazon machine image. Each supports Software components, and infrastructure
architects can use them when creating blueprints.

Updating Existing Virtual Machine Templates in vRealize Automation

If you are updating your templates, Amazon Machine Images, or snapshots for the latest version
of the Windows Software bootstrap agent, or if you are manually updating to the latest Linux
Software bootstrap agent instead of using the prepare_vra_template.sh script, you need to
remove any existing versions and delete any logs.

Linux

For Linux reference machines, running the prepare_vra_template.sh script script resets the
agent and removes any logs for you before reinstalling. However, if you intend to manually
install, you need to log in to the reference machine as the root user and run the command to
reset and remove the artifacts.

/opt/vmware-appdirector/agent-bootstrap/agent_reset.sh

Windows

For Windows reference machines, you remove the existing Software agent bootstrap and
vRealize Automation 6.0 or later guest agent, and delete any existing runtime log files. In a
PowerShell command window, run the commands to remove the agent and artifacts.

c:\opt\vmware-appdirector\agent-bootstrap\appd_bootstrap_removal.bat

Scenario: Prepare a vSphere CentOS Template for Clone Machine
and Software Component Blueprints

As a vCenter Server administrator, you want to prepare a vSphere template that your vRealize
Automation architects can use to clone Linux CentOS machines. You want to ensure that your
template supports blueprints with software components, so you install the guest agent and the
software bootstrap agent before you turn your reference machine into a template.

Prerequisites

m Identify or create a Linux CentOS reference machine with VMware Tools installed. Include at
least one Network Adapter to provide internet connectivity in case blueprint architects do
not add this functionality at the blueprint level. For information about creating virtual
machines, see the vSphere documentation.
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m  You must be connected to a vCenter Server to convert a virtual machine to a template. You
cannot create templates if you connect the vSphere Client directly to an vSphere ESXi host.

Procedure

1 Scenario: Prepare Your Reference Machine for Guest Agent Customizations and Software
Components

So that your template can support software components, you install the software bootstrap
agent and its prerequisite, the guest agent, on your reference machine. The agents ensure
that vRealize Automation architects who use your template can include software
components in their blueprints.

2 Scenario: Convert Your CentOS Reference Machine into a Template

After you install the guest agent and software bootstrap agent onto your reference
machine, you turn your reference machine into a template that vRealize Automation
architects can use to create clone machine blueprints.

3 Scenario: Create a Customization Specification for vSphere Cloning

Create a customization specification for your blueprint architects to use with your
cpb_centos_63_x84 template.

Results

You created a template and customization specification from your reference machine that
blueprint architects can use to create vRealize Automation blueprints that clone Linux CentOS
machines. Because you installed the Software bootstrap agent and the guest agent on your
reference machine, architects can use your template to create elaborate catalog item blueprints
that include Software components or other guest agent customizations such as running scripts or
formatting disks. Because you installed VMware Tools, architects and catalog administrators can
allow users to perform actions against machines, such as reconfigure, snapshot, and reboot.

What to do next

After you configure vRealize Automation users, groups, and resources, you can use your
template and customization specification to create a machine blueprint for cloning. See Installing
and Configuring vRealize Automation for the Rainpole Scenario.

Scenario: Prepare Your Reference Machine for Guest Agent Customizations and
Software Components

So that your template can support software components, you install the software bootstrap
agent and its prerequisite, the guest agent, on your reference machine. The agents ensure that
vRealize Automation architects who use your template can include software components in their
blueprints.

To simplify the process, you download and run a vRealize Automation script that installs both
agents, instead of downloading and installing separate packages.
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The script also connects to the Manager Service instance and downloads the SSL certificate,
which establishes trust between the Manager Service and machines deployed from the template.
Note that having the script download the certificate is less secure than manually obtaining the
Manager Service SSL certificate and installing it on your reference machine in /usr/share/
gugent/cert.pem.

Procedure

1 In your Web browser, open the following URL.
https://vrealize-automation-appliance-FQDN/software/index.html

2 Save the prepare_vra_template.sh script to your reference machine.

3 On the reference machine, make prepare_vra_template.sh executable.

chmod +x prepare_vra_template.sh

4 Run prepare_vra_template.sh.
./prepare_vra_template.sh

5 Follow the prompts.

If you need non-interactive information about options and values, enter ./

prepare_vra_template.sh —-help.

Results
A confirmation message appears when installation finishes. If error messages and logs appear,

correct the issues and rerun the script.

Scenario: Convert Your CentOS Reference Machine into a Template

After you install the guest agent and software bootstrap agent onto your reference machine, you
turn your reference machine into a template that vRealize Automation architects can use to
create clone machine blueprints.

After you convert your reference machine to a template, you cannot edit or power on the
template unless you convert it back to a virtual machine.

Procedure
1 Log in to your reference machine as the root user and prepare the machine for conversion.

a Remove udev persistence rules.
/bin/rm -f /etc/udev/rules.d/70%*
b Enable machines cloned from this template to have their own unique identifiers.

/bin/sed —i '/A\(HWADDR\ |UUID\)=/d"'
/etc/sysconfig/network-scripts/ifcfg-etho
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c If you rebooted or reconfigured the reference machine after installing the software
bootstrap agent, reset the agent.

/opt/vmware-appdirector/agent-bootstrap/agent_reset.sh
d Power down the machine.

shutdown —h now

Log in to the vSphere Web Client as an administrator.
Right-click your reference machine and select Edit Settings.

Enter cpb_centos_63_x84 in the VM Name text box.

g »~ W N

Even though your reference machine has a CentOS guest operating system, select Red Hat
Enterprise Linux 6 (64-bit) from the Guest OS Version drop-down menu.

If you select CentOS, your template and customization specification might not work as
expected.

6 Right-click your reference machine in the vSphere Web Client and select Template > Convert
to Template.

Results

vCenter Server marks your cpb_centos_63_x84 reference machine as a template and displays
the task in the Recent Tasks pane. If you have already brought your vSphere environment under
vRealize Automation management, your template is discovered during the next automated data
collection. If you have not configured your vRealize Automation yet, the template is collected
during that process.

Scenario: Create a Customization Specification for vSphere Cloning

Create a customization specification for your blueprint architects to use with your
cpb_centos_63_x84 template.

Procedure
1 Login to the vSphere Web Client as an administrator.
2 On the home page, click Customization Specification Manager to open the wizard.
3 Click the New icon.
4 Click the New icon.
5 Specify properties.
a Select Linux from the Target VM Operating System drop-down menu.

b Enter Customspecs in the Customization Spec Name text box.
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c Enter cpb_centos_63_x84 cloning with vRealize Automation in the Description text
box.

d Click Next.
6 Set computer name.
a Select Use the virtual machine name.

b Enter the domain on which cloned machines are going to be provisioned in the Domain
name text box.

c Click Next.
7 Configure time zone settings.
8 Click Next.

9 Select Use standard network settings for the guest operating system, including enabling
DHCP on all network interfaces.

Fabric administrators and infrastructure architects handle network settings for provisioned
machine by creating and using Network profiles in vRealize Automation.

10 Follow the prompts to enter the remaining required information.

11 On the Ready to complete page, review your selections and click Finish.

Results

Scenario: Prepare for Importing the Dukes Bank for vSphere Sample
Application Blueprint

As a vCenter Server administrator, you want to prepare a vSphere CentOS 6.x Linux template
and customization specification that you can use to provision the vRealize Automation Dukes
Bank sample application.

You want to ensure that your template supports the sample application software components, so
you install the guest agent and the software bootstrap agent onto your Linux reference machine
before you convert it to a template and create a customization specification. You deactivate
SELinux on your reference machine to ensure your template supports the specific
implementation of MySQL used in the Dukes Bank sample application.

Prerequisites

m Identify or create a CentOS 6.x Linux reference machine with VMware Tools installed. For
information about creating virtual machines, see the vSphere documentation.
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m  You must be connected to a vCenter Server to convert a virtual machine to a template. You
cannot create templates if you connect the vSphere Client directly to an vSphere ESXi host.

Procedure

1 Scenario: Prepare Your Reference Machine for the Dukes Bank vSphere Sample Application

You want your template to support the Dukes Bank sample application, so you must install
both the guest agent and the software bootstrap agent on your reference machine so
vRealize Automation can provision the software components. To simplify the process, you
download and run a vRealize Automation script that installs both the guest agent and the
software bootstrap agent instead of downloading and installing the packages separately.

2 Scenario: Convert Your Reference Machine into a Template for the Dukes Bank vSphere
Application

After you install the guest agent and software bootstrap agent on your reference machine,
you deactivate SELinux to ensure your template supports the specific implementation of
MySQL used in the Dukes Bank sample application. You turn your reference machine into a
template that you can use to provision the Dukes Bank vSphere sample application.

3 Scenario: Create a Customization Specification for Cloning the Dukes Bank vSphere Sample
Application Machines

You create a customization specification to use with your Dukes Bank machine template.
Results
You created a template and customization specification from your reference machine that
supports the vRealize Automation Dukes Bank sample application.
Scenario: Prepare Your Reference Machine for the Dukes Bank vSphere Sample
Application

You want your template to support the Dukes Bank sample application, so you must install both
the guest agent and the software bootstrap agent on your reference machine so vRealize
Automation can provision the software components. To simplify the process, you download and
run a vRealize Automation script that installs both the guest agent and the software bootstrap
agent instead of downloading and installing the packages separately.

Procedure
1 Login to your reference machine as the root user.

2 Download the installation script from your vRealize Automation appliance.

wget https://vRealize_VA_Hostname_fqdn/software/download/prepare_vra_template.sh
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If your environment is using self-signed certificates, you might have to use the wget option —
no—check-certificate option. For example:

wget ——no-check-certificate https://vRealize_VA_Hostname_fgdn/software/download/
prepare_vra_template.sh

3 Make the prepare_vra_template.sh script executable.
chmod +x prepare_vra_template.sh

4 Run the prepare_vra_template.sh installer script.
./prepare_vra_template.sh

You can run the help command . /prepare_vra_template.sh ——help for information about non-
interactive options and expected values.

5 Follow the prompts to complete the installation.

You see a confirmation message when the installation is successfully completed. If you see an
error message and logs in the console, resolve the errors and run the installer script again.

Results

You installed both the software bootstrap agent and its prerequisite, the guest agent, to ensure
the Dukes Bank sample application successfully provisions software components. The script also
connected to your Manager Service instance and downloaded the SSL certificate to establish
trust between the Manager Service and machines deployed from your template. This is a less
secure approach than obtaining the Manager Service SSL certificate and manually installing it on
your reference machine in /usr/share/gugent/cert.pem, and you can manually replace this
certificate now if security is a high priority.

Scenario: Convert Your Reference Machine into a Template for the Dukes Bank
vSphere Application

After you install the guest agent and software bootstrap agent on your reference machine, you
deactivate SELinux to ensure your template supports the specific implementation of MySQL used
in the Dukes Bank sample application. You turn your reference machine into a template that you
can use to provision the Dukes Bank vSphere sample application.

After you convert your reference machine to a template, you cannot edit or power on the
template unless you convert it back to a virtual machine.
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Procedure
1 Loginto your reference machine as the root user.

a Edityour /etc/selinux/config file to deactivate SELinux.

SELINUX=disabled

If you do not deactivate SELinux, the MySQL software component of the Duke's Bank
Sample application might not work as expected.

b Remove udev persistence rules.
/bin/rm -f /etc/udev/rules.d/70%*
¢ Enable machines cloned from this template to have their own unique identifiers.

/bin/sed —i '/A\(HWADDR\ |UUID\)=/d"'
/etc/sysconfig/network-scripts/ifcfg-etho

d If you rebooted or reconfigured the reference machine after installing the software
bootstrap agent, reset the agent.

/opt/vmware-appdirector/agent-bootstrap/agent_reset.sh
e Power down the machine.

shutdown —h now

2 Loginto the vSphere Web Client as an administrator.

3 Right-click your reference machine and select Edit Settings.

4 Enter dukes_bank_template in the VM Name text box.

5 |If your reference machine has a CentOS guest operating system, select Red Hat Enterprise
Linux 6 (64-bit) from the Guest OS Version drop-down menu.
If you select CentOS, your template and customization specification might not work as
expected.

6 Click OK.

7 Right-click your reference machine in the vSphere Web Client and select Template > Convert
to Template.

Results

vCenter Server marks your dukes_bank_template reference machine as a template and displays
the task in the Recent Tasks pane. If you have already brought your vSphere environment under
vRealize Automation management, your template is discovered during the next automated data
collection. If you have not configured your vRealize Automation yet, the template is collected
during that process.
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Scenario: Create a Customization Specification for Cloning the Dukes Bank
vSphere Sample Application Machines

You create a customization specification to use with your Dukes Bank machine template.

Procedure
1 Login to the vSphere Web Client as an administrator.
2 On the home page, click Customization Specification Manager to open the wizard.
3 Click the New icon.
4 Specify properties.
a Select Linux from the Target VM Operating System drop-down menu.
b Enter Customspecs_sample in the Customization Spec Name text box.
c Enter Dukes Bank customization spec in the Description text box.
d Click Next.
5 Set computer name.
a Select Use the virtual machine name.

b Enter the domain on which you want to provision the Dukes Bank sample application in
the Domain name text box.

c Click Next.
6 Configure time zone settings.
7 Click Next.

8 Select Use standard network settings for the guest operating system, including enabling
DHCP on all network interfaces.

Fabric administrators and infrastructure architects handle network settings for provisioned
machine by creating and using Network profiles in vRealize Automation.

9 Follow the prompts to enter the remaining required information.

10 On the Ready to complete page, review your selections and click Finish.

Results

You created a template and customization specification that you can use to provision the Dukes
Bank sample application.

What to do next

1 Create an external network profile to provide a gateway and a range of IP addresses. See
Create an External Network Profile by Using A Third-Party IPAM Provider.
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2 Map your external network profile to your vSphere reservation. See Create a Reservation for
Hyper-V, KVM, SCVMM, vSphere, or XenServer. The sample application cannot provision
successfully without an external network profile.

3 Import the Duke's Bank sample application into your environment. See Scenario: Importing
the Dukes Bank for vSphere Sample Application and Configuring for Your Environment.
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Tenant and Resource
Preparations for Blueprint
Provisioning

You can configure multiple tenant environments, each with their own groups of users and unique
access to resources that you bring under vRealize Automation management.

This chapter includes the following topics:
m  Configuring Tenant Settings
m  Configuring Resources

m  User Preferences for Notifications and Delegates

Configuring Tenant Settings

Tenant administrators configure tenant settings such as user authentication, and manage user
roles and business groups. System administrators and tenant administrators configure options
such as email servers to handle notifications, and branding for the vRealize Automation console.

You can use the Configuring Tenant Settings Checklist to see a high-level overview of the
sequence of steps required to configure tenant settings.

Table 2-1. Checklist for Configuring Tenant Settings

VRealize
Task Automation Role Details
U Create local user accounts and assign a tenant System For an example of creating local user
administrator. administrator accounts, see Installing and Configuring
vRealize Automation for the Rainpole
Scenario.
U Configure Directories Management to set up tenant Tenant Choosing Directories Management
identity management and access control settings. administrator Configuration Options
U Create business groups and custom groups, and grant  Tenant Configuring Groups and User Roles
user access rights to the vRealize Automation console. administrator
U (Optional) Create additional tenants so users can System Create Additional Tenants

access the appropriate applications and resources they administrator
need to complete their work assignments.
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Table 2-1. Checklist for Configuring Tenant Settings (continued)

Task

U (Optional) Configure custom branding on the tenant
login and application pages of the vRealize Automation
console.

0 (Optional) Configure vRealize Automation to send
users notifications when specific events occur.

U (Optional) Configure vRealize Orchestrator to support
XaaS and other extensibility.

U (Optional) Create a custom remote desktop protocol
file that laaS architects use in blueprints to configure
RDP settings.

U (Optional) Define datacenter locations that your fabric
administrators and laaS architects can leverage to allow
users to select an appropriate location for provisioning
when they request machines.

VRealize

Automation Role

Details

m  System Configuring Custom Branding
administrator

®  Tenant
administrator

m  System Checklist for Configuring Notifications
administrator

m  Tenant
administrator

m  System Configuring vRealize Orchestrator
administrator

m  Tenant
administrator

System Create a Custom RDP File to Support

administrator

System
administrator

RDP Connections for Provisioned
Machines

For an example of adding datacenter
locations, see Scenario: Add Datacenter
Locations for Cross Region
Deployments .

Choosing Directories Management Configuration Options

You can use vRealize Automation Directories Management features to configure an Active
Directory link in accordance with your user authentication requirements.

Directories Management provides many options to support a highly customized user

authentication.

Table 2-2. Choosing Directories Management Configuration Options

Configuration Option

Configure a link to your Active Directory.

(Optional) Enhance security of a user ID and password
based directory link by configuring bi-directional
integration with Active Directory Federated Services.

(Optional) Add users and groups to an existing Active
Directory Link .
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Procedure

1

Configure a link to your Active Directory. See Configure
an Active Directory over LDAP/IWA Link .

If you configured vRealize Automation for high
availability, see Configure Directories Management for
High Availability.

Configure a Bi Directional Trust Relationship Between

vRealize Automation and Active Directory

Add Users or Groups to an Active Directory Connection.
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Table 2-2. Choosing Directories Management Configuration Options (continued)

Configuration Option Procedure

(Optional) Edit the default policy to apply custom rules for Manage the User Access Policy.
an Active Directory link.

(Optional) Configure network ranges to restrict the IP Add or Edit a Network Range.
addresses through which users can log in to the system,

manage login restrictions (timeout, number of login

attempts before lock-out).

Directories Management Overview

Tenant administrators can configure tenant identity management and access control settings
using the Directories Management options on the vRealize Automation application console.

You can manage the following settings from the Administration > Directories Management tab.

Table 2-3. Directories Management Settings

Setting Description

Directories The Directories page enables you to create and manage Active Directory links to support
vRealize Automation tenant user authentication and authorization. You create one or more
directories and then sync those directories with your Active Directory deployment. This
page displays the number of groups and users that are synced to the directory and the last
sync time. You can click Sync Now, to manually start the directory sync.

See Using Directories Management to Create an Active Directory Link.

When you click on a directory and then click the Sync Settings button, you can edit the
sync settings, navigate the Identity Providers page, and view the sync log.

From the directories sync settings page you can schedule the sync frequency, see the list
of domains associated with this directory, change the mapped attributes list, update the
user and groups list that syncs, and set the safeguard targets.

Connectors The Connectors page lists deployed connectors for your enterprise network. A connector
syncs user and group data between Active Directory and the Directories Management
service, and when it is used as the identity provider, authenticates users to the service.
Each vRealize Automation appliance contains a connector by default. See Managing
Connectors and Connector Clusters.

User Attributes The User Attributes page lists the default user attributes that sync in the directory and you
can add other attributes that you can map to Active Directory attributes. See Select
Attributes to Sync with Directory .

Network Ranges This page lists the network ranges that are configured for your system. You configure a
network range to allow users access through those IP addresses. You can add additional
network ranges and you can edit existing ranges. See Add or Edit a Network Range.
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Table 2-3. Directories Management Settings (continued)

Setting Description

Identity Providers The Identity Providers page lists identity providers that are available on your system.

VvRealize Automation systems contain a connector that serves as the default identity
provider and that suffices for many user needs. You can add third-party identity provider
instances or have a combination of both.

See Configure a Third Party Identity Provider Connection.

Policies The Policies page lists the default access policy and any other web application access

policies you created. Policies are a set of rules that specify criteria that must be met for
users to access their application portals or to launch Web applications that are enabled for
them. The default policy should be suitable for most vRealize Automation deployments, but
you can edit it if needed. See Manage the User Access Policy.

Important Concepts Related to Active Directory

Several concepts related to Active Directory are integral to understanding how Directories

Management integrates with your Active Directory environments.

Connector

The connector, a component of the service, performs the following functions.

Syncs user and group data between Active Directory and the service.
When being used as an identity provider, authenticates users to the service.

The connector is the default identity provider. For the authentication methods the connector
supports, see VMware Identity Manager Administration. You can also use third-party identity
providers that support the SAML 2.0 protocol. Use a third-party identity provider for an
authentication type the connector does not support or for an authentication type the
connector does support, if the third-party identity provider is preferable based on your
enterprise security policy.

Note Even if you use third-party identity providers, you must configure the connector to
sync user and group data.

Directory

The Directories Management service has its own concept of a directory, which uses Active
Directory attributes and parameters to define users and groups. You create one or more
directories and then sync those directories with your Active Directory deployment. You can
create the following directory types in the service.

Active Directory over LDAP. Create this directory type if you plan to connect to a single
Active Directory domain environment. For the Active Directory over LDAP directory type, the
connector binds to Active Directory using simple bind authentication.

Active Directory, Integrated Windows Authentication. Create this directory type if you plan to
connect to a multi-domain or multi-forest Active Directory environment. The connector binds
to Active Directory using Integrated Windows Authentication.
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The type and number of directories that you create varies depending on your Active Directory
environment, such as single domain or multi-domain, and on the type of trust used between
domains. In most environments, you create one directory.

The service does not have direct access to Active Directory. Only the connector has direct
access to Active Directory. Therefore, you associate each directory created in the service with a
connector instance.

Worker

When you associate a directory with a connector instance, the connector creates a partition for
the associated directory called a worker. A connector instance can have multiple workers
associated with it. Each worker acts as an identity provider. You define and configure
authentication methods per worker.

The connector syncs user and group data between Active Directory and the service through one
or more workers.

You cannot have two workers of the Integrated Windows Authentication type on the same
connector instance.

Active Directory Environments

You can integrate the service with an Active Directory environment that consists of a single
Active Directory domain, multiple domains in a single Active Directory forest, or multiple domains
across multiple Active Directory forests.

Single Active Directory Domain Environment

A single Active Directory deployment allows you to sync users and groups from a single Active
Directory domain.

See Configure an Active Directory over LDAP/IWA Link . For this environment, when you add a
directory to the service, select the Active Directory over LDAP option.

Multi-Domain, Single Forest Active Directory Environment

A multi-domain, single forest Active Directory deployment allows you to sync users and groups
from multiple Active Directory domains within a single forest.

You can configure the service for this Active Directory environment as a single Active Directory,
Integrated Windows Authentication directory type or, alternatively, as an Active Directory over
LDAP directory type configured with the global catalog option.

m  The recommended option is to create a single Active Directory, Integrated Windows
Authentication directory type.

See Configure an Active Directory over LDAP/IWA Link . When you add a directory for this
environment, select the Active Directory (Integrated Windows Authentication) option.

Multi-Forest Active Directory Environment with Trust Relationships

A multi-forest Active Directory deployment with trust relationships allows you to sync users and
groups from multiple Active Directory domains across forests where two-way trust exists
between the domains.
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See Configure an Active Directory over LDAP/IWA Link . When you add a directory for this
environment, select the Active Directory (Integrated Windows Authentication) option.

Multi-Forest Active Directory Environment Without Trust Relationships

A multi-forest Active Directory deployment without trust relationships allows you to sync users
and groups from multiple Active Directory domains across forests without a trust relationship
between the domains. In this environment, you create multiple directories in the service, one
directory for each forest.

See Configure an Active Directory over LDAP/IWA Link . The type of directories you create in the
service depends on the forest. For forests with multiple domains, select the Active Directory
(Integrated Windows Authentication) option. For a forest with a single domain, select the Active
Directory over LDAP option.

Using Directories Management to Create an Active Directory Link

After you create vRealize Automation tenants, you must log in to the system console as a tenant
administrator and create an Active Directory link to support user authentication.

There are three Active Directory communication protocol options when configuring an Active
Directory connection using Directories Management.

m  Active Directory over LDAP - An Active Directory over LDAP protocol supports DNS Service
Location lookup by default.

m  Active Directory (Integrated Windows Authentication) - With Active Directory (Integrated
Windows Authentication), you configure the domain to join. Active Directory over LDAP is
appropriate for single domain deployments. Use Active Directory (Integrated Windows
Authentication) for all multi-domain and multi-forest deployments.

m  OpenLDAP - You can use the open source version of LDAP to support Directories
Management user authentication.

After you select a communication protocol and configure an Active Directory link, you can
specify the domains to use with the Active Directory configuration and then select the users and
groups to sync with the specified configuration.

Configure an Active Directory over LDAP/IWA Link

You can configure an Active Directory over LDAP/IWA link to support user authentication using
the Directories Management feature to configure a link to Active Directory to support user
authentication for all tenants and select users and groups to sync with the Directories
Management directory.

For information and instructions about using OpenLDAP with Directories Management, see
Configure an OpenLDAP Directory Connection.

VMware, Inc. 92



Configuring vRealize Automation

For Active Directory (Integrated Windows Authentication), when you have multi-forest Active
Directory configured and the Domain Local group contains members from domains in different
forests, make sure that the Bind user is added to the Administrators group of the domain in
which the Domain Local group resides. If you fail to do this, these members will be missing from
the Domain Local group.

Prerequisites

Select the required default attributes and add additional attributes on the User Attributes
page. See Select Attributes to Sync with Directory .

List of the Active Directory groups and users to sync from Active Directory.

If your Active Directory requires access over SSL or STARTTLS, the Root CA certificate of the
Active Directory domain controller is required.

Log in to vRealize Automation as a tenant administrator.

Procedure

1 Select Administration > Directories Management > Directories.

2 Click Add Directory and select Add Active Directory over LDAP/IWA.

3 On the Add Directory page, specify the IP address for the Active Directory server in the
Directory Name text box.

4 Select the appropriate Active Directory communication protocol using the radio buttons

under the Directory Name text box.

Option Description

Windows Authentication Select Active Directory (Integrated Windows Authentication). For Active
Directory Integrated Windows Authentication, required information includes
the domain's Bind user UPN address and password.

LDAP Select Active Directory over LDAP. For Active Directory over LDAP,
information required includes the Base DN, Bind DN, and Bind DN password.
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5 Configure the connector that synchronizes users from the Active Directory to the VMware
Directories Management directory in the Directory Sync and Authentication section.

Option

Sync Connector

Authentication

Directory Search Attribute

VMware, Inc.

Description

Select the appropriate connector to use for your system. Each vRealize
Automation appliance contains a default connector. Consult your system
administrator if you need help in choosing the appropriate connector.

Click the appropriate radio button to indicate whether the selected
connector also performs authentication.

If you are using Active Directory (Integrated Windows Authentication), with
a third party identity provider to authenticate users, click No. After you
configure the Active Directory connection to sync users and groups use the
Identity Providers page to add the third-party identity provider for
authentication.

For information about using authentication adapters such as
PasswordlpddAdapter, SecurIDAdapter, and RadiusAuthAdapter, see the
VVMware Identity Manager Administration Guide.

Select the appropriate account attribute that contains the user name.
VMware recommends using the sAMAccount attribute rather than
userPrincipleName. If you use userPrincipleName for sync operations,
integration with second and third party software that requires a user name
may not function correctly.

Note If you select sSAMAccountName when using a global catalog, indicated
by selecting theThis Directory has a Global Catalog check box in the Server
Location area, users will be unable to log in.
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6 Enter the appropriate information in the Server Location text box if you selected Active
Directory over LDAP, or enter information in the Join Domain Details text boxes if you
selected Active Directory (Integrated Windows Authentication).

Option Description

Server Location - Displayed when ]
Active Directory over LDAP is
selected

If you want to use DNS Service Location to locate Active Directory
domains, leave the This Directory supports DNS Service Location check
box selected.

Note You cannot change the port assignment to 636 if you select this
option.

A domain_krb.properties file, auto-populated with a list of domain
controllers, is created along with the directory. See About Domain
Controller Selection.

If the Active Directory requires STARTTLS encryption, select the This

Directory requires all connections to use STARTTLS check box in the
Certificates section and copy and paste the Active Directory Root CA

certificate in the SSL Certificate field.

If the specified Active Directory does not use DNS Service Location
lookup, deselect the check box beside This Directory supports DNS
Service Location in the Server Location fields and enter the Active
Directory server host name and port number in the appropriate text
boxes.

Select the This Directory has a Global Catalog check box if the
associated Active Directory uses a global catalog. A global catalog
contains a representation of all objects in every domain in a multi-domain
Active Directory forest.

To configure the directory as a global catalog, see the Multi-Domain
Single Forest Active Directory Environment section in Active Directory
Environments .

If Active Directory requires access over SSL, select the This Directory
requires all connections to use SSL check box under the Certificates
heading and provide the Active Directory SSL certificate.

When you select this option, port 636 is used automatically and cannot
be changed.

Ensure that the certificate is in PEM format and includes the BEGIN
CERTIFICATE and END CERTIFICATE lines.

Join Domain Details - Displayed Enter the appropriate credentials in the Domain Name, Domain Admin User

when Active Directory (Integrated Name, and Domain Admin Password text boxes.

Windows Authentication) is selected | the Active Directory requires STARTTLS encryption, select the This
Directory requires all connections to use STARTTLS check box in the

Certificates section and copy and paste the Active Directory Root CA
certificate in the SSL Certificate field.

Ensure that the certificate is in PEM format and includes the BEGIN
CERTIFICATE and END CERTIFICATE lines.
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Option

Description

If the directory uses multiple domains, add the Root CA certificates for all
domains, one at a time.

Note |If the Active Directory requires STARTTLS and you do not provide the
certificate, you cannot create the directory.

7 In the Bind User Details section, enter the appropriate credentials to facilitate directory

synchronization.

For Active Directory over LDAP:

Option

Base DN

Bind DN

Description

Enter the search base distinguished name. For example,
cn=users,dc=corp,dc=1ocal.

Enter the bind distinguished name. For example,
cn=Ffritz infra,cn=users,dc=corp,dc=1local

For Active Directory (Integrated Windows Authentication):

Option

Bind User UPN

Bind DN Password

Description

Enter the User Principal Name of the user who can authenticate with the
domain. For example, UserName@example.com.

Enter the Bind User password.

8 Click Test Connection to test the connection to the configured directory.

This button does not appear if you selected Active Directory (Integrated Windows

Authentication).

9 Click Save & Next.

The Select the Domains page appears with the list of domains.

10 Review and update the domains listed for the Active Directory connection.

m  For Active Directory (Integrated Windows Authentication), select the domains that should
be associated with this Active Directory connection.

m  For Active Directory over LDAP, the available domain is listed with a checkmark.

Note If you add a trusting domain after the directory is created, the service does not
automatically detect the newly trusting domain. To enable the service to detect the
domain, the connector must leave and then rejoin the domain. When the connector
rejoins the domain, the trusting domain appears in the list.

11 Click Next.
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12

13

14

15

16

17
18

19

Verify that the Directories Management directory attribute names are mapped to the correct
Active Directory attributes.

If the directory attribute names are not mapped correctly, select the correct Active Directory
attribute from the drop-down menu.

Click Next.

Click ¥ to select the groups you want to sync from Active Directory to the directory.

When you add a group from Active Directory, if members of that group are not in the Users
list, they are added. When you sync a group, any users that lack Domain Users as their
primary group in Active Directory are not synced.

Note The Directories Management user authentication system imports data from Active
Directory when adding groups and users, and the speed of the system is limited by Active
Directory capabilities. As a result, import operations may require significant time depending
on the number of groups and users being added. To minimize the potential for delays or
problems, limit the number of groups and users to only those required for vRealize
Automation operation.

If your system performance degrades or if errors occur, close any unneeded applications and
ensure that your system has appropriate memory allocated to Active Directory. If problems
persist, increase the Active Directory memory allocation as needed. For systems with a large
number of users and groups, you may need to increase the Active Directory memory
allocation to as much as 24 GB.

Click Next.

Click ¥ to add additional users.
The appropriate values are as follows:
m  Single user: CN=username,CN=Users,0U=Users,DC=myCorp,DC=com

m  Multiple users: QU=Users,0U=myUnit,DC=myCorp,DC=com

To exclude users, click + to create a filter to exclude some types of users. You select the
user attribute to filter by, the query rule, and the value.

Click Next.

Review the page to see how many users and groups are syncing to the directory.

If you want to make changes to users and groups, click the Edit links.

Note Ensure that you specify user DNs that are under the Base DN specified previously. If

the user DN is outside of the Base DN, users from that DN are synced but will be unable to
log in.

Click Push to Workspace to start the synchronization to the directory.
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Results

The connection to the Active Directory is complete and the selected users and groups are added
to the directory. You can now assign user and groups to the appropriate vRealize Automation
roles by selecting Administration > Users and Groups > Directory Users and Groups. See Assign
Roles to Directory Users or Groups for more information.

What to do next

If your vRealize Automation environment is configured for high availability, you must specifically
configure Directories Management for high availability. See Configure Directories Management
for High Availability.

m  Set up authentication methods. After users and groups sync to the directory, if the connector
is also used for authentication, you can set up additional authentication methods on the
connector. If a third party is the authentication identity provider, configure that identity
provider in the connector.

m  Review the default access policy. The default access policy is configured to allow all
appliances in all network ranges to access the Web browser, with a session time out set to
eight hours or to access a client app with a session time out of 2160 hours (90 days). You can
change the default access policy and when you add Web applications to the catalog, you can
create new ones.

m  Apply custom branding to the administration console, user portal pages and the sign-in

screen.

Configure an OpenLDAP Directory Connection

You can configure an OpenLDAP Directory connection with Directories Management.

Though there are several different LDAP protocols, OpenLDAP is the only protocol that is tested
and approved for use with vRealize Automation Directories Management.

To integrate your LDAP directory, you create a corresponding Directories Management directory
and sync users and groups from your LDAP directory to the Directories Management directory.
You can set up a regular sync schedule for subsequent updates.

You also select the LDAP attributes that you want to sync for users and map them to Directories
Management attributes.

Your LDAP directory configuration may be based on default schemas or you may have created
custom schemas. You may also have defined custom attributes. For Directories Management to
be able to query your LDAP directory to obtain user or group objects, you need to provide the
LDAP search filters and attribute names that are applicable to your LDAP directory.

Specifically, you need to provide the following information.

m  LDAP search filters for obtaining groups, users, and the bind user
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m  LDAP attribute names for group membership, UUID, and distinguished name

Note Directories Management uses the default page size of 1500 for LDAP queries. If you
configure an OpenLDAP directory connection, then you must enable the simple page results
control extension for OpenLDAP to limit the number of results displayed. Failure to use this
extension may cause user and group sync errors.

Prerequisites

= Review the configuration on the User Attributes page and add any other attributes that you
want to sync. You will map the Directories Management attributes to your LDAP directory
attributes when you create the directory. These attributes will be synced for the users in the
directory.

Note When you make changes to user attributes, consider the effect on other directories in
the service. If you plan to add both Active Directory and LDAP directories, ensure that you
do not mark any attributes as required except for userName. The settings on the User
Attributes page apply to all directories in the service. If an attribute is marked required, users
without that attribute are not synced to the Directories Management service.

m A Bind DN user account. Using a Bind DN user account with a non-expiring password is
recommended.

= In your LDAP directory, the UUID of users and groups must be in plain text format.
m In your LDAP directory, a domain attribute must exist for all users and groups.

You map this attribute to the Directories Management domain attribute when you create the
Directories Management directory.

m  User names must not contain spaces. If a user name contains a space, the user is synced but
entitlements are not available to the user.

m If you use certificate authentication, users must have values for userPrincipalName and email
address attributes.

Procedure
1 Select Administration > Directories Management > Directories.

2 Click Add Directory and select Add LDAP Directory.
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3 Enter the required information in the Add LDAP Directory page.

Option Description
Directory Name Enter a name for the Directories Management directory.
Directory Sync and Authentication a In the Sync Connector field, select the connector you want to use to

sync users and groups from your LDAP directory to the Directories
Management directory.

A connector component is always available with the Directories
Management service by default. This connector appears in the drop-
down list. If you install multiple Directories Management appliances for
high availability, the connector component of each appears in the list.

You do not need a separate connector for an LDAP directory. A
connector can support multiple directories, regardless of whether they
are Active Directory or LDAP directories.

b In the Authentication field, if you want to use this LDAP directory to
authenticate users, select Yes.

If you want to use a third-party identity provider to authenticate users,
select No. After you add the directory connection to sync users and
groups, go to the Administration > Directories Management > Identity
Providers page to add the third-party identity provider for
authentication.

c For most configurations, leave the Custom default selected in the
Directory Search Attribute text box. In the Custom Directory Search
Attribute field, specify the LDAP directory attribute to be used for user
and group names. This attribute uniquely identifies entities, such as users
and groups, from the LDAP server. For example, cn.

Server Location Enter the LDAP Directory server host and port number. For the server host,
you can specify either the fully-qualified domain name or the IP address. For
example, myLDAPserver.example.com or 100.00.00.0.

If you have a cluster of servers behind a load balancer, enter the load
balancer information instead.
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Option

LDAP Configuration

Certificates

Bind User Details

Description

Specify the LDAP search filters and attributes that Directories Management
can use to query your LDAP directory. Default values are provided based on
the core LDAP schema.

Filter Queries

m  Groups: The search filter for obtaining group objects.

For example: (objectClass=group)

m  Bind user: The search filter for obtaining the bind user object, that is, the
user that can bind to the directory.

For example: (objectClass=person)

m  Users: The search filter for obtaining users to sync.

For example: (&(objectClass=user) (objectCategory=person))
Attributes

m  Membership: The attribute that is used in your LDAP directory to define
the members of a group.

For example: member

m  Object UUID: The attribute that is used in your LDAP directory to define
the UUID of a user or group.

For example: entryUUID

m Distinguished Name: The attribute that is used in your LDAP directory
for the distinguished name of a user or group.

For example: entryDN

If your LDAP directory requires access over SSL, select the This Directory
requires all connections to use SSL check box. Then copy and paste the
LDAP directory server's root CA SSL certificate into the SSL Certificate text
box. Ensure the certificate is in PEM format and include the "BEGIN
CERTIFICATE" and "END CERTIFICATE" lines.

Finally, ensure that the correct port number is specified in the Server Port
field in the Server Location section of the page.

Base DN: Enter the DN from which to start searches. For example,
cn=users,dc=example,dc=com

All applicable users must reside under the Base DN. If a particular user is not
located under the Base DN, that user will be unable to log in even if he is a
member of a group that is under the Base DN.

Bind DN: Enter the DN to use to bind to the LDAP directory. You can also
enter user names, but a DN is more appropriate for most deployments.

Note Using a Bind DN user account with a non-expiring password is
recommended.

Bind DN Password: Enter the password for the Bind DN user.

4 To test the connection to the LDAP directory server, click Test Connection.

If the connection is not successful, check the information you entered and make the

appropriate changes.

5 Click Save & Next.
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6 Verify the correct domain is selected on the Select the Domains page, and then click Next.

7 In the Map Attributes page, verify that the Directories Management attributes are mapped to
the correct LDAP attributes.

These attributes will be synced for users.
Important You must specify a mapping for the domain attribute.

You can add attributes to the list from the User Attributes page.
8 Click Next.

9 Click + to select the groups you want to sync from the LDAP directory to the Directories
Management directory on Select the groups (users) you want to sync page.

If you have multiple groups with the same name in your LDAP directory, you must specify
unique names for them in the groups page.

When you add a group from Active Directory, if members of that group are not in the Users
list, they are added. When you sync a group, any users that lack Domain Users as their
primary group in Active Directory are not synced.

The Sync nested group members option is enabled by default. When this option is enabled,
all the users that belong directly to the group you select as well as all the users that belong to
nested groups under it are synced. Note that the nested groups are not synced; only the
users that belong to the nested groups are synced. In the Directories Management directory,
these users will appear as members of the top-level group that you selected for sync. In
effect, the hierarchy under a selected group is flattened and users from all levels appear in
Directories Management as members of the selected group.

If this option is deactivated, when you specify a group to sync, all the users that belong
directly to that group are synced. Users that belong to nested groups under it are not
synced. Disabling this option is useful for large directory configurations where traversing a
group tree is resource and time intensive. If you deactivate this option, ensure that you select
all the groups whose users you want to sync.

Note The Directories Management user authentication system imports data from Active
Directory when adding groups and users, and the speed of the system is limited by Active
Directory capabilities. As a result, import operations may require a significant amount of time
depending on the number of groups and users being added. To minimize the potential for
delays or problems, limit the number of groups and users to only those required for vRealize
Automation operation.

If your system performance degrades or if errors occur, close any unneeded applications and
ensure that your system has appropriate memory allocated to Directories Management. If
problems persist, increase the Directories Management memory allocation as needed. For
systems with large numbers of users and groups, you may need to increase the Directories
Management memory allocation to as much as 24 GB.

10 Click Next.

VMware, Inc. 102



Configuring vRealize Automation

11 Click + to add additional users. For example, enter
CN=username,CN=Users,0U=myUnit,DC=myCorp,DC=com.

You can add organizational units as well as individual users here.

You can create a filter to exclude some types of users. Select the user attribute to filter by,
the query rule, and the value.

12 Click Next.

13 Review the page to see how many users and groups will sync to the directory and to view
the default sync schedule.

To make changes to users and groups, or to the sync frequency, click the Edit links.

14 Click Sync Directory to start the directory sync.

Results

The connection to the LDAP directory is established and users and groups are synced from the
LDAP directory to the Directories Management directory.

You can now assign user and groups to the appropriate vRealize Automation roles by selecting
Administration > Users and Groups > Directory Users and Groups. See Assign Roles to Directory

Users or Groups for more information.
Limitations of LDAP Directory Integration
There are several important limitations related to LDAP Directory integration in Directories

Management.
m  You can only integrate a single-domain LDAP directory environment.

To integrate multiple domains from an LDAP directory, you need to create additional
Directories Management directories, one for each domain.

= The following authentication methods are not supported for Directories Management
directories of type LDAP directory.

m  Kerberos authentication

m  RSA Adaptive Authentication

m  ADFS as a third-party identity provider

m  SecurlD

m  Radius authentication with Vasco and SMS Passcode server
m  You cannot join an LDAP domain.

= Integration with View or Citrix-published resources is not supported for Directories
Management directories of type LDAP directory.

m  User names must not contain spaces. If a user name contains a space, the user is synced but
entitlements are not available to the user.
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m [|f you plan to add both Active Directory and LDAP directories, ensure that you do not mark
any attributes required in the User Attributes page, except for userName, which can be
marked required. The settings in the User Attributes page apply to all directories in the
service. If an attribute is marked required, users without that attribute are not synced to the
Directories Management service.

m If you have multiple groups with the same name in your LDAP directory, you must specify
unique names for them in the Directories Management service. You can specify the names
when you select the groups to sync.

m  The option to allow users to reset expired passwords is not available.

m  The domain_krb.properties file is not supported.

Configure Directories Management for High Availability

You can use Directories Management to configure a high availability Active Directory connection
in vRealize Automation.

Each vRealize Automation appliance includes a connector that supports user authentication,
although only one connector is typically configured to perform directory synchronization. It does
not matter which connector you choose as the sync connector. To support Directories
Management high availability, you must manually configure a second connector that corresponds
to your second vRealize Automation appliance, which connects to your Identity Provider and
points to the same Active Directory. With this configuration, if one appliance fails, the other takes
over management of user authentication.

In a high availability environment, all nodes must serve the same set of Active Directories, users,
authentication methods, etc. The most direct method to accomplish this is to promote the
Identity Provider to the cluster by setting the load balancer host as the Identity Provider host.
With this configuration, all authentication requests are directed to the load balancer, which
forwards the request to either connector as appropriate.

A connector is also used for user synchronization. But only one connector is configured to
perform directory synchronization. Synced users are saved to appliance database, which is
readable by all clustered nodes. If the connector that is responsible for directory synchronization
fails, directory synchronization will stop working. To recover, the tenant admin needs to manually
prompt another connector to perform directory synchronization using the vRealize Automation
Ul. See Enable Directory Sync on a Secondary Connector.

For more information about working with connectors, see Managing Connectors and Connector
Clusters.

Prerequisites

m  Configure your vRealize Automation deployment with at least two instance of the vRealize
Automation appliance.

m Install vRealize Automation in Enterprise mode operating in a single domain with two
instances of thevRealize Automation appliance.
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m Install and configure an appropriate load balancer to work with your vRealize Automation
deployment.

m  Configure tenants and Directories Management using one of the connectors supplied with the
installed instances of the vRealize Automation appliance. For information about tenant
configuration, see Configuring Tenant Settings.

Procedure

1 Loginto the load balancer for your vRealize Automation deployment as a tenant
administrator.

The load balancer URL is <load balancer address>/vcac/org/tenant_name.
2 Select Administration > Directories Management > Identity Providers.
3 Click the Identity Provider that is currently in use for your system.

The existing directory and connector that provide basic identity management for your
system appears.

4 On the Identity Provider properties page, click the Add a Connector drop-down list, and
select the connector that corresponds to your secondary vRealize Automation appliance.

5 Enter the appropriate password in the Bind DN Password text box that appears when you
select the connector.

6 Click Add Connector.

7 The main connector appears in the IdP Hostnametext box by default. Change the host name
to point to the load balancer.

Enable Directory Sync on a Secondary Connector
If your primary connector fails, authentication is handled automatically by another connector

instance. In the case of a failure, for directory sync, you must modify the directory settings in
Directories Management to use the appropriate secondary connector instance. You can enable
directory sync only on one connector at a time.

Procedure
1 Select Administration > Directories Management > Directories

2 Select the directory that was associated with the original connector instance.

Note You can view this information on the Directories > Connectors page.

3 In the Directory Sync and Authentication section of the Directory page, select another
connector instance in the Sync Connector drop-down list.

4 In the Bind User Details section, enter your Active Directory bind account password in the
Bind DN Password text box.

5 Click Save.
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Configure a Bi Directional Trust Relationship Between vRealize Automation and Active Directory

You can enhance system security of a basic vRealize Automation Active Directory connection by
configuring a bi directional trust relationship between your identity provider and Active Directory
Federated Services.

To configure a bi-directional trust relationship between vRealize Automation and Active
Directory, you must create a custom identity provider and add Active Directory metadata to this
provider. Also, you must modify the default policy used by your vRealize Automation
deployment. Finally, you must configure Active Directory to recognize your identity provider.

Prerequisites

Verify that you have configured tenants for your vRealize Automation deployment set up an
appropriate Active Directory link to support basic Active Directory user ID and password
authentication.

Active Directory is installed and configured for use on your network.
Obtain the appropriate Active Directory Federated Services (ADFS) metadata.

Log in to vRealize Automation as a tenant administrator.

Procedure

1

Obtain the Federation Metadata file.

You can download this file from https://servername.domain/FederationMetadata/2007-06/
FederationMetadata.xml

Search for the word logout, and edit the location of each instance to point to https://
servername.domain/adfs/Is/logout.aspx

For example, the following:

SinglelLogoutService
Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
Location="https://servername.domain/adfs/1s/ " />

Should be changed to:

SinglelLogoutService
Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
Location="https://servername.domain/adfs/1s/logout.aspx" />
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3 Create a new ldentity Provider for you deployment.

a

b

C

d

Select Administration > Directories Management > Identity Providers.

Click Add Identity Provider and complete the fields as appropriate.

Option Description
Identity Provider Name Enter a name for the new identity provider

Identity Provider Metadata (URl or  Paste the contents of your Active Directory Federated Services metadata
XML) file here.

Name ID Policy in SAML Request If appropriate, enter a name for the identity policy SAML request.

(Optional)

Users Select the domains to which you want users to have access privileges.

Process IDP Metadata Click to process the metadata file that you added.

Network Select the network ranges to which you want users to have access.

Authentication Methods Enter a name for the authentication method used by this identity
provider.

SAML Context Select the appropriate context for your system.

SAML Signing Certificate Click the link beside the SAML Metadata heading to download the

Directories Management metadata.

Save the Directories Management metadata file as sp.xml.

Click Add.

4 Add arule to the default policy.

a

b

Select Administration > Directories Management > Policies.
Click the default policy name.
Click the + icon under the Policy Rules heading to add a new rule.

Use the fields on the Add a Policy Rule page to create a rule that specifies the
appropriate primary and secondary authentication methods to use for a specific network
range and device.

For example, if your network range is My Machine, and you need to access content from
All Device Types then, for a typical deployment, you must authenticate by using the
following method: ADFS Username and Password.

Click Save to save your policy updates.

On the Default Policy page, drag the new rule to the top of the table so that it takes
precedence over existing rules.
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5 Using the Active Directory Federated Services management console, or another appropriate
tool, set up a relying party trust relationship with the vRealize Automation identity provider.

To set up this trust, you must import the Directories Management metadata that you
previously downloaded. See the Microsoft Active Directory documentation for more
information about configuring Active Directory Federated Services for bi-directional trust
relationships. As part of this process, you must do the following:

m  Set up a Relying Party Trust. When you set up this trust, you must import the VMware
Identity Provider service provider metadata XML file that you copied and saved

m Create a claim rule that transforms the attributes retrieved from LDAP in the Get
Attributes rule into the desired SAML format. After you create the rule, edit the rule by
adding the following text:

c:[Type == "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress"]

=> issue(Type = "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/nameidentifier",
Issuer = c.Issuer, OriginalIssuer = c.OriginalIssuer, Value = c.Value, ValueType =
c.ValueType, Properties["http://schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/
format"] = "urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress", Properties["http://
schemas.xmlsoap.org/ws/2005/05/identity/claimproperties/spnamequalifier"”] =
"vmwareidentity.domain.com™);

Configure SAML Federation Between Directories Management and SSO2

You can establish SAML federation between vRealize Automation Directories Management and
systems that use SSO2 to support single sign on.

Establish federation between Directories Management and SSO2 by creating a SAML connection

between the two parties. Currently, the only supported end-to-end flow is where SSO2 acts as
the Identity Provider (IdP) and Directories Management acts as the service provider (SP).

For SSO2 user authentication, the same account must exist in both Directories Management and

SSO2. Minimally, the UserPrincipalName (UPN) of the user has to match on both ends. Other
attributes can differ as they are required to identify the SAML subject.

For local users in SSO2, such as admin@vsphere.local, corresponding accounts must also exist
Directories Management, where at least the UPN of the user matches. Create these accounts
manually or with a script using the Directories Management local user creation APIs.

Setting up SAML between SSO2 and Directories Management involves configuration on the
Directories Management and SSO components.
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Table 2-4. SAML Federation Component Configuration

Component Configuration

Directories Management Configure SSO2 as a third-party Identity Provider on Directories Management and
update the default authentication policy. You can create an automated script to set
up Directories Management.

SSO2 component Configure Directories Management as a service provider by importing the Directories
Management sp.xml file. This file enables you to configure SSO2 to use Directories
Management as the Service Provider (SP).

Prerequisites
m  Configure tenants for your vRealize Automation deployment. See Create Additional Tenants.

m  Set up an appropriate Active Directory link to support basic Active Directory user ID and
password authentication.

m  Login to vRealize Automation as a tenant administrator.

Procedure
1 Download SSO2 Identity Provider metadata through the SSO2 user interface.
a Loginto vCenter as an administrator at https://<cloudvm-hostname>/ .
b Click the Log in to vSphere Web Client link.
c On the left navigation pane, select Administration > Single Sign On > Configuration.
d Click Download adjacent to the Metadata for your SAML service provider heading.
The vsphere.local.xml file should begin downloading.
e Copy the contents of the vsphere.local.xml file.

2 On the vRealize Automation Directories Management Identity Providers page, create a new
Identity Provider.

a Login to vRealize Automation as a tenant administrator.

b Select Administration > Directories Management > Identity Providers.
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d

e

Click Add Identity Provider and provide the configuration information.

Option Action
Identity Provider Name Enter a name for the new Identity Provider.

Identity Provider Metadata (URl or  Paste the contents of your SSO2 idp.xml metadata file in the text box

XML) text box and click Process IDP Metadata.

Name ID Policy in SAML Request Enter http://schemas.xmlsoap.org/claims/UPN.

(Optional)

Users Select the domains to which you want users to have access privileges.

Network Select the network ranges from which you want users to have access
privileges.

If you want to authenticate users from an IP addresses, select All Ranges.

Authentication Methods Enter a name for the authentication method. Then, use the SAML Context
drop down menu to the right to map the authentication method to

urn:oasis:names:tc:SAML:2.0:ac:classes:Password.

SAML Signing Certificate Click the link beside the SAML Metadata heading to download the
Directories Management metadata.

Save the Directories Management metadata file as sp.xml.

Click Add.

3 Update the relevant authentication policy using the Directories Management Policies page to
redirect authentication to the third party SSO2 identity provider.

a

b

e

Select Administration > Directories Management > Policies.
Click the default policy name.

Click the authentication method under the Policy Rules heading to edit the existing
authentication rule.

On the Edit a Policy Rule page, change the authentication method from password to the
appropriate method.

In this case, the method should be SSO2.

Click Save to save your policy updates.

4 On the left navigation pane, select Administration > Single Sign On > Configuration, and click
Update to upload the sp.xml file to vSphere.

Add Users or Groups to an Active Directory Connection

You can add users or groups to an existing Active Directory connection.

The Directories Management user authentication system imports data from Active Directory
when adding groups and users. The speed of the data transport is limited by Active Directory
capabilities. As a result, actions can take a long time depending on the number of groups and
users that are added. To minimize problems, limit the groups and users to only the groups and
users required for a vRealize Automation action. If problems occur, close unneeded applications
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and verify that your deployment has appropriate memory allocated to Active Directory. If
problems continue, increase the Active Directory memory allocation. For deployments with large
numbers of users and groups, you might need to increase the Active Directory memory
allocation to as much as 24 GB.

When you sync a vRealize Automation deployment with a many users and groups, there might
be a delay before the Log details are available. The time stamp on the log file can differ from the
completed time displayed on the console.

If members of a group are not in the Users list, when you add the group from Active Directory,
the members are added to the list. When you sync a group, any users that do not have Domain
Users as their primary group in Active Directory are not synced.

Note You cannot cancel a synchronize action after you start the action.

Prerequisites

m  Connector installed and the activation code activated. Select the required default attributes
and add additional attributes on the User Attributes page.

See Select Attributes to Sync with Directory in Configuring vRealize Automation.
m List of the Active Directory groups and users to sync from Active Directory.

m  For Active Directory over LDAP, information required includes the Base DN, Bind DN, and
Bind DN password.

m  For Active Directory Integrated Windows Authentication, the information required includes
the domain's Bind user UPN address and password.

m |f Active Directory is accessed over SSL, a copy of the SSL certificate is required.

m If you have a multi-forest Active Directory integrated with Windows Authentication and the
Domain Local group contains members from different forests, do the following. Add the Bind
user to the Administrators group of the Domain Local group. If the Bind user is not added,
these members are missing from the Domain Local group.

m  Login to vRealize Automation as a tenant administrator.

Procedure

)

Select Administration > Directories Management > Directories.
Click the desired directory name.

Click Sync Settings to open a dialog box with synchronization options.

H W N

Click the appropriate icon depending on whether you want to change the user or group
configuration.

To edit the group configuration:

m  To add groups, click the + icon to add a line for group DN definitions and enter the
appropriate group DN.

VMware, Inc. m



Configuring vRealize Automation

= |f you want to delete a group DN definition, click the x icon for the desired group DN.
To edit the user configuration:

¢ To add users, click the + icon to add a line for a user DN definition and enter the
appropriate user DN.

If you want to delete a user DN definition, click the x icon for the desired user DN.

5 Click Save to save your changes without synchronizing your updates immediately. Click Save
& Sync to save your changes and synchronize your updates immediately.

Select Attributes to Sync with Directory

When you set up the Directories Management directory to sync with Active Directory, you
specify the user attributes that sync to the directory. Before you set up the directory, you can
specify on the User Attributes page which default attributes are required and, if you want, add
additional attributes that you want to map to Active Directory attributes.

When you configure the User Attributes page before the directory is created, you can change
default attributes from required to not required, mark attributes as required, and add custom
attributes.

For a list of the default mapped attributes, see Managing User Attributes that Sync from Active
Directory.

After the directory is created, you can change a required attribute to not be required, and you
can delete custom attributes. You cannot change an attribute to be a required attribute.

When you add other attributes to sync to the directory, after the directory is created, go to the
directory's Mapped Attributes page to map these attributes to Active Directory Attributes.

Procedure

1 Login to vRealize Automation as a system or tenant administrator.
2 Click the Administration tab.

3 Select Directories Management > User Attributes

4

In the Default Attributes section, review the required attribute list and make appropriate
changes to reflect what attributes should be required.

Ul

In the Attributes section, add the Directories Management directory attribute name to the list.
6 Click Save.

The default attribute status is updated and attributes you added are added on the directory's
Mapped Attributes list.

7 After the directory is created, go to the ldentity Stores page and select the directory.
8 Click Sync Settings > Mapped Attributes.

9 In the drop-down menu for the attributes that you added, select the Active Directory
attribute to map to.
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10 Click Save.

Results

The directory is updated the next time the directory syncs to the Active Directory.

Add Memory to Directories Management

You may need to allocate additional memory to Directories Management if you have Active
Directory connections that contain a large number of users or groups.

By default, 4 GB of memory is allocated to the Directories Management service. This is sufficient
for many small to medium sized deployments. If you have an Active Directory connection that
uses a large number of users or groups, you may need to increase this memory allocation.
Increased memory allocation is appropriate for systems with more than 100,000 users, each in
30 groups and 750 groups overall. For these system, VMware recommends increasing the
Directories Management memory allocation to 6 GB.

Directories Management memory is calculated based on the total memory allocated to the
vRealize Automation appliance The following table shows memory allocations for relevant
components.

Table 2-5. vRealize Automation Appliance Memory Allocation

Virtual Appliance memory VRA service memory vIDM service memory
18 GB 3.3GB 4GB

24 GB 49 GB 6 GB

30GB 7.4 GB 9.1GB

Note These allocations assume that all default services are enabled and running on the virtual
appliance. They may change if some services are stopped.
Prerequisites

m  An appropriate Active Directory connection is configured and functioning on your vRealize
Automation deployment.

Procedure
1 Stop each machine on which a vRealize Automation appliance is running.
2 Increase the virtual appliance memory allocation on each machine.

If you are using the default memory allocation of 18 GB, VMware recommends increasing the
memory allocation to 24 GB.

3 Restart the vRealize Automation appliance machines.

Create a Domain Host Lookup File to Override DNS Service Location (SRV) Lookup

When you enable Integrated Windows Authentication, the Directory configuration is changed to
enable the DNS Service Location field. The connector service location lookup is not site aware. If
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you want to override the random DC selection, you can create a file called
domain_krb.properties and add the domain to host values that take precedence over SRV
lookup.

Procedure
1 From the appliance-va command line, log in as the user with root privileges.

2 Change directories to /usr/local/horizon/conf and create a file called
domain_krb.properties.

3 Edit the domain_krb.properties file to add the list of the domain to host values. Add the
information as <AD Domain>=<host:port>, <host2:port2>, <host2:port2>.

For example, enter the list as example.com=examplehost.com:636, examplehost2.example.com:389

4 Change the owner of the domain_krb.properties file to horizon and group to www. Enter
chown horizon:www /usr/local/horizon/conf/domain_krb.properties.

5 Restart the service. Enter service horizon-workspace restart.

Configure Just-in-Time User Provisioning

You can configure Just-in-Time (JIT) provisioning to support adding users without syncing from
your Active Directory.

To support Just-in-Time provisioning, you must add a third party identity provider and then
configure a connection to it within your vRealize Automation deployment to integrate Directories
Management with other SSO providers via a SAML protocol. In addition, you must create a new
directory with the appropriate name, such as JIT Directory.

When you enable Just-in-Time provisioning, you can add Just-in-Time users to a designated
custom group. To support this functionality, create a custom group with the appropriate
members. See Add Just-in-Time Users with Custom Groups and Rules.

Note As a best practice, do not configure Just-in-Time provisioning on the default vsphere.local
tenant.

Prerequisites

Configure an appropriate third party identity provider for use with JIT provisioning.
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Procedure

1 Create an identity provider for Just-in-Time provisioning.

a

b

Select Administration > Directories management > Identity Providers

Click Add Identity Provider and edit the identity provider instance settings as
appropriate.

m  Forjustin time provisioning, create a third party identity provider.

m In the Create Just-in-Time Directory section, enter names for the directory and one or
more domains.

= You must select a network for the third party identity provider configuration.

m If you are using an external VMware ldentity Manager as your third party identity
provider, and you are using userPrincipleName to authenticate users, you must change
the Name ID mapping configuration for userPrincipleName from the default of
x509SubjectName tO unspecified.

See Configure a Third Party ldentity Provider Connection for more information about
creating identity providers.

2 Configure SAML on the Just-in-Time identity provider.

j

Copy |dP metadata from your identity provider.

In vRealize Automation, select your identity provider and paste the IdP metadata into the
Identity Provider Metadata (URL or XML) text box.

Click Save.

In the Name ID policy in SAML Request (Optional) drop-down menu, select the
appropriate format.

For example, if you are using the emal address as the unique user identifier, you would

select urn:oasis:names:tc:SAML:1.1:nameid-format:emailAddress.

Select the appropriate directory under the Users heading.

Select the networks for use by this identity provider under the Network heading.
Specify an appropriate name in the Authentication Methods text box.

In the SAML Context drop down, select

urn:oasis:names:tc:SAML:2.0:ac:classes:PasswordProtectedTransport

Right-click the Service Provider (SP) Metadata link, and open it in a separate browser
tab.

Use this metadata to configure the SAML connection on your identity provider.

If you are using VMware ldentity Manager see the VMware Identity Manager documentation
for complete instructions on configuring SAML.
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3 Click Add.
The new directory is created using the Directory Name provided.
4 Configure the vRealize Automation Access Policy.
a Select Administration > Policies.
b Click the green + icon at the top right of the policy rules table.
c Set the policy rule to apply to applicable ranges and device types.
d Select the authentication method that you created when configuring the third party
identity provider for JIT provisioning for the authentication method.
Managing User Attributes that Sync from Active Directory

The Directories Management User Attributes page lists the user attributes that sync to your
Active Directory connection.

Changes that you make and save in the User Attributes page are added to the Mapped

Attributes page in the Directories Management directory. The attributes changes are updated to

the directory with the next sync to Active Directory.

The User Attributes page lists the default directory attributes that you can map to Active
Directory attributes. You select the attributes that are required, and you can add other Active
Directory attributes to sync to the directory.

Table 2-6. Default Active Directory Attributes to Sync to Directory

Directory Attribute Name Default Mapping to Active Directory Attribute

userPrincipalName userPrincipalName

distinguishedName distinguishedName

employeeld employeelD

domain canonicalName. Adds the fully qualified domain name of the
object.

disabled (external user disabled) userAccountControl. Flagged with UF_Account_Disable.

When an account is disabled, users cannot log in to access
their applications and resources. The resources that users
were entitled to are not removed from the account so that
when the flag is removed from the account users can log in
and access their entitled resources.

phone telephoneNumber
lastName sn

firstName givenName

email mail

userName sAMAccountName
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The User Attributes page lists the default directory attributes that you can map to Active
Directory attributes. You select the attributes that are required, and you can add other Active

Directory attributes to sync to the directory.

Table 2-7. Default Active Directory Attributes to Sync to Directory

Directory Attribute Name
userPrincipalName
distinguishedName
employeeld

domain

disabled (external user disabled)

phone
lastName
firstName
email

userName

Default Mapping to Active Directory Attribute
userPrincipalName

distinguishedName

employeelD

canonicalName. Adds the fully qualified domain name of the
object.

userAccountControl. Flagged with UF_Account_Disable.

When an account is disabled, users cannot log in to access
their applications and resources. The resources that users
were entitled to are not removed from the account so that
when the flag is removed from the account users can log in
and access their entitled resources.

telephoneNumber
sn

givenName

mail

sAMAccountName

Managing Connectors and Connector Clusters

The Connectors page lists deployed connectors for your enterprise network. A connector syncs
user and group data between Active Directory and the Directories Management service, and
when it is used as the identity provider, authenticates users to the service.

In vRealize Automation, each vRealize Automation appliance contains its own connector, and
these connectors are suitable for most deployments.

When you associate a directory with a connector instance, the connector creates a partition for
the associated directory called a worker. A connector instance can have multiple associated
workers. Each worker acts as an identity provider. The connector syncs user and group data
between Active Directory and the service through one or more workers. You define and
configure authentication methods on a per worker basis.

You can manage various aspects of an Active Directory link from the Connectors page. This page
contains a table and several buttons that enable you to complete various management tasks.

m In the Worker column, select a worker to view the connector details and navigate to the Auth
Adapters page to see the status of the available authentication methods. For information
about authentication, see Integrating Alternative User Authentication Products with

Directories Management.
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= In the Identity Provider column, select the IdP to view, edit or deactivate. See Configure a
Third Party Identity Provider Connection.

= In the Associated Directory column, access the directory associated with this worker.

m Click Join Domain to join the connector to a specific Active Directory domain. For example
when you configure Kerberos authentication, you must join the Active Directory domain
either containing users or having trust relationship with the domains containing users.

m  When you configure a directory with an Integrated Windows Authentication Active Directory,
the connector joins the domain according to the configuration details.

Connectors in a Clustered Environment

In a distributed, vRealize Automation deployment, all available connectors perform any required
user authorization, while a single designated connector handles all configuration synchronization.
Typically, synchronization would include additions, deletions, or changes to the user
configuration, and synchronization occurs automatically as long as all connectors are available.
There are some specific situations in which automatic synchronization may not occur.

For changes related to directory configuration, such as base dn, vRealize Automation attempts to
automatically push updates to all connectors in a cluster. If a connector is inoperable or
unreachable for some reason, that connector will not receive the update, even when it resumes
online operation. To implement configuration changes to connectors that may not have received
them automatically, system administrators must manually save the changes to all applicable
connectors.

For directory sync profile related changes, vRealize Automation attempts to automatically push
updates to all connectors as well. If the sync connector is operational, the update is saved and
pushed to all available authorization connectors. If one or more connectors is unreachable, the
system admin receives a warning indicating that not all connectors were updated. If the sync
connector is inoperable, the update fails and an error occurs. If the system admin changes the
connector designated as the sync connector, the new sync connector receives the latest
available profile information, and this information is pushed to all applicable, and available,
connectors.

Join a Connector Machine to a Domain

In some cases, you may need to join a machine containing a Directories Management connector
to a domain.

For Active Directory over LDAP directories, you can join a domain after creating the directory.
For Active Directory (Integrated Windows Authentication) directories, the connector is joined to
the domain automatically when you create the directory. In both cases, you must supply the
appropriate credentials.

To join a domain, you need Active Directory credentials that have the privilege to "join computer
to AD domain". This is configured in Active Directory with the following rights:

m Create Computer Objects

VMware, Inc. 18



Configuring vRealize Automation

m  Delete Computer Objects
When you join a domain, a computer object is created in the default location in Active Directory.

If you do not have the rights to join a domain, or if your company policy requires a custom
location for the computer object, you must ask your administrator to create the object and then
join the connector machine to the domain.

Procedure

1 Ask your Active Directory administrator to create the computer object in Active Directory in a
location determined by your company policy. You must provide the host name of the
connector. Ensure that you provide the fully-qualified domain name, for example
server.example.com.

You can find the host name in the Host Name column on the Connectors page in the
administrative console. Select Administration > Directories Management > Connectors.

2 After the computer object is created, click Join Domain on the Connectors page to join the
domain using any domain user account available in Directories Management.

About Domain Controller Selection

The domain_krb.properties file determines which domain controllers are used for directories
that have DNS Service Location (SRV records) lookup enabled. It contains a list of domain
controllers for each domain. The connector creates the file initially, and you must maintain it
subsequently. The file overrides DNS Service Location (SRV) lookup.

The following types of directories have DNS Service Location lookup enabled.

m  Active Directory over LDAP with the This Directory supports DNS Service Location option
selected

m Active Directory (Integrated Windows Authentication), which always has DNS Service
Location lookup enabled

When you first create a directory that has DNS Service Location lookup enabled, a
domain_krb.properties file is created automatically in the /usr/local/horizon/conf directory
of the virtual machine and is auto-populated with domain controllers for each domain. To
populate the file, the connector attempts to find domain controllers that are at the same site as
the connector and selects two that are reachable and that respond the fastest.

When you create additional directories that have DNS Service Location enabled, or add new
domains to an Integrated Windows Authentication directory, the new domains, and a list of
domain controllers for them, are added to the file.

You can override the default selection at any time by editing the domain_krb.properties file. As
a best practice, after you create a directory, view the domain_krb.properties file and verify that
the domain controllers listed are the optimal ones for your configuration. For a global Active
Directory deployment that has multiple domain controllers across different geographical
locations, using a domain controller that is in close proximity to the connector ensures faster
communication with Active Directory.
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You must also update the file manually for any other changes. The following rules apply.

The domain_krb.properties file is created in the virtual machine that contains the connector.
In a typical deployment, with no additional connectors deployed, the file is created in the
Directories Management service virtual machine. If you are using an additional connector for
the directory, the file is created in the connector virtual machine. A virtual machine can only
have one domain_krb.properties file.

The file is created, and auto-populated with domain controllers for each domain, when you
first create a directory that has DNS Service Location lookup enabled.

Domain controllers for each domain are listed in order of priority. To connect to Active
Directory, the connector tries the first domain controller in the list. If it is not reachable, it tries
the second one in the list, and so on.

The file is updated only when you create a new directory that has DNS Service Location
lookup enabled or when you add a domain to an Integrated Windows Authentication
directory. The new domain and a list of domain controllers for it are added to the file.

Note that if an entry for a domain already exists in the file, it is not updated. For example, if
you created a directory, then deleted it, the original domain entry remains in the file and is
not updated.

The file is not updated automatically in any other scenario. For example, if you delete a
directory, the domain entry is not deleted from the file.

If a domain controller listed in the file is not reachable, edit the file and remove it.

If you add or edit a domain entry manually, your changes will not be overwritten.

How Domain Controllers are Selected to Auto-Populate the domain_krb.properties File

To auto-populate the domain_krb.properties file, domain controllers are selected by first

determining the subnet on which the connector resides (based on the IP address and netmask),
then using the Active Directory configuration to identify the site of that subnet, getting the list of
domain controllers for that site, filtering the list for the appropriate domain, and picking the two
domain controllers that respond the fastest.

To detect the domain controllers that are the closest, VMware Identity Manager has the following

requirements.

The subnet of the connector must be present in the Active Directory configuration, or a
subnet must be specified in the runtime-config.properties file.

The subnet is used to determine the site.

The Active Directory configuration must be site aware.
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If the subnet cannot be determined or if your Active Directory configuration is not site aware,
DNS Service Location lookup is used to find domain controllers, and the file is populated with a
few domain controllers that are reachable. Note that these domain controllers may not be at the
same geographical location as the connector, which can result in delays or timeouts while
communicating with Active Directory. In this case, edit the domain_krb.properties file manually
and specify the correct domain controllers to use for each domain.

Sample domain_krb.properties File

example.com=hostl.example.com:389,host2.example.com:389

m  Override the Default Subnet Selection
To auto-populate the domain_krb.properties file, the connector attempts to find domain
controllers that are at the same site so there is minimal latency between the connector and
Active Directory.

m  Edit the domain_krb.properties file

The /usr/local/horizon/conf/domain_krb.properties file determines the domain
controllers to use for directories that have DNS Service Location lookup enabled. You can
edit the file at any time to modify the list of domain controllers for a domain, or to add or
delete domain entries. Your changes will not be overridden.

m  Troubleshooting domain_krb.properties

Use this information to troubleshoot the domain_krb.properties file.

Override the Default Subnet Selection

To auto-populate the domain_krb.properties file, the connector attempts to find domain
controllers that are at the same site so there is minimal latency between the connector and
Active Directory.

To find the site, the connector determines the subnet on which it resides, based on its IP address
and netmask, then uses the Active Directory configuration to identify the site for that subnet. If
the subnet of the virtual machine is not in Active Directory, or if you want to override the
automatic subnet selection, you can specify a subnet in the runtime-config.properties file.

Procedure

1 Login to the Directories Management virtual machine as the root user.

Note If you are using an additional connector for the directory, log in to the connector
virtual machine.

2 Edit the /usr/local/horizon/conf/runtime-config.properties file and add the following
attribute.

siteaware.subnet.override=subnet

where subnet is a subnet for the site whose domain controllers you want to use. For example:
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siteaware.subnet.override=10.100.0.0/20
3 Save and close the file.
4 Restart the service.

service horizon-workspace restart

Edit the domain_krb.properties file

The /usr/local/horizon/conf/domain_krb.properties file determines the domain controllers
to use for directories that have DNS Service Location lookup enabled. You can edit the file at any
time to modify the list of domain controllers for a domain, or to add or delete domain entries.
Your changes will not be overridden.

The file is initially created and auto-populated by the connector. You need to update it manually
in some scenarios.

m |f the domain controllers selected by default are not the optimal ones for your configuration,
edit the file and specify the domain controllers to use.

m |f you delete a directory, delete the corresponding domain entry from the file.
m If any domain controllers in the file are not reachable, remove them from the file.

See also About Domain Controller Selection.

Procedure

1 Login to the Directories Management virtual machine as the root user.

Note If you are using an additional connector for the directory, log in to the connector
virtual machine.

2 Change directories to /usr/local/horizon/conf.
3 Edit the domain_krb.properties file to add or edit the list of domain to host values.
Use the following format:

domain=host: port,hhost2: port, host3: port
For example:

example.com=examplehostl.example.com:389,examplehost2.example.com:389

List the domain controllers in order of priority. To connect to Active Directory, the connector
tries the first domain controller in the list. If it is not reachable, it tries the second one in the
list, and so on.

Important Domain names must be in lowercase.

4 Change the owner of the domain_krb.properties file to horizon and group to www using the
following command:

chown horizon:www /usr/local/horizon/conf/domain_krb.properties
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5 Restart the service.

service horizon-workspace restart

Troubleshooting domain_krb.properties
Use this information to troubleshoot the domain_krb.properties file.
"Error resolving domain" error

If the domain_krb.properties file already includes an entry for a domain, and you try to create a
new directory of a different type for the same domain, an "Error resolving domain" error occurs.
You must edit the domain_krb.properties file and manually remove the domain entry before
creating the new directory.

Domain controllers are unreachable

Once a domain entry is added to the domain_krb.properties file, it is not updated automatically.
If any domain controllers listed in the file become unreachable, edit the file manually and remove
them.

Managing Access Policies

The Directories Management policies are a set of rules that specify criteria that must be met for
users to access their app portal or to launch specified Web applications.

You create the rule as part of a policy. Each rule in a policy can specify the following information.

m  The network range, where users are allowed to log in from, such as inside or outside the
enterprise network.

m  The device type that can access through this policy.

m  The order that the enabled authentication methods are applied.
m  The number of hours the authentication is valid.

m  Custom access denied message.

Note The policies do not control the length of time that a Web application session lasts. They
control the amount of time that users have to launch a Web application.

The Directories Management service includes a default policy that you can edit. This policy
controls access to the service as a whole. See Applying the Default Access Policy. To control
access to specific Web applications, you can create additional policies. If you do not apply a
policy to a Web application, the default policy applies.

Configuring Access Policy Settings

A policy contains one or more access rules. Each rule consists of settings that you can configure
to manage user access to their application portals as a whole or to specified Web applications.
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Network Range

For each rule, you determine the user base by specifying a network range. A network range
consists of one or more IP ranges. You create network ranges from the Identity & Access
Management tab, Setup > Network Ranges page prior to configuring access policy sets.

Device Type

Select the type of device that the rule manages. The client types are Web Browser, ldentity
Manager Client App, iOS, Android, and All device types.

Authentication Methods

Set the priority of the authentication methods for the policy rule. The authentication methods are
applied in the order they are listed. The first identity provider instances that meets the
authentication method and network range configuration in the policy is selected, and the user
authentication request is forwarded to the identity provider instance for authentication. If
authentication fails, the next authentication method in the list is selected. If Certificate
authentication is used, this method must be the first authentication method in the list.

You can configure access policy rules to require users to pass credentials through two
authentication methods before they can sign in. If one or both authentication method fails and
fallback methods are also configured, users are prompted to enter their credentials for the next
authentication methods that are configured. The following two scenarios describe how
authentication chaining can work.

m In the first scenario, the access policy rule is configured to require users to authenticate with
their password and with their Kerberos credential. Fallback authentication is set up to require
the password and the RADIUS credential for authentication. A user enters the password
correctly, but fails to enter the correct Kerberos authentication credential. Since the user
entered the correct password, the fallback authentication request is only for the RADIUS
credential. The user does not need to re-enter the password.

= In the second scenario, the access policy rule is configured to require users to authenticate
with their password and their Kerberos credential. Fallback authentication is set up to require
RSA SecurlD and a RADIUS for authentication. A user enters the password correctly but fails
to enter the correct Kerberos authentication credential. The fallback authentication request is
for both the RSA SecurlD credential and the RADIUS credential for authentication.

Authentication Session Length

For each rule, you set the length that this authentication is valid. The value determines the
maximum amount of time users have since their last authentication event to access their portal or
to launch a specific Web application. For example, a value of 4 in a Web application rule gives
users four hours to launch the web application unless they initiate another authentication event
that extends the time.
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Custom Access Denied Error Message
When users attempt to sign in and fail because of invalid credentials, incorrect configuration, or

system error, an access denied message is displayed. The default message is

Access denied as no valid authentication methods were found.

You can create a custom error message for each access policy rule that overrides the default
message. The custom message can include text and a link for a call to action message. For
example, in a policy rules for mobile devices that you want to manage, if a user tries to sign in
from an unenrolled device, the follow custom error message could appear:

Please enroll your device to access corporate resources by clicking the link at the end of this
message. If your device is already enrolled, contact support for help.

Example Default Policy

The following policy serves as an example of how you can configure the default policy to control
access to the apps portal. See Manage the User Access Policy.

The policy rules are evaluated in the order listed. You can change the order of the policy by
dragging and dropping the rule in the Policy Rules section.

In the following use case, this policy example applies to all applications.

@ DEFAULT POLICY

Policy Name* default_access_policy_set
Description Default access policy set
Applies To

i All Applications
Policy Rules

Network Range Device type Authentication Method Re-authenticate (Hours) +
T Internal Network Web Browser First, try: Kerberos 8 ®
and 1 more
I ALLRANGES Web Browser Securid 4 x +

1 wm For the internal network (Internal Network Range), two authentication methods are
configured for the rule, Kerberos and password authentication as the fallback method. To
access the apps portal from an internal network, the service attempts to authenticate
users with Kerberos authentication first, as it is the first authentication method listed in
the rule. If that fails, users are prompted to enter their Active Directory password. Users
log in using a browser and now have access to their user portals for an eight-hour
session.
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m  For access from the external network (All Ranges), only one authentication method is
configured, RSA SecurlD. To access the apps portal from an external network, users are

required to log in with SecurlD. Users log in using a browser and now have access to their
apps portals for a four-hour session.

2 When a user attempts to access a resource, except for Web applications covered by a Web-

application-specific policy, the default portal access policy applies.

For example, the re-authentication time for such resources matches the re-authentication
time of the default access policy rule. If the time for a user who logs in to the apps portal is
eight hours according to the default access policy rule, when the user attempts to launch a
resource during the session, the application launches without requiring the user to re-

authenticate.

Managing Web-Application-Specific Policies

When you add Web applications to the catalog, you can create Web-application-specific access

policies. For example, you can create an policy with rules for a Web application that specifies
which IP addresses have access to the application, using which authentication methods, and for

how long until reauthentication is required.

The following Web-application-specific policy provides an example of a policy you can create to
control access to specified Web applications.

Example 1 Strict Web-Application-Specific Policy

In this example, a new policy is created and applied to a sensitve Web application.

Policy Name™

Description

Applies To

Policy Rules

Network Range

[

Internal Network

i ALLRANGES

Sensitive Web Applications

To be applied to Web applications that should have
limited access.

Sensitive Web Applications

To be applied to Web applications that should have limited access.

Select the Web applications from your Catalog that this policy applies fo.

AirWatch
Content Locker

Device type

Web Browser

Web Browser

Edit Apps

Authentication Method Re-authenticate (Hours)

First, try: Kerberos 8
and 1 more

Securld 4

1 To access the service from outside the enterprise network, the user is required to log in with

RSA SecurlD. The user logs in using a browser and now has access to the apps portal for a
four hour session as provided by the default access rule.
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2 After four hours, the user tries to launch a Web application with the Sensitive Web
Applications policy set applied.

3 The service checks the rules in the policy and applies the policy with the ALL RANGES
network range since the user request is coming from a Web browser and from the ALL
RANGES network range.

The user logs in using the RSA SecurlD authentication method, but the session just expired.
The user is redirected for reauthentication. The reauthentication provides the user with
another four hour session and the ability to launch the application. For the next four hours,
the user can continue to launch the application without having to reauthenticate.

Example 2 Stricter Web-Application-Specific Policy

For a stricter rule to apply to extra sensitve Web applications, you could require re-
authentication With Secureld on any device after 1 hour. The following is an example of how this
type of policy access rule is implemented.

1 Userlogs in from an inside the enterprise network using the password authentication method.
Now, the user has access to the apps portal for eight hours, as set up in Example 1.

2 The user immediately tries to launch a Web application with the Example 2 policy rule
applied, which requires RSA SecurlD authentication.

3 The useris redirected to an identity provider that provides RSA SecurlD authentication.

4 After the user successfully logs in, the service launches the application and saves the
authentication event.

The user can continue to launch this application for up to one hour but is asked to

reauthenticate after an hour, as dictated by the policy rule.

Manage the User Access Policy

vRealize Automation is supplied with a default user access policy that you can use as is or edit as
needed to manage tenant access to applications.

vRealize Automation is supplied with a default user access policy, and you cannot add new
policies. You can edit the existing policy to add rules.

Prerequisites

m  Select or configure the appropriate identity providers for your deployment. See Configure a
Third Party Identity Provider Connection.

m  Configure the appropriate network ranges for your deployment. See Add or Edit a Network
Range.

m  Configure the appropriate authentication methods for your deployment. See Integrating
Alternative User Authentication Products with Directories Management.

m If you plan to edit the default policy (to control user access to the service as a whole),
configure it before creating Web-application-specific policy.
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m  Add Web applications to the Catalog. The Web applications must be listed in the Catalog

page before you can add a policy.

m  Login to vRealize Automation as a tenant administrator.

Procedure

—

H W N

Select Administration > Directories Management > Policies.
Click Edit Policy to add a new policy.
Add a policy name and description in the respective text boxes.

In the Applies To section, click Select and in the page that appears, select the Web

applications that are associated with this policy.

5 In the Policy Rules section, click + to add a rule.

The Add a Policy Rule page appears.

a
b
C
d

e

Select the network range to apply to this rule.

Select the type of device that can access the web applications for this rule.

Select the authentication methods to use in the order the method should be applied.

Specify the number of hours a Web application session open.

Click Save.

6 Configure additional rules as appropriate.

7 Click Save.

Configuring Additional Identity Provider Connections

You can configure additional identity provider connections as needed to support different

identity management scenarios, including additional built-in identity providers and third-party

identity providers.

You can create three types of identity provider connections using Directories Management.

m Create Third-Party IDP - Use this item to create a connection to an external third-party
identity provider. Ensure that you have following before adding a third-party identity provider
instance.

Verify that the third-party instances are SAML 2.0 compliant and that the service can

reach the third-party instance.

Obtain the appropriate third-party metadata information to add when you configure the
identity provider in the administration console. The metadata information you obtain from

the third-party instance is either the URL to the metadata or the actual metadata.

m Create Workspace IDP - When you enable a connector to authenticate users during

Directories Management configuration, a Workspace IDP is created as the identity provider
and password authentication is enabled. You can configure additional workspace identity

providers behind different load balancers.
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m  Create Built-in IDP - Built in Identity Providers use the internal Directories Management
mechanisms to support authentication. You can configure built-in identity providers to use
authentication methods that do not require the use of an on premises connector. When you
configure the built-in provider, you associate the authentication methods to use with the
provider.

m  Configure a Third Party ldentity Provider Connection
vRealize Automation is supplied with a default identity provider connection instance. Users
may want to create additional identity provider connections to support just-in-time user
provisioning or other custom configurations.

m  Configure Additional Workspace Identity Providers
When you configure a Directories Management connector to authenticate users, a
Workspace IDP is created and password authentication is enabled.

m  Configure a Built-in Identity Provider Connection

You can configure multiple built-in identity providers and associate authentication methods
with them.
Configure a Third Party Identity Provider Connection

vRealize Automation is supplied with a default identity provider connection instance. Users may
want to create additional identity provider connections to support just-in-time user provisioning
or other custom configurations.

vRealize Automation is supplied with an default identity provider. In most cases, the default
provider is sufficient for customer needs. If you use an existing enterprise identity management
solution, you can set up a custom identity provider to redirect users to your existing identity
solution.

When using a custom identity provider, Directories Management uses SAML metadata from that
provider to establish a trust relationship with the provider. After this relationship is established,
Directories Management maps the users from the SAML assertion to the list of internal vRealize
Automation users based the subject name ID.

Prerequisites

m  Configure the network ranges that you want to direct to this identity provider instance for
authentication. See Add or Edit a Network Range.

m  Access to the third-party metadata document. This can be either the URL to the metadata or
the actual metadata.

m  Login to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Directories Management > Identity Providers.

This page displays all configured |dentity Providers.
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Click Add Identity Provider.

A menu appears with Identity Provider options.

Select Create Third Party IDP.

Enter the appropriate information to configure the identity provider.

Option
Identity Provider Name

SAML Metadata

Users

Just-in-Time User
Provisioning

Network

Authentication Methods

SAML Signing
Certificate

Hostname

5 Click Add.

What to do next

Description
Enter a name for this identity provider instance.

Add the third party IdPs XML-based metadata document to establish trust with the

identity provider.

1 Enter the SAML metadata URL or the xml content into the text box.

2 Click Process IdP Metadata. The NamelD formats supported by the IdP are extracted
from the metadata and added to the Name ID Format table.

3 Inthe Name ID value column, select the user attribute in the service to map to the ID
formats displayed. You can add custom third-party name ID formats and map them to
the user attribute values in the service.

4 (Optional) Select the NamelDPolicy response identifier string format.

Select the Directories Management directories of the users that can authenticate using this
identity provider.

Select the appropriate options to support just-in-time provisioning using an appropriate
third party identity provider.
Enter the Directory Name to use for just-in-time provisioning.

Enter one or more Domains that exist within the external identity provider that you will
use for just-in-time provisioning.

The existing network ranges configured in the service are listed.

Select the network ranges for the users, based on their IP addresses, that you want to
direct to this identity provider instance for authentication.

Add the authentication methods supported by the third-party identity provider. Select the
SAML authentication context class that supports the authentication method.

Click Service Provider (SP) Metadata to see URL to Directories Management SAML
service provider metadata URL . Copy and save the URL. This URL is configured when you
edit the SAML assertion in the third-party identity provider to map Directories
Management users.

If the Hostname field displays, enter the hostname where the identity provider is
redirected to for authentication. If you are using a non-standard port other than 443, you
can set this as Hostname:Port. For example, myco.example.com:8443.

Copy and save the Directories Management service provider metadata that is required to
configure the third-party identity provider instance. This metadata is available either in the
SAML Signing Certificate section of the Identity Provider page.

Add the authentication method of the identity provider to the services default policy.
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See the Setting Up Resources in Directories Management guide for information about adding and
customizing resources that you add to the catalog.

Configure Additional Workspace Identity Providers

When you configure a Directories Management connector to authenticate users, a Workspace
IDP is created and password authentication is enabled.

You can configure additional connectors to operate behind multiple load balancers. When your
deployment includes more than one load balancer, you can configure additional Workspace
identity providers for authentication in each load balancer configuration.

Procedure

1 Select Administration > Directories Management > Identity Providers.
This page displays all configured Identity Providers.

2 Click Add Identity Provider.
A menu appears with Identity Provider options.

3 Select Create Workspace IDP.

4 Enter the appropriate information to configure the identity provider.

Option Description

Identity Provider Name Enter the name for this built-in identity provider instance.

Users Select the users to authenticate. The configured directories are listed.

Users Select the group of users who can authenticate using this Workspace identity
provider.

Network The existing network ranges configured in the service are listed. Select the network

range for the users based on the IP addresses that you want to direct to this
identity provider instance for authentication.

Authentication Methods Authentication methods that are configured for the service are displayed. Select the
check box for the authentication methods to associate with this identity provider.

For device compliance and Password, with AirWatch and AirWatch Connector,
ensure that the option is enabled on the AirWatch configuration page.

5 Click Add.

Configure a Built-in Identity Provider Connection

You can configure multiple built-in identity providers and associate authentication methods with
them.

Prerequisites

If you are using Built-in Keberos authentication, download the KDC issuer certificate to use in the
AirWatch configuration of the iOS device management profile.
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Procedure

1 Select Administration > Directories Management > Identity Providers.
This page displays all configured Identity Providers.

2 Click Add Identity Provider.
A menu appears with Identity Provider options.

3 Select Create Built-in IDP.

4 Enter the appropriate information to configure the identity provider.

Option Description

Identity Provider Name Enter the name for this built-in identity provider instance.

Users Select the users to authenticate. The configured directories are listed.

Network The existing network ranges configured in the service are listed. Select the network

range for the users based on the IP addresses that you want to direct to this
identity provider instance for authentication.

Authentication Methods The authentication methods that are configured for the service are displayed. Select
the check box for the authentication methods to associate with this identity
provider.

For device compliance and Password, with AirWatch and AirWatch Connector,
ensure that the appropriate option is enabled on the AlrWatch configuration page.

5 Click Add.

Integrating Alternative User Authentication Products with Directories
Management

Typically, when you initially configure Directories Management, you use the connectors supplied
with your existing vRealize Automation infrastructure to create an Active Directory connection
for user ID and password based authentication and management. Alternatively, you can integrate
Directories Management with other authentication solutions such as Kerberos or RSA SecurlD.

The identity provider instance can be the Directories Management connector instance, third-
party identity provider instances, or a combination of both.

The identity provider instance that you use with the Directories Management service creates an
in-network federation authority that communicates with the service using SAML 2.0 assertions.

When you initially deploy the Directories Management service, the connector is the initial identity
provider for the service. Your existing Active Directory infrastructure is used for user
authentication and management.

The following authentication methods are supported. You configure these authentication
methods from the administration console.
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Table 2-8. User Authentication Types Supported by Directories Management

Authentication Types

Password (on-premise deployment)

Kerberos for desktops

Certificate (on-premise
deployment)

RSA SecurlD (on-premise
deployment)

RADIUS (on-premise deployment)

RSA Adaptive Authentication (on-

premise deployment)

Mobile SSO (for iOS)

Mobile SSO (for Android)

Password (AirWatch Connector)

Description

Without any configuration after Active Directory is configured, Directories
Management supports Active Directory password authentication. This method
authenticates users directly against Active Directory.

Kerberos authentication provides domain users with single sign-in access to their
apps portal. Users do not need to sign in again after they sign in to the network.

Certificate-based authentication can be configured to allow clients to authenticate
with certificates on their desktop and mobile devices or to use a smart card
adapter for authentication.

Certificate-based authentication is based on what the user has and what the
person knows. An X.509 certificate uses the public key infrastructure standard to
verify that a public key contained within the certificate belongs to the user.

When RSA SecurlD authentication is configured, Directories Management is
configured as the authentication agent in the RSA SecurlD server. RSA SecurlD
authentication requires users to use a token-based authentication system. RSA
SecurlD is an authentication method for users accessing Directories Management
from outside the enterprise network.

RADIUS authentication provides two-factor authentication options. You set up the
RADIUS server that is accessible to the Directories Management service. When
users sign in with their user name and passcode, an access request is submitted to
the RADIUS server for authentication.

RSA authentication provides a stronger multi-factor authentication than only user
name and password authentication against Active Directory. When RSA Adaptive
Authentication is enabled, the risk indicators specified in the risk policy set up in
the RSA Policy Management application. The Directories Management service
configuration of adaptive authentication is used to determine the required
authentication prompts.

Mobile SSO for iOS authentication is used for single sign-on authentication for
AirWatch-managed iOS devices. Mobile SSO (for iOS) authentication uses a Key
Distribution Center (KDC) that is part of the Directories Management service. You
must initiate the KDC service in the VMware Identity Manager service before you
enable this authentication method.

Mobile SSO for Android authentication is used for single sign-on authentication for
AirWatch-managed Android devices. A proxy service is set up between the
Directories Management service and AirWatch to retrieve the certificate from
AirWatch for authentication.

The AirWatch Cloud Connector can be integrated with the Directories
Management service for user password authentication. You configure the
Directories Managementservice to sync users from the AirWatch directory.

Users are authenticated based on the authentication methods, the default access policy rules,
network ranges, and the identity provider instance you configure. After the authentication
methods are configured, you create access policy rules that specify the authentication methods

to be used by device type.
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Configuring SecurlD for Directories Management

When you configure RSA SecurlD server, you must add the Directories Management service
information as the authentication agent on the RSA SecurID server and configure the RSA
SecurlD server information on the Directories Management service.

When you configure SecurlD to provide additional security, you must ensure that your network is
properly configured for your Directories Management deployment. For SecurlD specifically, you
must ensure that the appropriate port is open to enable SecurlD to authenticate users outside
your network.

After you run the Directories Management Setup wizard and configured your Active Directory
connection, you have the information necessary to prepare the RSA SecurlD server. After you
prepare the RSA SecurlD server for Directories Management, you enable SecurlD in the
administration console.

m  Prepare the RSA SecurlD Server

The RSA SecurlD server must be configured with information about the Directories
Management appliance as the authentication agent. The information required is the host
name and the IP addresses for network interfaces.

m  Configure RSA SecurlD Authentication

After Directories Management is configured as the authentication agent in the RSA SecurlD
server, you must add the RSA SecurlD configuration information to the connector.

Prepare the RSA SecurlD Server

The RSA SecurlD server must be configured with information about the Directories Management
appliance as the authentication agent. The information required is the host name and the IP
addresses for network interfaces.

Prerequisites

m  Verify that one of the following RSA Authentication Manager versions is installed and
functioning on the enterprise network: RSA AM 6.1.2, 7.1 SP2 and later, and 8.0 and later. The
Directories Management server uses AuthSDK_Java_v8.1.1.312.06_03_11_03_16_51 (Agent
API 8.1 SP1), which only supports the preceding versions of RSA Authentication Manager (the
RSA SecurlD server). For information about installing and configuring RSA Authentication
Manager (RSA SecurlD server), see RSA documentation.

VMware, Inc. 134



Configuring vRealize Automation

Procedure

1 On a supported version of the RSA SecurID server, add the Directories Management
connector as an authentication agent. Enter the following information.

Option Description

Hostname The host name of Directories Management.

IP address The IP address of Directories Management.

Alternate IP address If traffic from the connector passes through a network address translation

(NAT) device to reach the RSA SecurlD server, enter the private IP address
of the appliance.
2 Download the compressed configuration file and extract the sdconf.rec file.

Be prepared to upload this file later when you configure RSA SecurlD in Directories
Management.

What to do next

Go to the administration console and in the Identity & Access Management tab Setup pages,
select the connector and in the AuthAdapters page configure SecurlD.

Configure RSA SecurlD Authentication
After Directories Management is configured as the authentication agent in the RSA SecurlD
server, you must add the RSA SecurlD configuration information to the connector.

Prerequisites

m  Verify that RSA Authentication Manager (the RSA SecurlD server) is installed and properly
configured.

m  Download the compressed file from the RSA SecurlD server and extract the server
configuration file.

Procedure

1 As atenant administrator, navigate to Administration > Directories Management >
Connectors

2 On the Connectors page, select the Worker link for the connector that is being configured
with RSA SecurID.

3 Click Auth Adapters and then click SecuriDIldpAdapter.

You are redirected to the identity manager sign in page.
4 In the Authentication Adapters page SecurlDIdpAdapter row, click Edit.
5 Configure the SecurlD Authentication Adapter page.

Information used and files generated on the RSA SecurlD server are required when you
configure the SecurlD page.
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Option Action

Name A name is required. The default name is SecurlDldpAdapter. You can change this.

Enable Select this box to enable SecurlD authentication.

SecurlD

Number of Enter the maximum number of failed login attempts when using the RSA SecurlD token. The default

authentication is five attempts.

attempts

allowed

Connector Enter the IP address of the connector instance. The value you enter must match the value you used

Address when you added the connector appliance as an authentication agent to the RSA SecurlD server. If
your RSA SecurlD server has a value assigned to the Alternate IP address prompt, enter that value
as the connector IP address. If no alternate IP address is assigned, enter the value assigned to the
IP address prompt.

Agent IP Enter the value assigned to the IP address prompt in the RSA SecurlD server.

Address

Server Upload the RSA SecurlD server configuration file. First, you must download the compressed file

Configuration from the RSA SecurlD server and extract the server configuration file, which by default is named

sdconf.rec.

Node Secret Leaving the node secret field blank allows the node secret to auto generate. It is recommended that

you clear the node secret file on the RSA SecurlD server and intentionally do not upload the node
secret file. Ensure that the node secret file on the RSA SecurlD server and on the server connector
instance always match. If you change the node secret at one location, change it at the other
location.

6 Click Save.

What to do next

Add the authentication method to the default access policy. Navigate to Administration >
Directories Management > Policies and click Edit Default Policy to edit the default policy rules to
add the SecurlD authentication method to the rule in the correct authentication order.

Configuring RADIUS for Directories Management

You can configure Directories Management so that users are required to use RADIUS (Remote
Authentication Dial-In User Service) authentication. You configure the RADIUS server information
on the Directories Management service.

RADIUS support offers a wide range of alternative two-factor token-based authentication
options. Because two-factor authentication solutions, such as RADIUS, work with authentication
managers installed on separate servers, you must have the RADIUS server configured and
accessible to the identity manager service.

When users sign in to their My Apps portal and RADIUS authentication is enabled, a special login
dialog box appears in the browser. Users enter their RADUS authentication user name and
passcode in the login dialog box. If the RADIUS server issues an access challenge, the identity
manager service displays a dialog box prompting for a second passcode. Currently support for
RADIUS challenges is limited to prompting for text input.
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After a user enters credentials in the dialog box, the RADIUS server can send an SMS text
message or email, or text using some other out-of-band mechanism to the user's cell phone with
a code. The user can enter this text and code into the login dialog box to complete the
authentication.

If the RADIUS server provides the ability to import users from Active Directory, end users might
first be prompted to supply Active Directory credentials before being prompted for a RADIUS

authentication username and passcode.
Prepare the RADIUS Server
Set up the RADIUS server and then configure it to accept RADIUS requests from the Directories

Management service.

Refer to your RADIUS vendor's setup guides for information about setting up the RADIUS server.
Note your RADIUS configuration information as you use this information when you configure
RADIUS in the service. To view the type of RADIUS information required to configure Directories
Management see Configure RADIUS Authentication in Directories Management.

You can set up a secondary Radius authentication server to be used for high availability. If the
primary RADIUS server does not respond within the server timeout configured for RADIUS
authentication, the request is routed to the secondary server. When the primary server does not

respond, the secondary server receives all future authentication requests.
Configure RADIUS Authentication in Directories Management
You enable RADIUS software on an authentication manager server. For RADIUS authentication,

follow the vendor's configuration documentation.

Prerequisites

Install and configure the RADIUS software on an authentication manager server. For RADIUS
authentication, follow the vendor's configuration documentation.

You need to know the following RADIUS server information to configure RADIUS on the service.
m |P address or DNS name of the RADIUS server.
m  Authentication port numbers. Authentication port is usually 1812.

= Authentication type. The authentication types include PAP (Password Authentication
Protocol), CHAP (Challenge Handshake Authentication Protocol), MSCHAP1, MSCHAP2
(Microsoft Challenge Handshake Authentication Protocol, versions 1 and 2).

m  RADIUS shared secret that is used for encryption and decryption in RADIUS protocol
messages.

m  Specific timeout and retry values needed for RADIUS authentication.

m  Login to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Directories Management > Connectors.

2 On the Connectors page, select the Worker link for the connector that is being configured for
RADIUS authentication.
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Click Auth Adapters and then click RadiusAuthAdapter.

You are redirected to the identity manager sign-in page.

Click Edit to configure these fields on the Authentication Adapter page.

Option
Name

Enable Radius
Adapter

Number of
authentication
attempts
allowed

Number of
attempts to
Radius server

Radius server
hostname/
address

Authenticatio
n port

Accounting
port

Authenticatio
n type

Shared secret

Server
timeout in
seconds

Realm Prefix

Realm Suffix

Login page
passphrase
hint

Action
A name is required. The default name is RadiusAuthAdapter. You can change this.

Select this box to enable RADIUS authentication.

Enter the maximum number of failed login attempts when using RADIUS to log in. The default is five
attempts.

Specify the total number of retry attempts. If the primary server does not respond, the service
waits for the configured time before retrying again.

Enter the host name or the IP address of the RADIUS server.

Enter the Radius authentication port number. This is usually 1812.

Enter O for the port number. The accounting port is not used at this time.

Enter the authentication protocol that is supported by the RADIUS server. Either PAP, CHAP,
MSCHAP1, OR MSCHAP2.

Enter the shared secret that is used between the RADIUS server and the VMware Identity Manager
service.

Enter the RADIUS server timeout in seconds, after which a retry is sent if the RADIUS server does
not respond.

(Optional) The user account location is called the realm.

If you specify a realm prefix string, the string is placed at the beginning of the user name when the
name is sent to the RADIUS server. For example, if the user name is entered as jdoe and the realm
prefix DOMAIN-A\ is specified, the user name DOMAIN-A\jdoe is sent to the RADIUS server. If you
do not configure these fields, only the user name that is entered is sent.

(Optional) If you specify a realm suffix, the string is placed at end of the user name. For example, if
the suffix is @myco.com, the username jdoe@myco.com is sent to the RADIUS server.

Enter the text string to display in the message on the user login page to direct users to enter the
correct Radius passcode. For example, if this field is configured with AD password first and then
SMS passcode, the login page message would read Enter your AD password first and then SMS
passcode. The default text string is RADIUS Passcode.

You can enable a secondary RADIUS server for high availability.

Configure the secondary server as described in step 4.

Click Save.
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What to do next

Add the RADIUS authentication method to the default access policy. Select Administration >
Directories Management > Policies and click Edit Default Policy to edit the default policy rules to
add the RADIUS authentication method to the rule in the correct authentication order.

Configuring a Certificate or Smart Card Adapter for Use with Directories Management

You can configure x509 certificate authentication to allow clients to authenticate with certificates
on their desktop and mobile devices or to use a smart card adapter for authentication.
Certificate-based authentication is based on what the user has (the private key or smart card),
and what the person knows (the password to the private key or the smart-card PIN.) An X.509
certificate uses the public key infrastructure (PKI) standard to verify that a public key contained
within the certificate belongs to the user. With smart card authentication, users connect the
smart card with the computer and enter a PIN.

The smart card certificates are copied to the local certificate store on the user's computer. The
certificates in the local certificate store are available to all the browsers running on this user's
computer, with some exceptions, and therefore, are available to a Directories Management
instance in the browser.

m  Using User Principal Name for Certificate Authentication

You can use certificate mapping in Active Directory. Certificate and smart card logins uses
the user principal name (UPN) from Active Directory to validate user accounts. The Active
Directory accounts of users attempting to authenticate in the Directories Management
service must have a valid UPN that corresponds to the UPN in the certificate.

m Certificate Authority Required for Authentication
To enable logging in using certificate authentication, root certificates and intermediate
certificates must be uploaded to the Directories Management.

m Using Certificate Revocation Checking

You can configure certificate revocation checking to prevent users who have their user
certificates revoked from authenticating. Certificates are often revoked when a user leaves
an organization, loses a smart card, or moves from one department to another.

m  Configure Certificate Authentication for Directories Management

You enable and configure certificate authentication from the vRealize Automation
administration console Directories Management feature.

Using User Principal Name for Certificate Authentication
You can use certificate mapping in Active Directory. Certificate and smart card logins uses the

user principal name (UPN) from Active Directory to validate user accounts. The Active Directory
accounts of users attempting to authenticate in the Directories Management service must have a
valid UPN that corresponds to the UPN in the certificate.

You can configure the Directories Management to use an email address to validate the user
account if the UPN does not exist in the certificate.
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You can also enable an alternate UPN type to be used.
Certificate Authority Required for Authentication
To enable logging in using certificate authentication, root certificates and intermediate

certificates must be uploaded to the Directories Management.

The certificates are copied to the local certificate store on the user's computer. The certificates in
the local certificate store are available to all the browsers running on this user's computer, with
some exceptions, and therefore, are available to a Directories Management instance in the
browser.

For smart-card authentication, when a user initiates a connection to a the Directories
Management instance, the Directories Management service sends a list of trusted certificate
authorities (CA) to the browser. The browser checks the list of trusted CAs against the available
user certificates, selects a suitable certificate, and then prompts the user to enter a smart card
PIN. If multiple valid user certificates are available, the browser prompts the user to select a
certificate.

If a user cannot authenticate, the root CA and intermediate CA might not be set up correctly, or
the service has not been restarted after the root and intermediate CAs were uploaded to the
server. In these cases, the browser cannot show the installed certificates, the user cannot select

the correct certificate, and certificate authentication fails.
Using Certificate Revocation Checking
You can configure certificate revocation checking to prevent users who have their user

certificates revoked from authenticating. Certificates are often revoked when a user leaves an
organization, loses a smart card, or moves from one department to another.

Certificate revocation checking with certificate revocation lists (CRLs) and with the Online
Certificate Status Protocol (OCSP) is supported. A CRL is a list of revoked certificates published
by the CA that issued the certificates. OCSP is a certificate validation protocol that is used to get
the revocation status of a certificate.

You can configure certificate revocation checking in the administration console Connectors >
Auth Adapters > CertificateAuthAdapter page when you configure certificate authentication.

You can configure both CRL and OCSP in the same certificate authentication adapter
configuration. When you configure both types of certificate revocation checking and the Use CRL
in case of OCSP failure checkbox is enabled, OCSP is checked first and if OCSP fails, revocation
checking falls back to CRL. Revocation checking does not fall back to OCSP if CRL fails.

Logging in with CRL Checking

When you enable certificate revocation, the Directories Management server reads a CRL to
determine the revocation status of a user certificate.

If a certificate is revoked, authentication through the certificate fails.

Logging in with OCSP Certificate Checking
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When you configure Certificate Status Protocol (OCSP) revocation checking, Directories
Management sends a request to an OCSP responder to determine the revocation status of a
specific user certificate. The Directories Management server uses the OCSP signing certificate to
verify that the responses it receives from the OCSP responder are genuine.

If the certificate is revoked, authentication fails.

You can configure authentication to fall back to CRL checking if it does not receive a response
from the OSCP responder or if the response is invalid.

Configure Certificate Authentication for Directories Management

You enable and configure certificate authentication from the vRealize Automation administration
console Directories Management feature.

Prerequisites

= Obtain the Root certificate and intermediate certificates from the CA that signed the
certificates presented by your users.

m  (Optional) List of Object Identifier (OID)s of valid certificate policies for certificate
authentication.

m For revocation checking, the file location of the CRL, the URL of the OCSP server.
m  (Optional) OCSP Response Signing certificate file location.

m  Consent form content, if enabling a consent form to display before authentication.

Procedure

1 As atenant administrator, navigate to Administration > Directories Management >
Connectors

2 On the Connectors page, select the Worker link for the connector that is being configured.
3 Click Auth Adapters and then click CertificateAuthAdapter.

You are redirected to the identity manager sign in page.
4 In the CertificateAuthAdapter row, click Edit.

5 Configure the Certificate Authentication Adapter page.

Note An asterisk indicates a required field. All other fields are optional.

Option Description

*Name A name is required. The default name is CertificateAuthAdapter. You can
change this name.

Enable certificate adapter Select the check box to enable certificate authentication.
*Root and intermediate CA Select the certificate files to upload. You can select multiple root CA and
certificates intermediate CA certificates that are encoded as DER or PEM.
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Option

Uploaded CA certificates

Use email if no UPN in certificate

Certificate policies accepted

Enable cert revocation

Use CRL from certificates

CRL Location

Enable OCSP Revocation

Use CRL in case of OCSP failure

Send OCSP Nonce

OCSP URL

OCSP responder's signing certificate

Enable consent form before
authentication

Consent form content

6 Click Save.

What to do next

Description

The uploaded certificate files are listed in the Uploaded Ca Certificates
section of the form.

You must restart the service before the new certificates are made available.
Click Restart Web Service to restart the service and add the certificates to
the trusted service.

Note Restarting the service does not enable certificate authentication. After
the service is restarted, continue configuring this page. Clicking Save at the
end of the page enables certificate authentication on the service.

If the user principal name (UPN) does not exist in the certificate, select this
checkbox to use the emailAddress attribute as the Subject Alternative Name
extension to validate user accounts.

Create a list of object identifiers that are accepted in the certificate policies
extensions.

Enter the object ID numbers (OID) for the Certificate Issuing Policy. Click Add
another value to add additional OIDs.

Select the check box to enable certificate revocation checking. This prevents
users who have revoked user certificates from authenticating.

Select the check box to use the certificate revocation list (CRL) published by
the CA that issued the certificates to validate a certificate's status, revoked
or not revoked.

Enter the server file path or the local file path from which to retrieve the CRL.

Select the check box to use the Online Certificate Status Protocol (OCSP)
certificate validation protocol to get the revocation status of a certificate.

If you configure both CRL and OCSP, you can check this box to fall back to
using CRL if OCSP checking is not available.

Select this check box if you want the unique identifier of the OCSP request
to be sent in the response.

If you enabled OCSP revocation, enter the OCSP server address for
revocation checking.

Enter the path to the OCSP certificate for the responder, /path/to/file.cer.

Select this check box to include a consent form page to appear before users
log in to their My Apps portal using certificate authentication.

Type the text that displays in the consent form in this text box.

= Add the certificate authentication method to the default access policy.Navigate to
Administration > Directories Management > Policies and click Edit Default Policy to edit the
default policy rules and add Certificate and make it the first authentication method for the
default policy. Certificate must be first authentication method listed in the policy rule,
otherwise certificate authentication fails.
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m  When Certificate Authentication is configured, and the service appliance is set up behind a
load balancer, make sure that the Directories Management connector is configured with SSL
pass-through at the load balancer and not configured to terminate SSL at the load balancer.
This configuration ensures that the SSL handshake is between the connector and the client in
order to pass the certificate to the connector.

Configuring a Third-Party Identity Provider Instance to Authenticate Users

You can configure a third-party identity provider to be used to authenticate users in the
Directories Management service.

Complete the following tasks prior to using the administration console to add the third-party
identity provider instance.

m  Verify that the third-party instances are SAML 2.0 compliant and that the service can reach
the third-party instance.

m  Obtain the appropriate third-party metadata information to add when you configure the
identity provider in the administration console. The metadata information you obtain from the
third-party instance is either the URL to the metadata or the actual metadata.

Configure a Third Party Identity Provider Connection

vRealize Automation is supplied with a default identity provider connection instance. Users may
want to create additional identity provider connections to support just-in-time user provisioning
or other custom configurations.

vRealize Automation is supplied with an default identity provider. In most cases, the default
provider is sufficient for customer needs. If you use an existing enterprise identity management
solution, you can set up a custom identity provider to redirect users to your existing identity
solution.

When using a custom identity provider, Directories Management uses SAML metadata from that
provider to establish a trust relationship with the provider. After this relationship is established,
Directories Management maps the users from the SAML assertion to the list of internal vRealize
Automation users based the subject name ID.

Prerequisites

m  Configure the network ranges that you want to direct to this identity provider instance for
authentication. See Add or Edit a Network Range.

m  Access to the third-party metadata document. This can be either the URL to the metadata or
the actual metadata.

m  Login to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Directories Management > Identity Providers.

This page displays all configured ldentity Providers.
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Click Add Identity Provider.

A menu appears with Identity Provider options.

Select Create Third Party IDP.

Enter the appropriate information to configure the identity provider.

Option
Identity Provider Name

SAML Metadata

Users

Just-in-Time User
Provisioning

Network

Authentication Methods

SAML Signing
Certificate

Hostname

5 Click Add.

What to do next

Description
Enter a name for this identity provider instance.

Add the third party IdPs XML-based metadata document to establish trust with the

identity provider.

1 Enter the SAML metadata URL or the xml content into the text box.

2 Click Process IdP Metadata. The NamelD formats supported by the IdP are extracted
from the metadata and added to the Name ID Format table.

3 Inthe Name ID value column, select the user attribute in the service to map to the ID
formats displayed. You can add custom third-party name ID formats and map them to
the user attribute values in the service.

4 (Optional) Select the NamelDPolicy response identifier string format.

Select the Directories Management directories of the users that can authenticate using this
identity provider.

Select the appropriate options to support just-in-time provisioning using an appropriate
third party identity provider.
Enter the Directory Name to use for just-in-time provisioning.

Enter one or more Domains that exist within the external identity provider that you will
use for just-in-time provisioning.

The existing network ranges configured in the service are listed.

Select the network ranges for the users, based on their IP addresses, that you want to
direct to this identity provider instance for authentication.

Add the authentication methods supported by the third-party identity provider. Select the
SAML authentication context class that supports the authentication method.

Click Service Provider (SP) Metadata to see URL to Directories Management SAML
service provider metadata URL . Copy and save the URL. This URL is configured when you
edit the SAML assertion in the third-party identity provider to map Directories
Management users.

If the Hostname field displays, enter the hostname where the identity provider is
redirected to for authentication. If you are using a non-standard port other than 443, you
can set this as Hostname:Port. For example, myco.example.com:8443.

Copy and save the Directories Management service provider metadata that is required to
configure the third-party identity provider instance. This metadata is available either in the
SAML Signing Certificate section of the Identity Provider page.

Add the authentication method of the identity provider to the services default policy.
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See the Setting Up Resources in Directories Management guide for information about adding and
customizing resources that you add to the catalog.

Managing Authentication Methods to Apply to Users

The Directories Management service attempts to authenticate users based on the authentication
methods, the default access policy, network ranges, and the identity provider instances you
configure.

When users attempt to log in, the service evaluates the default access policy rules to select
which rule in the policy to apply. The authentication methods are applied in the order they are
listed in the rule. The first identity provider instance that meets the authentication method and
network range requirements of the rule is selected and the user authentication request is
forwarded to the identity provider instance for authentication. If authentication fails, the next
authentication method configured in the rule is applied.

You can add rules that specify the authentication methods to be used by device type or by
device type and from a specific network range. For example, you could configure a rule requiring
users that sign in using iOS devices from a specific network to authenticate using RSA SecurlD
and another rule that specifies all device types signing in from the internal network IP address to

authenticate using their password.
Add or Edit a Network Range
You can manage the network ranges to define the IP addresses from which users can log in via

an Active Directory link. You add the network ranges you create to specific identity provider
instances and to access policy rules.

Define network ranges for your Directories Management deployment based on your network
topology.

One network range, called ALL RANGES, is created as the default. This network range includes
every IP address available on the Internet, 0.0.0.0 to 255.255.255.255. Even if your deployment
has a single identity provider instance, you can change the IP address range and add other
ranges to exclude or include specific IP addresses to the default network range. You can create
other network ranges with specific IP addresses that you can apply for specific purpose.

Note The default network range, ALL RANGES, and its description, "a network for all ranges,"
are editable. You can edit the name and description, including changing the text to a different
language, by clicking the network range name on the Network Ranges page.

Prerequisites

= You have configured tenants for your vRealize Automation deployment set up an appropriate
Active Directory link to support basic Active Directory user ID and password authentication.

m  Active Directory is installed and configured for use on your network.

m  Login to vRealize Automation as a tenant administrator.

Procedure

1 Select Administration > Directories Management > Network Ranges.
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2 Edit an existing network range or add a new network range.

Option Description
Edit an existing range Click the network range name to edit.
Add a range Click Add Network Range to add a new range.

3 Complete the form.

Form Iltem Description
Name Enter a name for the network range.
Description Enter a description for the Network Range.

View Pods  The View Pods option only appears when the View module is enabled.
Client Access URL Host. Enter the correct Horizon Client access URL for the network range.

Client Access Port. Enter the correct Horizon Client access port number for the network range.

IP Ranges Edit or add IP ranges until all desired and no undesired IP addresses are included.

What to do next
m  Associate each network range with an identity provider instance.

m  Associate network ranges with access policy rule as appropriate. See Configuring Access
Policy Settings.

Select Attributes to Sync with Directory

When you set up the Directories Management directory to sync with Active Directory, you
specify the user attributes that sync to the directory. Before you set up the directory, you can
specify on the User Attributes page which default attributes are required and, if you want, add
additional attributes that you want to map to Active Directory attributes.

When you configure the User Attributes page before the directory is created, you can change
default attributes from required to not required, mark attributes as required, and add custom
attributes.

For a list of the default mapped attributes, see Managing User Attributes that Sync from Active
Directory.

After the directory is created, you can change a required attribute to not be required, and you
can delete custom attributes. You cannot change an attribute to be a required attribute.

When you add other attributes to sync to the directory, after the directory is created, go to the
directory's Mapped Attributes page to map these attributes to Active Directory Attributes.

Procedure
1 Login to vRealize Automation as a system or tenant administrator.
2 Click the Administration tab.

3 Select Directories Management > User Attributes
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4 In the Default Attributes section, review the required attribute list and make appropriate
changes to reflect what attributes should be required.

5 In the Attributes section, add the Directories Management directory attribute name to the list.
6 Click Save.

The default attribute status is updated and attributes you added are added on the directory's
Mapped Attributes list.

7 After the directory is created, go to the Identity Stores page and select the directory.
8 Click Sync Settings > Mapped Attributes.

9 In the drop-down menu for the attributes that you added, select the Active Directory
attribute to map to.

10 Click Save.

Results

The directory is updated the next time the directory syncs to the Active Directory.
Applying the Default Access Policy
The Directories Management service includes a default access policy that controls user access to

their apps portals. You can edit the policy to change the policy rules as necessary.

When you enable authentication methods other than password authentication, you must edit the
default policy to add the enabled authentication method to the policy rules.

Each rule in the default access policy requires that a set of criteria be met in order to allow user
access to the apps portal. You apply a network range, select which type of user can access
content and select the authentication methods to use. See Managing Access Policies.

The number of attempts the service makes to login a user using a given authentication method
varies. The services only makes one attempt at authentication for Kerberos or certificate
authentication. If the attempt is not successful in logging in a user, the next authentication
method in the rule is attempted. The maximum number of failed login attempts for Active
Directory password and RSA SecurlD authentication is set to five by default. When a user has
five failed login attempts, the service attempts to log in the user with the next authentication
method on the list. When all authentication methods are exhausted, the service issues an error
message.

Apply Authentication Methods to Policy Rules

Only the password authentication method is configured in the default policy rules. You must edit
the policy rules to select the other authentication methods you configured and set the order in
which the authentication methods are used for authentication.

Prerequisites

Enable and configure the authentication methods that your organization supports. See
Integrating Alternative User Authentication Products with Directories Management
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Procedure

1 Select Administration > Directories Management > Policies

2 Click the default access policy to edit.

3 To edit a policy rule, click the authentication method to edit in the Policy Rules,

Authentication Method column.

The add a new policy rule, click the + icon.

4 Click Save and click Save again on the Policy page.

Edit Policy Rule

If a user's Network Range is...

and the user is trying to access content from...

then the user must authenticate using the following method...

Password E| and E|

If preceding Authentication Method fails, then:

-Select Authentication Method- E|

- fallback Method(s) S

Re-authenticate after: 851 | hours

0 =1

5 Click Save and click Save again on the Policy page.

Configuring Kerberos for Directories Management

Kerberos authentication provides users who are successfully signed in to their Active Directory
domain to access their apps portal without additional credential prompts. You enable Windows
authentication to allow the Kerberos protocol to secure interactions between users' browsers

and the Directories Management service. You do not need to directly configure Active Directory

to make Kerberos function with your deployment.

Currently, interactions between a user's browser and the service are authenticated by Kerberos

on the Windows operating systems only. Accessing the service from other operating systems
does not take advantage of Kerberos authentication.

m  Configure Kerberos Authentication

To configure the Directories Management service to provide Kerberos authentication, you

must join to the domain and enable Kerberos authentication on the Directories Management

connector.

m  Configure Internet Explorer to Access the Web Interface

You must configure the Internet Explorer browser if Kerberos is configured for your
deployment and if you want to grant users access to the Web interface using Internet

Explorer.
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m  Configure Firefox to Access the Web Interface
You must configure the Firefox browser if Kerberos is configured for your deployment and
you want to grant users access to the Web interface using Firefox.

m  Configure the Chrome Browser to Access the Web Interface

You must configure the Chrome browser if Kerberos is configured for your deployment and
if you want to grant users access to the Web interface using the Chrome browser.

Configure Kerberos Authentication
To configure the Directories Management service to provide Kerberos authentication, you must

join to the domain and enable Kerberos authentication on the Directories Management
connector.

Procedure

1 As atenant administrator, navigate to Administration > Directories Management >
Connectors

2 On the Connectors page, for the connector that is being configured for Kerberos
authentication, click Join Domain.

3 On the Join Domain page, enter the information for the Active Directory domain.

Option Description

Domain Enter the fully qualified domain name of the Active Directory. The domain name you enter must be
the same Windows domain as the connector server.

Domain User Enter the user name of an account in the Active Directory that has permissions to join systems to
that Active Directory domain.

Domain Enter the password associated with the AD Username. This password is not stored by Directories
Password Management
Click Save.

The Join Domain page is refreshed and displays a message that you are currently joined to
the domain.

4 In the Worker column for the connector click Auth Adapters.
5 Click KerberosldpAdapter
You are redirected to the identity manager sign in page.

6 Click Edit in the KerberosldpAdapter row and configure the Kerberos authentication page.

Option Description
Name A name is required. The default name is KerberosldpAdapter. You can change this.

Directory UID Enter the account attribute that contains the user name.
Attribute

VMware, Inc. 149



Configuring vRealize Automation

Option Description
Enable Select this to extend authentication interactions between users' browsers and Directories
Windows Management.

Authenticatio
n

Enable NTLM Select this to enable NT LAN Manager (NTLM) protocol-based authentication only if your Active
Directory infrastructure relies on NTLM authentication.

Enable Select this if round-robin DNS and load balancers do not have Kerberos support. Authentication
Redirect requests are redirected to Redirect Host Name. If this is selected, enter the redirect host name in
Redirect Host Name text box. This is usually the hostname of the service.

7 Click Save.

What to do next

Add the authentication method to the default access policy. Navigate to Administration >
Directories Management > Policies and click Edit Default Policy to edit the default policy rules to
add the Kerberos authentication method to the rule in the correct authentication order.

Configure Internet Explorer to Access the Web Interface
You must configure the Internet Explorer browser if Kerberos is configured for your deployment
and if you want to grant users access to the Web interface using Internet Explorer.

Kerberos authentication works in conjunction with Directories Management on Windows
operating systems.

Note Do not implement these Kerberos-related steps on other operating systems.

Prerequisites

Configure the Internet Explorer browser for each user or provide users with the instructions after
you configure Kerberos.

Procedure
1 Verify that you are logged into Windows as a user in the domain.
2 InInternet Explorer, enable automatic log in.

a Select Tools > Internet Options > Security.

b Click Custom level.

c Select Automatic login only in Intranet zone.

d Click OK.
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3 Verify that this instance of the connector virtual appliance is part of the local intranet zone.

a

Use Internet Explorer to access the Directories Management sign in URL at https.//
myconnectorhost.domain/authenticate/.

Locate the zone in the bottom right corner on the status bar of the browser window.

If the zone is Local intranet, Internet Explorer configuration is complete.

4 |If the zone is not Local intranet, add the Directories Management sign in URL to the intranet

zone.
a Select Tools > Internet Options > Security > Local intranet > Sites.
b Select Automatically detect intranet network.
If this option was not selected, selecting it might be sufficient for adding the to the
intranet zone.
c (Optional) If you selected Automatically detect intranet network, click OK until all dialog
boxes are closed.
d In the Local Intranet dialog box, click Advanced.
A second dialog box named Local intranet appears.
e Enter the Directories Management URL in the Add this Web site to the zone text box.
https.//myconnectorhost.domain/authenticate/
f  Click Add > Close > OK.
5 Verify that Internet Explorer is allowed to pass the Windows authentication to the trusted
site.
a In the Internet Options dialog box, click the Advanced tab.
b Select Enable Integrated Windows Authentication.

C

This option takes effect only after you restart Internet Explorer.

Click OK.

6 Loginto the Web interface to check access.

If Kerberos authentication is successful, the test URL goes to the Web interface.

Results

The Kerberos protocol secures all interactions between this Internet Explorer browser instance

and Directories Management. Now, users can use single sign-on to access their My Apps portal.
Configure Firefox to Access the Web Interface
You must configure the Firefox browser if Kerberos is configured for your deployment and you

want to grant users access to the Web interface using Firefox.

Kerberos authentication works in conjunction with Directories Management on Windows
operating systems.

VMware, Inc.

151



Configuring vRealize Automation

Prerequisites

Configure the Firefox browser, for each user, or provide users with the instructions, after you
configure Kerberos.

Procedure

1 Inthe URL text box of the Firefox browser, enter about:config to access the advanced
settings.

2 Click I'll be careful, | promise!.

3 Double-click network.negotiate-auth.trusted-uris in the Preference Name column.

4 Enter your Directories Management URL in the text box.
https.//myconnectorhost.domain.com

5 Click OK.

6 Double-click network.negotiate-auth.delegation-uris in the Preference Name column.

7 Enter your Directories Management URL in the text box.
https://myconnectorhost.domain.com/authenticate/

8 Click OK.

9 Test Kerberos functionality by using the Firefox browser to log in to login URL. For example,
https.//myconnectorhost.domain.com/authenticate/.

If the Kerberos authentication is successful, the test URL goes to the Web interface.

Results

The Kerberos protocol secures all interactions between this Firefox browser instance and
Directories Management. Now, users can use single sign-on access their My Apps portal.
Configure the Chrome Browser to Access the Web Interface

You must configure the Chrome browser if Kerberos is configured for your deployment and if

you want to grant users access to the Web interface using the Chrome browser.
Kerberos authentication works in conjunction with Directories Management on Windows
operating systems.

Note Do not implement these Kerberos-related steps on other operating systems.

Prerequisites
m  Configure Kerberos.

m  Since Chrome uses the Internet Explorer configuration to enable Kerberos authentication, you
must configure Internet Explorer to allow Chrome to use the Internet Explorer configuration.
See Google documentation for information about how to configure Chrome for Kerberos
authentication.

VMware, Inc. 152



Configuring vRealize Automation

Procedure
1 Test Kerberos functionality by using the Chrome browser.
2 Login to Directories Management at https.//myconnectorhost.domain.com/authenticate/.

If Kerberos authentication is successful, the test URL connects with the Web interface.

Results

If all related Kerberos configurations are correct, the relative protocol (Kerberos) secures all
interactions between this Chrome browser instance and Directories Management. Users can use
single sign-on access their My Apps portal.

Upgrading External Connectors for Directories Management

If you use an external connector with your vRealize Automation Directories Management
configuration, you may need to upgrade this connector on occasion.

You may need to upgrade an external connector when upgrading the version of your vRealize
Automation deployment or if a new connector build offers a feature you want.

This documentation applies only to users who have deployed additional, stand-alone external
connector appliances. In vRealize Automation, external connector appliances are used with smart
card authentication, for instance.

By default, the connector uses the VMware Web site for the upgrade procedure, which requires
the connector appliance to have Internet connectivity. You must also configure proxy server
settings for the connector appliance, if applicable.

If your connector instance does not have an Internet connection, you can perform the upgrade
offline. For an offline upgrade, you download the upgrade package and set up a local Web
server to host the upgrade file.

Intended Audience

This information is intended for anyone who installs, upgrades, and configures Directories
Management. The information is written for experienced Windows or Linux system administrators
who are familiar with virtual machine technology.

Preparing to Upgrade an External Connector

To prepare for a connector upgrade, you must check for available upgrades and configuring the
proxy server settings for the appliance, if applicable.

m  Check Availability of an External Connector Upgrade Online

If your connector appliance has Internet connectivity, you can check for the availability of
upgrades online from the appliance.
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m  Configure Proxy Server Settings for the External Connector Appliance

The connector appliance accesses the VMware update servers through the Internet. If your
network configuration provides Internet access using an HTTP proxy, you must adjust the
proxy settings for the appliance.

Check Availability of an External Connector Upgrade Online

If your connector appliance has Internet connectivity, you can check for the availability of
upgrades online from the appliance.

Procedure
1 Loginto the connector appliance as the root user.

2 Run the following command.
/usr/local/horizon/update/updatemgr.hzn updateinstaller

3 Run the following command to check for an online upgrade.
/usr/local/horizon/update/updatemgr.hzn check

Configure Proxy Server Settings for the External Connector Appliance

The connector appliance accesses the VMware update servers through the Internet. If your
network configuration provides Internet access using an HTTP proxy, you must adjust the proxy
settings for the appliance.

Enable your proxy to handle only Internet traffic. To ensure that the proxy is set up correctly, set
the parameter for internal traffic to no-proxy within the domain.

Note Proxy servers that require authentication are not supported.

Prerequisites
m  Verify that you have the root password for the connector appliance.

m  Verify that you have the proxy server information.

Procedure

-

Log in to the connector appliance as the root user.

Enter YaST on the command line to run the YaST utility.

Select Network Services in the left pane, then select Proxy.

Enter the proxy server URLs in the HTTP Proxy URL and HTTPS Proxy URL fields.

Select Finish and exit the YaST utility.

o u h~ W N

Restart the Tomcat server on the connector virtual appliance to use the new proxy settings.

service horizon-workspace restart
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Results

The VMware update servers are now available to the connector appliance.

Upgrade an External Connector Online

You can upgrade a Directories Management external connector online if you have an appropriate
connection.

Prerequisites

Verify that the connector appliance can resolve and reach vapp-updates.vmware.com on
port 80 over HTTP.

Confirm that a connector upgrade exists. Run the appropriate command to check for
upgrades. See Check for the Availability of a Directories Management Connector Upgrade
Online.

Verify that at least 2 GB of disk space is available on the primary root partition of the
appliance.

Verify that the connector is properly configured.

Take a snapshot of your connector appliance to back it up. For information about how to
take snapshots, see the vSphere documentation.

If an HTTP proxy server is required for outbound HTTP access, configure the proxy server
settings for the connector appliance. See Configure Proxy Server Settings for the Directories
Management Connector Appliance.

Procedure
1 Login to the connector appliance as the root user.
2 Run the following command.
/usr/local/horizon/update/updatemgr.hzn updateinstaller
3 Run the following command to check that on online upgrade exists.
/usr/local/horizon/update/updatemgr.hzn check
4 Run the following command to update the appliance.
/usr/local/horizon/update/updatemgr.hzn update
Messages that occur during the upgrade are saved to the update.log file at /opt/
vmware/var/log/update. log.
5 Run the updatemgr.hzn check command again to verify that a newer update does not exist.

/usr/local/horizon/update/updatemgr.hzn check
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Check the version of the upgraded appliance.

vamicli version —-appliance

The new version is displayed.
Restart the connector appliance.

reboot

Upgrade an External Connector Offline

If your existing vRealize Automation Directories Management connector appliance cannot
connect to the Internet for upgrade, you can perform an offline upgrade. You must set up an
upgrade repository on a local Web server and configure the connector appliance to use the local
Web server for upgrade.

Prerequisites

Confirm that a connector upgrade exists. Check the My VMware Downloads site at
my.vmware.com for upgrades.

Verify that at least 2 GB of disk space is available on the primary root partition of the
appliance.

Verify that the connector is properly configured.

Take a shapshot of your connector appliance to back it up. For information about how to
take snapshots, see the vSphere documentation.

Configure the connector appliance to user a local Web server to host the upgrade file. See
Prepare a Local Web Server for Offline Upgrade.

Procedure

Prepare a Local Web Server for Offline Upgrade

Before you start the offline connector upgrade, prepare the local Web server by creating a
directory structure that includes a subdirectory for the connector appliance.

Configure the Connector and Perform Offline Upgrade

Configure the connector appliance to point to the local Web server to perform an offline
upgrade. Then upgrade the appliance.

Prepare a Local Web Server for Offline Upgrade

Before you start the offline connector upgrade, prepare the local Web server by creating a
directory structure that includes a subdirectory for the connector appliance.

VMware, Inc. 156


http://my.vmware.com

Configuring vRealize Automation

Prerequisites

m  Download the identity-manager—connector-versionNumber-buildNumber-updaterepo.zip
file from My VMware. Go to my.vmware.com, navigate to the VMware ldentity Manager
Download page, and download the file listed under VMware Identity Manager Connector
offline upgrade package.

m If you use an lIS Web server, configure the Web server to allow special characters in file
names. You configure this in the Request Filtering section by selecting the Allow double
escaping option.

Procedure

1 Create a directory on the Web server at http://YourWebServer/VVM/ and copy the
downloaded zip file to it.

2 Verify that your Web server includes mime types for .sig (text/plain) and .sha256 (text/
plain).

Without these mime types your Web server fails to check for updates.
3  Unzip the file.
The contents of the extracted ZIP file are served by http://YourWebServer/VM/.

The extracted contents of the file contain the following subdirectories: /manifest and /
package-pool.

4 Run the following updatelocal.hzn command to check that the URL has valid update
contents.

/usr/local/horizon/update/updatelocal.hzn checkurl http://YourWebServer/VM

Configure the Connector and Perform Offline Upgrade

Configure the connector appliance to point to the local Web server to perform an offline
upgrade. Then upgrade the appliance.

Prerequisites

Prepare a local Web server for offline upgrade.

Procedure

1 Login to the connector appliance as the root user.
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2 Run the following command to configure an upgrade repository that uses a local Web server.

/usr/local/horizon/update/updatelocal.hzn seturl http://YourWebServer/VM/

Note To undo the configuration and restore the ability to perform an online upgrade, you
can run the following command.

/usr/local/horizon/update/updatelocal.hzn setdefault

3 Perform the upgrade.

a Run the following command.
/usr/local/horizon/update/updatemgr.hzn updateinstaller

b Run the following command to check the version of the available upgrade.
/usr/local/horizon/update/updatemgr.hzn check

¢ Run the following command to update the connector.
/usr/local/horizon/update/updatemgr.hzn update

Messages that occur during the upgrade are saved to the update.log file at /opt/
vmware/var/log/update.log.

d Run the updatemgr.hzn check command again.
/usr/local/horizon/update/updatemgr.hzn check

e Check the version of the upgraded appliance.
vamicli version —-appliance

The command should display the new version.
f Restart the connector appliance.
For example, from the command line run the following command.
reboot
Results

The connector upgrade is complete.

Configuring Settings After Upgrading an External Connector

After upgrading to connector 2016.3.1.0 or later, you may need to configure some settings.
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Rejoin Domain with Kerberos Authentication

If you use Kerberos authentication or Active Directory (Integrated Windows Authentication)
directories, you must leave the domain and then rejoin it. This is required for all the connector
virtual appliances in your deployment.

1
2

5

Select Administration > Directories Management > Connectors

In the Connectors page, for each connector that is being used for Kerberos authentication or
an Active Directory (Integrated Windows Authentication) directory, click Leave Domain.

To join the domain, you need Active Directory credentials with the privileges to join the
domain. See Join a Connector Machine to a Domain for more information.

If you are using Kerberos authentication, enable the Kerberos authentication adapter again.
To access the Auth Adapters page, in the Connectors page click the appropriate link in the
Worker column and select the Auth Adapters tab.

Verify that the other authentication adapters you are using are enabled.

Update Domains Page

If you are using Active Directory (Integrated Windows Authentication), or Active Directory over
LDAP with the This Directory supports DNS Service Location option enabled, save the
directory's Domains page.

1

2
3
4
5

Select Administration > Directories Management > Directories

Select the applicable directory to edit it.

Provide the password for the Bind DN user and click Save.

Click Sync Settings on the left of the page and select the Domains tab.

Click Save.

DNS Service Location and Domain Controllers

Note In connector 2016.3.1.0 and later, a domain_krb.properties file is automatically created

and auto-populated with domain controllers when a directory with DNS Service Location enabled
is created. When you save the Domains page after upgrade, if you had a
domain_krb.properties file in your original deployment, the file is updated with domains that

you may have added subsequently and that were not in the file. If you did not have a
domain_krb.properties file in your original deployment, the file is created and auto-populated

with domain controllers. See About Domain Controller Selection for more information about the
domain_krb.properties file.

Troubleshooting External Connector Upgrade Errors

You can troubleshoot VRA Directories Management external connector upgrade problems by
reviewing the error logs. If the connector does not start, you can revert to a previous instance by
rolling back to a snapshot.
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m  Checking the Upgrade Error Logs

Resolve errors that occur during upgrade by reviewing the error logs. Upgrade log files are
in the /opt/vmware/var/log directory.

m  Rolling Back to Snapshots of Connector

If the connector does not start properly after an upgrade, and you cannot resolve the
problem by reviewing the upgrade error logs and running the upgrade command again, you
can roll back to a previous connector instance.

m  Collecting a Log File Bundle

You can collect a bundle of log files to send to VMware support. You obtain the bundle from
the connector configuration page.

Checking the Upgrade Error Logs

Resolve errors that occur during upgrade by reviewing the error logs. Upgrade log files are in
the /opt/vmware/var/log directory.

If any errors occurred, the connector may not start after upgrade.

Procedure

1 Login to the connector appliance.

2 Go tothe /opt/vmware/var/log directory.

3 Open the update. log file and review the error messages.

4 Resolve the errors and rerun the upgrade command. The upgrade command resumes from
the point where it stopped.

Note Alternatively, you can revert to a snapshot and run the update again.

Rolling Back to Snapshots of Connector

If the connector does not start properly after an upgrade, and you cannot resolve the problem
by reviewing the upgrade error logs and running the upgrade command again, you can roll back
to a previous connector instance.

Procedure

¢ Revert to one of the snapshots you took as a backup of your original connector instance. For
information, see the vSphere documentation.

Collecting a Log File Bundle

You can collect a bundle of log files to send to VMware support. You obtain the bundle from the
connector configuration page.

The following log files are collected in the bundle.
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Table 2-9. Log Files

Component

Apache Tomcat Logs
(catalina.log)

Configurator Logs
(configurator.log)

Connector Logs
(connector.log)

Procedure

Location of Log File

/opt/vmware/horizon/workspace/logs/
catalina.log

/opt/vmware/horizon/workspace/logs/
configurator.log

/opt/vmware/horizon/workspace/logs/
connector.log

Description

Apache Tomcat records messages that
are not recorded in other log files.

Requests that the Configurator
receives from the REST client and the
Web interface.

A record of each request received
from the Web interface. Each log entry
also includes the request URL,
timestamp, and exceptions. No sync
actions are recorded.

1 Login to the connector configuration page at https://connectorURL:8443/cfg/logs.

2 Click Prepare log bundle.

3 Download the bundle and send it to VMware support.

Scenario: Configure an Active Directory Link for a Highly Available
VRealize Automation

As a tenant administrator, you want to configure an Active Directory over LDAP directory
connection to support user authentication for your highly available vRealize Automation

deployment.

Each vRealize Automation appliance includes a connector that supports user authentication,
although only one connector is typically configured to perform directory synchronization. It does
not matter which connector you choose to serve as the sync connector. To support Directories
Management high availability, you must configure a second connector that corresponds to your
second vRealize Automation appliance, which connects to your Identity Provider and points to
the same Active Directory. With this configuration, if one appliance fails, the other takes over
management of user authentication.

In a high availability environment, all nodes must serve the same set of Active Directories, users,
authentication methods, etc. The most direct method to accomplish this is to promote the
Identity Provider to the cluster by setting the load balancer host as the Identity Provider host.
With this configuration, all authentication requests are directed to the load balancer, which
forwards the request to either connector as appropriate.

Prerequisites

m Install a distributed vRealize Automation deployment with appropriate load balancers. See
Installing vRealize Automation.

m  Login to vRealize Automation as a tenant administrator.
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Procedure
1 Select Administration > Directories Management > Directories.
2 Click Add Directory.

3 Enter your specific Active Directory account settings, and accept the default options.

Option Sample Input
Directory Name Add the IP address of your active directory domain name.
Sync Connector Every vRealize Automation appliance contains a connector. Use any of the

available connectors.

Base DN Enter the Distinguished Name (DN) of the starting point for directory server
searches. For example, cn=users,dc=corp,dc=local.

Bind DN Enter the full distinguished name (DN), including common name (CN), of an
Active Directory user account that has privileges to search for users. For
example, cn=config_admin infra,cn=users,dc=corp,dc=local.

Bind DN Password Enter the Active Directory password for the account that can search for
users.
4 Click Test Connection to test the connection to the configured directory.

If the connection fails, check your entries in all fields and consult your system administrator if
necessary.

5 Click Save & Next.
The Select the Domains page with the list of domains appears.
6 Leave the default domain selected and click Next.

7 Verify that the attribute names are mapped to the correct Active Directory attributes. If not,
select the correct Active Directory attribute from the drop-down menu. Click Next.

8 Select the groups and users you want to sync.

a Click the Add icon (%),

b Enter the user domain and click Find Groups.
For example, cn=users,dc=corp,dc=local.

c Select the Select All check box.

d Click Select.

e Click Next.
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9

Click ¥ to add additional users. For example, enter as
CN-username,CN=Users,0U-myUnit,DC=myCorp,DC=com.

To exclude users, click + to create a filter to exclude some types of users. You select the
user attribute to filter by, the query rule, and the value.

Click Next.

9 Review the page to see how many users and groups are syncing to the directory and click
Sync Directory.

The directory sync process takes some time, but it happens in the background and you can
continue working.

10 Configure a second connector to support high availability.

a

f

9

Results

Log in to the load balancer for your vRealize Automation deployment as a tenant
administrator.

The load balancer URL is load balancer address/vcac/org/tenant_name.
Select Administration > Directories Management > Identity Providers.
Click the Identity Provider that is currently in use for your system.

The existing directory and connector that provide basic identity management for your
system appears.

Click the Add a Connector drop-down list, and select the connector that corresponds to
your secondary VRealize Automation appliance.

Enter the appropriate password in the Bind DN Password text box that appears when
you select the connector.

Click Add Connector.

Edit the host name to point to your load balancer.

You connected your corporate Active Directory to vRealize Automation and configured
Directories Management for high availability.

What to do next

To provide enhanced security, you can configure bi-directional trust between your identity
provider and your Active Directory. See Configure a Bi Directional Trust Relationship Between
VRealize Automation and Active Directory.
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Configure External Connectors for Smart Card and Third-party
Identity Provider Authentication in vRealize Automation

A system administrator must configure an external connector for your vRealize Automation
deployment using Directories Management if you are using third party identity providers such as
Keberos or smart card authentication.

Directories Management supports multiple identity providers and connector clusters for each
configured Active Directory. To use a third-party identity provider or smart card authentication,
you can set up either a single external connector or a connector cluster with an appropriate
identity provider behind a load balancer that permits SSL passthrough. See Managing Connectors
and Connector Clusters for more information.

See Upgrading External Connectors for Directories Management for information about updating
an external connector.

There are various certificate configuration options available for use with smart card
authentication. See Configuring a Certificate or Smart Card Adapter for Use with Directories
Management .

Prerequisites

m  Configure an appropriate Active Directory connection for use with your vRealize Automation
deployment.

m  Download the OVA file required to configure a connector from VMware vRealize Automation
Tools and SDK.

m  Login to vRealize Automation as a tenant administrator.

Procedure

1 Generate a Connector Activation Token
Before you deploy the connector virtual appliance to use for smart card authentication,
generate an activation code for the new connector from the vRealize Automation console.
The activation code is used to establish communication between Directories Management
and the connector.

2 Deploy the Connector OVA File
After downloading a connector OVA file, you can deploy it using the VMware vSphere Client
or vSphere Web Client.

3 Configure Connector Settings
After deploying the connector OVA, you must run the Setup wizard to activate the
appliance and configure the administrator passwords.

4 Apply Public Certificate Authority

When Directories Management is installed, a default SSL certificate is generated. You can
use the default certificate for testing purposes, but you should generate and install
commercial SSL certificates for production environments.
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5 Create a Workspace Identity Provider

You must create a Workspace identity provider for use with an external connector.

6 Configure Certificate Authentication and Configure Default Access Policy Rules

You must configure your external connection for use with your vRealize Automation Active
Directory and domain.
Generate a Connector Activation Token

Before you deploy the connector virtual appliance to use for smart card authentication, generate
an activation code for the new connector from the vRealize Automation console. The activation
code is used to establish communication between Directories Management and the connector.

You can configure a single connector or a connector cluster. If you want to use a connector
cluster, repeat this procedure for each connector that you need.

Prerequisites

m  Login to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Directories Management > Connectors
2 Type a name for the new connector in the Connector ID Name text box.
3 Press Enter.
The activation code for the connector is displayed in the Connector Activation Code box.

4 Copy the activation code for use in configuring the connector using the OVA file.

Deploy the Connector OVA File

After downloading a connector OVA file, you can deploy it using the VMware vSphere Client or
vSphere Web Client.

You deploy the OVA file using the vSphere Client or the vSphere Web Client.

Prerequisites
m Identify the DNS records and host name to use for your connector OVA deployment.

m If using the vSphere Web Client, use either Firefox or Chrome browsers. Do not use Internet
Explorer to deploy the OVA file.

s Download the OVA file required to configure a connector from VMware vRealize Automation
Tools and SDK.

Procedure

1 Inthe vSphere Client or the vSphere Web Client, select File > Deploy OVF Template.
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2 Inthe Deploy OVF Template pages, enter the information specific to your deployment of the

connector.
Page Description
Source Browse to the OVA package location, or enter a specific URL.

OVA Template Details
License

Name and Location

Host / Cluster
Resource Pool
Storage

Disk Format

Network Mapping

Properties

Ready to Complete

Verify that you selected the correct version.
Read the End User License Agreement and click Accept.

Enter a name for the virtual appliance. The name must be unique within the
inventory folder and can contain up to 80 characters. Names are case
sensitive.

Select a location for the virtual appliance.

Select the host or cluster to run the deployed template.
Select the resource pool.

Select the location to store the virtual machine files.

Select the disk format for the files. For production environments, select a
Thick Provision format. Use the Thin Provision format for evaluation and
testing.

Map the networks in your environment to the networks in the OVF template.

In the Timezone setting field, select the correct time zone.

b  The Customer Experience Improvement Program checkbox is selected
by default. VMware collects anonymous data about your deployment in
order to improve VMware's response to user requirements. Deselect the
checkbox if you do not want the data collected.

¢ Inthe Host Name text box, enter the host name to use. If this is blank,
reverse DNS is used to look up the host name.

d To configure the static IP address for connector, enter the address for
each of the following: Default Gateway, DNS, IP Address, and Netmask.

Important If any of the four address fields, including Host Name, are left
blank, DHCP is used.

To configure DHCP, leave the address fields blank.

Review your selections and click Finish.

Depending on your network speed, the deployment can take several minutes. You can view
the progress in the progress dialog box.

3 When the deployment is complete, select the appliance, right-click, and select Power >

Power on.

The appliance is initialized. You can go to the Console tab to see the details. When the virtual
appliance initialization is complete, the console screen displays the version and URLs to log in
to the Setup wizard to complete the set up.

What to do next

Use the Setup wizard to add the activation code and administrative passwords.
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Configure Connector Settings

After deploying the connector OVA, you must run the Setup wizard to activate the appliance and
configure the administrator passwords.

Prerequisites

You have generated an activation code for the connector.
Ensure the connector appliance is powered on and you know the connector URL.

Collect a list of password to use for the connector administrator, root account, and sshuser
account.

Procedure

1

To run the Setup wizard, enter the connector URL that was displayed in the Console tab after
the OVA was deployed.

On the Welcome Page, click Continue.

Create strong passwords for the following connector virtual appliance administrator
accounts.

Strong passwords should be at least eight characters long and include uppercase and
lowercase characters and at least one digit or special character.

Option Description

Appliance Administrator Create the appliance administrator password. The user name is admin and
cannot be changed. You use this account and password to log in to the
connector services to manage certificates, appliance passwords and syslog
configuration.

Important The admin user password must be at least 6 characters in
length.

Root Account A default VMware root password was used to install the connector
appliance. Create a new root password.

sshuser Account Create the password to use for remote access to the connector appliance.

Click Continue.
On the Activate Connector page, paste in the activation code and click Continue.

If you are using a self-signed certificate on the vRealize Automation internal connector, you
can get the appropriate certificate by running the following command on the vRealize
Automation appliance: cat /etc/apache2/server-cert.pem

Select the Terminate SSL on a Load Balancer tab, and then click the link for /
horizon_workspace_rootca.pem.

The activation code is verified and communication between the service and the connector
instance is established to complete the connector configuration.
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What to do next

In the service, set up your environment based on your needs. For example, if you added an
additional connector because you want to sync two Integrated Windows Authentication
directories, create the directory and associate it with the new connector.

Apply Public Certificate Authority

When Directories Management is installed, a default SSL certificate is generated. You can use the

default certificate for testing purposes, but you should generate and install commercial SSL
certificates for production environments.

If the Directories Management points to a load balancer, the SSL certificate is applied to the load

balancer.
You must check the Mark this key as exportable when importing a certificate.

You only need to specify the CN, or certificate authority's site domain name, if you are
generating a CSR for a custom certificate.

Prerequisites

Generate a Certificate Signing Request (CSR) and obtain a valid, signed certificate from a CA. If

your organization provides SSL certificates that are signed by a CA, you can use these
certificates. The certificate must be in the PEM format.

Procedure

1 Login to the connector appliance administrative page as an admin user at the following
location:

https://myconnector.mycompany:8443/cfg
2 In the administrator console, click Appliance Settings.
VA Configuration is selected by default.
Click Manage Configurations.
Enter the VMware Identify Manager server admin user password.
Select Install Certificate.

In the Terminate SSL on the Identity Manager Appliance tab, select Custom Certificate.

N o u b~ W

that order.

The SSL certificate works only if you include the entire certificate chain in the correct order.

For each certificate, copy everything between and including the lines ----- BEGIN
CERTIFICATE----- and ----- END CERTIFICATE----

Ensure that the certificate includes the FQDN hostname.

8 Paste the private key in the Private Key text box. Copy everything between ----BEGIN RSA

PRIVATE KEY and ---END RSA PRIVATE KEY.
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9 Click Save.

Example: Certificate Examples

Certificate Chain Example

JIQVtOWARIVpg3WQT5+C3HUT17bUOWVhp/rO+

W53+005j5xsxzDJfWrllgBIFF/OkIYCPcyK1

WdR9Vpg3WQT5+C3HU17bUOwWVhp/rjlQvt90+

005j5xsxzDJfWrllgBIFF/OklYCPW53+cyK1

dRIVpPY3WQT)IQVtOWS5E+C3HUT7bUOWVhp/rO+

5j5xsxzDJfWrllgW53+0O0BIFF/OklYCPcyK1

jlQVtg3WQTS+C3HU17bUIWARIVpOWVhp/rO+

11laBIFFW53+005j5xsxzDJfWr/OklYCPcyK1

Create a Workspace Identity Provider

You must create a Workspace identity provider for use with an external connector.

Prerequisites

m  Login to vRealize Automation as a tenant administrator.
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Procedure

1 Select Administration > Directories Management > Identity Providers.

2 Select Add Identity Provider.

3 Select Create Workspace IDP on the displayed menu.

4 Type a name for the identity provider in the Identity Provider Name field.

5 Select the directory that corresponds to the users that will use this identity provider.
The directory selected determine which connectors are displayed for selection with this
identity provider.

6 Select the external connector or connectors that you configured for smart card
authentication.

Note If the deployment is located behind a load balancer, enter the load balancer URL.

7 Select the network for access to this identity provider.

8 Click Add.

Configure Certificate Authentication and Configure Default Access Policy Rules

You must configure your external connection for use with your vRealize Automation Active
Directory and domain.

Prerequisites

Log in to vRealize Automation as a tenant administrator.

Procedure

1 Select Administration > Directories Management > Connectors.

2 Select the Desired connector in the Worker column.
The selected worker is shown in the Worker Name text box on the Connector Detail tab and
connector type information appears in the Connector Type text box.

3 Ensure that the connector is linked to the desired Active Directory by specifying that
Directory in the Associated Directory text box.

4 Enter the appropriate domain name in the Associated Domains text box.

5 Select the AuthAdapters tab and enable CertificateAuthAdapter.

6 Configure certificate authentication as appropriate for your deployment.
See Configure Certificate Authentication for Directories Management.

7 Select Administration > Directories Management > Policies.

8 Click Edit Default Policy.
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9 Add Certificate to the policy rules and make it the first authentication method.

Certificate must be the first authentication method listed in the policy rule, otherwise
certificate authentication fails.

Create a Multi Domain or Multi Forest Active Directory Link

As a system administrator, you need to configure a multi domain or multi forest Active Directory
link.

The procedure for configuring a multi domain or multi forest Active Directory link is essentially
the same. For a multi forest link, bi-directional trust is required between all applicable domains.

Prerequisites

Install a distributed vRealize Automation deployment with appropriate load balancers. See
Installing vRealize Automation.

Log in to vRealize Automation as a tenant administrator.

Configure the appropriate domains and Active Directory forests for your deployment.

Procedure
1 Select Administration > Directories Management > Directories.
2 Click Add Directory.
3 On the Add Directory page, specify a name for the Active Directory server in the Directory
Name text box.
4 Select Active Directory (Integrated Windows Authentication) under the Directory Name
heading.
5 Configure the connector that synchronizes users from the Active Directory to the VMware
Directories Management directory in the Directory Sync and Authentication section.
Option Description
Sync Connector Select the appropriate connector to use for your system. Each vRealize
Automation appliance contains a default connector. Consult your system
administrator if you need help in choosing the appropriate connector.
Authentication Click the appropriate radio button to indicate whether the selected
connector also performs authentication.
Directory Search Attribute Select the appropriate account attribute that contains the user name.
Depending on your deployment configuration, you will have one or more connectors
available for use.
6 Enter the appropriate join domain credentials in the Domain Name, Domain Admin User

Name, and Domain Admin Password text boxes.

As an example, you might enter something like the following: Domain Name: hs.trcint.com,

Domain Admin Username: devadmin, Domain Admin Password: xxxx.
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10
1

12

13

14

15

16

In the Bind User Details section, enter the appropriate Active Directory (Integrated Windows
Authentication) credentials to facilitate directory synchronization.

Option Description

Bind User UPN Enter the User Principal Name of the user who can authenticate with the
domain. For example, UserName@example.com.

Bind DN Password Enter the Bind User password.

Click Save & Next.

The Select the Domains page appears with the list of domains.

Click the appropriate check boxes to select the desired domains for your system deployment.
Click Next.

Verify that the Directories Management directory attribute names are mapped to the correct
Active Directory attributes.

If the directory attribute names are mapped incorrectly, select the correct Active Directory
attribute from the drop-down menu.

Click Next.

Click ¥ to select the groups you want to sync from Active Directory to the directory.

When you add an Active Directory group, if members of that group are not in the Users list,
they are added.

Note The Directories Management user authentication system imports data from Active
Directory when adding groups and users, and the speed of the system is limited by Active
Directory capabilities. As a result, import operations may require a significant amount of time
depending on the number of groups and users being added. To minimize the potential for
delays or problems, limit the number of groups and users to only those required for vRealize
Automation operation. If your system performance degrades or if errors occur, close any
unneeded applications and ensure that your system has appropriate memory allocated to
Active Directory. If problems persist, increase the Active Directory memory allocation as
needed. For systems with large numbers of users and groups, you may need to increase the
Active Directory memory allocation to as much as 24 GB.

Click Next.

Click ¥ to add additional users. For example, enter as
CN-username,CN=Users,0U-myUnit,DC=myCorp,DC=com.

To exclude users, click “ to create a filter to exclude some types of users. You select the
user attribute to filter by, the query rule, and the value.

Click Next.
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17 Review the page to see how many users and groups are syncing to the directory.
If you want to make changes to users and groups, click the Edit links.

18 Click Push to Workspace to start the synchronization to the directory.

What to do next

Configuring Groups and User Roles

Tenant administrators create business groups and custom groups, and grant user access rights
to the vRealize Automation console.

Assign Roles to Directory Users or Groups

Tenant administrators grant access rights to users by assigning roles to users or groups.

To allow users or groups to modify and trigger a pipeline, you must assign permissions to those
users and groups. When you assign users and groups the role of Release Manager, they can
modify and trigger the pipeline. When you assign users and groups the role of Release Engineer,
they can trigger the pipeline. For more information, see the Using vRealize Code Stream guide.

Prerequisites

Log in to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Users & Groups > Directory Users & Groups.
2 Enter a user or group name in the Search box and press Enter.

Do not use an at sign (@), backslash (\), or slash (/) in a name. You can optimize your search
by typing the entire user or group name in the form user@domain.

3 Click the name of the user or group to which you want to assign roles.
4 Select one or more roles from the Add Roles to this User list.

The Authorities Granted by Selected Roles list indicates the specific authorities you are
granting.

5 (Optional) Click Next to view more information about the user or group.
6 On the User Details page, on the General tab, scroll the list of roles to add the user.

a To give the user permissions to modify and trigger a pipeline, select the Release Manager
check box.

b To give the user permissions to trigger a pipeline, select the Release Engineer check box.

7 Click Update.
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Results

Users who are currently logged in to the vRealize Automation must log out and log back in to the
vRealize Automation before they can navigate to the pages to which they have been granted
access.

What to do next

Optionally, you can create your own custom groups from users and groups in your Active
Directory connections. See Create a Custom Group.

Create a Custom Group

Tenant administrators can create custom groups by combining other custom groups, identity
store groups, and individual identity store users. Custom groups provide more granular control
over access within vRealize Automation than business groups which correspond to a line of
business, department, or other organizational unit.

Custom groups enable you to grant access rights for tasks on a finer basis than the standard
vRealize Automation group assignments. For instance, you may want to create a custom group
to allow tenant administrators to control who has specific permissions within the tenant.

You can assign roles to your custom group, but it is not necessary in all cases. For example, you
can create a custom group called Machine Specification Approvers, to use for all machine pre-
approvals. You can also create custom groups to map to your business groups so that you can
manage all groups in one place. In those cases, you do not need to assign roles.

Prerequisites

Log in to vRealize Automation as a tenant administrator.

Procedure

1 Select Administration > Users & Groups > Custom Groups.

2 Click the Add icon ().
3 Enter a group name in the New Group Name text box.

Custom group names cannot contain the combination of a semicolon (;) followed by an equal
sign (=).
4 (Optional) Enter a description in the New Group Description text box.

5 Select one or more roles from the Add Roles to this Group list.

The Authorities Granted by Selected Roles list indicates the specific authorities you are
granting.

6 Click Next.
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7 Add users and groups to create your custom group.
a Enter a user or group name in the Search box and press Enter.

Do not use an at sign (@), backslash (\), or slash (/) in a name. You can optimize your
search by typing the entire user or group name in the form user@domain.

b Select the user or group to add to your custom group.

8 Click Add.

Results

Users who are currently logged in to the vRealize Automation must log out and log back in to the
vRealize Automation before they can navigate to the pages to which they have been granted
access.

Add Just-in-Time Users with Custom Groups and Rules

You can add vRealize Automation users to a deployment without access to Active Directory
using just-in-time user provisioning. To invoke just-in-time provisioning for first time users, you
must create rules to populate the applicable custom group.

On initial log on, Just-in-time users are assigned group membership dynamically based on rules
that you create on the Advanced Group Membership wizard page. After initial log on, you can
assign group membership in the usual manner. This second page of this wizard contains four
selection boxes for creating rules based on a variety of criteria that define just-in-time users.

vmware' vRealize- Automation Welcome, fritz.  Preferences Help = Logout
Adminisiration Infrastructure vTravel

. Advanced Group Membership: memberOf@vsphere. local

Group Rules
Directery Users and Groups P
Match  Any |+ ofthe faollowing rules: 2 users have been found

Custom Groups

Memberor w  Matches w CN=suﬁa.0U=pa|:mar|.DC=vcal.DC=sqa-noriz,un.DC=Incal + x

Business Groups

Copyright & 2012-2017 YMware, Inc. All rights reserved,
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For instance, in the first rule selection box, you can select Domain as a criteria, and then select
Matches in the second box. Then, in the third rule box, you can enter a domain. These selections
create a rule that establishes just-in-time membership based users that are associated with the
specified domain. The third selection box is a free form entry box, and you can enter any
information that logically relates to the selections in the first two selection boxes.

Note You can create multiple rules to populate just-in time users based on a variety of criteria. If
you create multiple rules, you can use the Match rule selection box, located above the main rule
boxes, to indicate whether vRealize Automation should match any or all of the rules when
populating just-in-time users.

Procedure

1 Select Administration > Users & Groups > Custom Groups and create or locate an
appropriate custom group for the just-in-time users.

See Create a Custom Group for more information.
2 Click the Advanced Membership button.

You can add individual users on the page if desired.
3 Click Next to view the Group Rules page.

4 In the three main rule selection boxes, located below the Match rule selection box, click the
Down arrows and enter information to activate drop down menus that enable you to create
the desired rule.

5 Use the rule selection boxes to create one or more rules as appropriate for your user
configuration.

6 (Optional) If you create multiple rules, you can use the Match rule selection box to designate
how vRealize Automation handles the rules.

7 Click Next.

8 If you want to exclude users from the group, search for and add those users on the Exclude
Users from Group page.

9 Click Next.

10 Review the group configuration on the Review page, and then click Save to save and
implement your rules and configuration.

Results

Just-in-time users are added based on the rules that you created.

Create a Business Group

Business groups are used to associate a set of services and resources to a set of users. These
groups often correspond to a line of business, department, or other organizational unit. You
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create a business group so that you can configure reservations and entitle users to provision
service catalog items for the business group members.

To add multiple users to a business group role, you can add multiple individual users, or you can
add multiple users at the same time by adding an identity store group or a custom group to a
role. For example, you can create a custom group Sales Support Team and add that group to the
support role. You can also use existing identity store user groups. The users and groups you
choose must be valid in the identity store.

To support vCloud Director integration, the same business group members in the vRealize
Automation business group must also be members of the vCloud Director organization.

After a tenant administrator creates the business group, the business group manager has
permission to modify the manager email address and the members. The tenant administrator can
modify all the options.

This procedure assumes that laaS is installed and configured.

Prerequisites
m  Login to vRealize Automation as a tenant administrator.

= |f you want to add machines created by business group members to a particular Active
Directory organizational unit, configure the Active Directory policy. See Create an Active
Directory Policy. You can and apply the policy when you create the business group, or add it
later.

= |f you want to provide a default machine prefix for the group that is prepended to
provisioned machine names, request a prefix from a fabric administrator. See Configure
Machine Prefixes. Machine prefixes are not applicable to XaaS requests.

Procedure

1 Select Administration > Users and Groups > Business Groups.

2 Click the New icon ().

3 Configure the business group details.

Option Description

Name Enter the name for the business group.

Description Enter the description.

Send manager emails to Enter one or more email addresses of users that must receive capacity alert

notifications. Email alias addresses are not supported, each email addresses
must be for a specific user.

Separate multiple entries with a comma. For example,
JoeAdmin@mycompany . com,WeiMgr@mycompany . com.

Active Directory Policy Select the default Active Directory policy for the business group.

4 Add custom properties.
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5 Enter a user name or custom user group hame and press Enter.

You can add one or more individuals or custom user groups to the business group. You can
specify the users now or you can create empty business groups to populate later.

Option Description
Group manager role Can create entitlements and assign approval policies for the group.
Support role Can request and manage service catalog items on behalf of the other

members of the business group.

Shared access role Can use and run actions on the resources that other business group
members deploy.

User role Can request service catalog items to which they are entitled.

6 Click Next.

7 Configure default infrastructure options.

Option Description

Default machine prefix Select a preconfigured machine prefix for the business group.

This prefix is used by machine blueprints. If the blueprint is uses the default
prefix and you do not provide it here, a machine prefix is created based on
the business group name. The best practice is to provide a default prefix.
You can still configure blueprints with specific prefixes or allow service
catalog users to override it when they request a blueprint.

XaaSs blueprints do not use default machine prefixes. If you configure a
prefix here and entitle an Xaa$S blueprint to this business group, it does not
affect the provisioning of an XaaS machine.

Active Directory container Enter an Active Directory container. This option applies only to WIM
provisioning.
Other provisioning methods require extra configuration to join provisioned
machines to an AD container.

8 Click Add.

Results

Fabric administrators can allocate resources to your business group by creating a reservation.
Business group managers can create entitlements for members of the business group.

What to do next

m Create a reservation for your business group based on where the business group provisions
machines. See Choosing a Reservation Scenario.

m |f the catalog items are published and the services exist, you can create an entitlement for the
business group members. See Entitle Users to Services, Catalog Items, and Actions.
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Troubleshooting Slow Performance When Displaying Group Members

The business group or custom group members are slow to display when viewing a group's
details.

Problem

When you view user information in environments with a large number of users, the user names
are slow to load in the user interface.

Cause

The extended time required to load the names occurs in environments with a large Active
Directory environment.

Solution

¢ Toreduce the retrieval workload, use Active Directory groups or custom groups whenever
possible rather than adding hundreds of individual members by name.

Create Additional Tenants

As a system administrator, you can create additional vRealize Automation tenants so that users
can access the appropriate applications and resources that they need to complete their work
assignments.

A tenant is a group of users with specific privileges who work within a software instance.
Typically, a default vRealize Automation tenant is created during system installation and initial
configuration. After that, administrators can create additional tenants so that users can log in and
complete their work assignments. Administrators can create as many tenants as needed for
system operation. When creating tenants, administrators must specify basic configuration such
as name, login URL, local users, and administrators. After configuring basic tenant information,
the tenant administrator must log in and set up an appropriate Active Directory connection using
the Directories Management functionality on the Administrative tab of the vRealize Automation
console. In addition, tenant administrators can apply custom branding to tenants.

Prerequisites
Log in to the vRealize Automation console as a system administrator.

Procedure

1 (Optional) Specify Tenant Information
The first step to configuring a tenant is to name the new tenant and add it to vRealize
Automation and create the tenant-specific access URL.

2 (Optional) Configure Local Users

The vRealize Automation system administrator must configure local users for each
applicable tenant.
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3 (Optional) Appoint Administrators

You can appoint one or more tenant administrators and laaS administrators from the identity
stores you configured for a tenant.
Specify Tenant Information

The first step to configuring a tenant is to name the new tenant and add it to vRealize
Automation and create the tenant-specific access URL.

Prerequisites

Log in to the vRealize Automation console as a system administrator.

Procedure

1 Select Administration > Tenants.

2 Click the New icon (Ci').

3 Enter a name in the Name text box.

4 (Optional) Enter a description in the Description text box.

5 Enter a unique identifier for the tenant in the URL Name text box.

This URL token is used to append a tenant-specific identifier to the vRealize Automation
console URL.

For example, enter mytenant to create the URL https://vrealize-appliance-
hostname.domain.name/vcac/org/mytenant.

Note The tenant URL must use lowercase characters only in vRealize Automation 7.0 and
7.1.

6 (Optional) Enter an email address in the Contact Email text box.
7 Click Submit and Next.

Configure Local Users

The vRealize Automation system administrator must configure local users for each applicable
tenant.

After an administrator creates the general information for a tenant, the Local users tab becomes
active, and the administrator can designate users who can access the tenant. When tenant
configuration is complete, local tenant users can log in to their respective tenants to complete
work assignments.

Note After you add a user, you cannot change its configuration. If you need to change anything
about the user configuration, you must delete the user and recreate it.
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Procedure
1 Click the Add button on the Local users tab.

2 Enter the users first and last names into the First name and Last name fields on the User
Details dialog.

Enter the user email address into the Email field.

3
4 Enter the user ID and password for the user in the User name and Password fields.
5 Click the Add button.

6

Repeat these steps as applicable for all local users of the tenant.

Results

The specified local users are created for the tenant.

Appoint Administrators

You can appoint one or more tenant administrators and laaS administrators from the identity
stores you configured for a tenant.

Tenant administrators are responsible for configuring tenant-specific branding, as well as
managing identity stores, users, groups, entitlements, and shared blueprints within the context of
their tenant. laaS Administrators are responsible for configuring infrastructure source endpoints
in laasS, appointing fabric administrators, and monitoring laaS logs.

Prerequisites

m  Before you appoint laaS administrators, you must install laaS. For more information about
installing laas, see Installing vRealize Automation.

Procedure
1 Enter the name of a user or group in the Tenant Administrators search box and press Enter.

For faster results, enter the entire user or group name, for example
myAdmins@mycompany.domain. Repeat this step to appoint additional tenant
administrators.

2 |If you have installed laaS, enter the name of a user or group in the laaS Administrators
search box and press Enter.

For faster results, enter the entire user or group name, for example
laaSAdmins@mycompany.domain. Repeat this step to appoint additional infrastructure
administrators.

3 Click Add.

Delete a Tenant

A system administrator can delete any unwanted tenants from vRealize Automation.
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If you delete a tenant, that tenant will be removed from the vRealize Automation interface
immediately, but it may take several hours for the tenant to be completely removed from your
deployment. If you delete a tenant and want to create another tenant with the same URL, allow
several hours for complete deletion before creating the new tenant.

Prerequisites

Log in to the vRealize Automation console as a system administrator.

Procedure
1 Select Administration > Tenants.
2 Select the tenant that you want to delete.
Do not click the actual name to select the tenant. Doing so will open the tenant for editing.

3 Click Delete.

Results

The tenant is deleted from your vRealize Automation deployment.

Configuring Security Settings for Multi-tenancy

You can control the availability of NSX security objects across tenants in a multi-tenant
environment.

When you create an NSX security object in vRealize Automation, its default availability can be
either global, meaning available in all tenants for which the associated endpoint has a reservation,
or hidden to all users except the administrator.

Availability of security objects across tenants is also relative to whether the associated endpoint
has a reservation or reservation policy in the tenant.

The means by which you control the availability of new security objects across tenants and the
behavior you see in existing security objects, relative to cross-tenancy, after upgrading to this
vRealize Automation release are summarized in related topic Controlling Tenant Access for
Security Objects.

Configuring Custom Branding

vRealize Automation enables you to apply custom branding to tenant login and application
pages.

Custom branding can include text and background colors, business logos, company hame,
privacy policies, copyright statements and other relevant information that you want to appear on
tenant login or application pages.

Custom Branding for Tenant Login Page

Use the Login Screen Branding page to apply custom branding to your vRealize Automation
tenant login pages.
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You can use default vRealize Automation branding on your tenant login pages, or you can
configure custom branding using the Login Screen Branding page. Note that custom branding
applies in the same manner to all of your tenant applications.

This page enables you to configure branding on all tenant login pages.
The Login Screen Branding page displays the currently implemented tenant login branding in the

Preview pane.

Note After saving new tenant login page branding, there may be a delay of up to five minutes
before it becomes visible on all login pages.
Prerequisites

To use a custom logo or other image with your branding, you must have the appropriate files
available.

Procedure

1 Login to vRealize Automation as a system or tenant administrator.

2 Click the Administration tab.

3 Select the desired visual effects using the check boxes under the Effects heading.
All effects are optional.

4 Select Branding > Login Screen Branding

5 Click Upload beneath the Logo field, then navigate to the appropriate folder and select a
logo image file.

6 If desired, click Upload beneath the Image (optional) field, then navigate to the appropriate
folder and select an additional image file.

7 |If desired, enter the appropriate hex codes in the Background color, Masthead color, Login
button background color and Login button foreground color fields.

Search the internet for a list of hex color codes if needed.

8 Click Save to apply your settings.

Results

Tenant users see the custom branding on their login pages.

Custom Branding for Tenant Applications

Use the Application Branding page to apply custom branding to vRealize Automation tenant
applications.

You can use default vRealize Automation branding on your user applications, or you can
configure custom branding using the Application Branding page. This page enables you to
configure branding on the header and footer of application pages. Note that custom branding
applies in the same manner to all of your user applications.
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The Application Branding page displays the currently implemented header or footer branding at
the bottom of the page.

Prerequisites

If you want to use a custom logo with your branding, you must have the logo image file available.

Procedure

1 Login to vRealize Automation as a system or tenant administrator.
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Click the Administration tab.

Select Branding > Application Branding

Click the Header tab if it is not already active.

If you want to use the default vRealize Automation branding, click the Use Default check box.

To implement custom branding, make the appropriate selections in the fields on the Header

and Footer tabs.

a

h

Click the Browse button in the Header Logo field, then navigate to the appropriate folder
and select an logo image file.

Type the appropriate company name in the Company name field.

The specified name appears when a user mouses over the logo.

Type the appropriate name into the Product name field.

The name you enter here appears in the application header adjacent to the logo.

Enter the appropriate hex color code for the application perimeter background color in
the Background hex color field.

Search the internet for a list of hex color codes if needed.

Enter the appropriate hex code for the text color in the Text hex color field.

Search the internet for a list of hex text color codes if needed.

Click Next to activate the Footer tab.

Type the desired statement into the Copyright notice field.

Type the link to you company privacy policy statement in the Privacy policy link field.

Type the desired company contact information in the Contact link field.

7 Click Update to implement your branding configuration.

Results

Tenant users see the custom branding on their application pages.
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Checklist for Configuring Notifications

You can configure vRealize Automation to send users notifications when specific events occur.
Users can choose which notifications to subscribe to, but they can only select from events you
enable as notification triggers.

A
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Configure an outbound mail
server to send notifications.

Do you want users
to be able to respond
to notifications?

Enable notifications for
any events you want
to allow users to
receive updates for.

Do you want to
customize the
templates for laaS
notifications?

Tell your users how to
subscribe to the
notifications you enabled.

Users get the
notifications they want.

Configure an inbound mail
server to receive notifications.

TEMPLATE

Edit the configuration files

that control laaS notifications.
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The Configuring Notifications Checklist provides a high-level overview of the sequence of steps
required to configure notifications and provides links to decision points or detailed instructions

for each step.

Table 2-10. Checklist for Configuring Notifications

Task

U Configure an outbound email server to send
notifications.

U (Optional) Configure an inbound email server so that
users can complete tasks by responding to notifications.

U (Optional) Specify when to send an email notification
prior to a machine expiration date.

U Select the vRealize Automation events to trigger user
notifications. Users can only subscribe to notifications for
events you enable as notification triggers.
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Required Role

System
administrators
configure
default global
servers.

Tenant
administrators
configure
servers for
their tenants.

System
administrators
configure
default global
servers.

Tenant
administrators
configure
servers for
their tenants.

System
administrator

Tenant

administrator

Details

To configure a server for your tenant for
the first time, see Add a Tenant-Specific
Outbound Email Server. If you need to
override a default global server, see
Override a System Default Outbound
Email Server. To configure global default
servers for all tenants, see Create a
Global Outbound Email Server.

To configure a server for your tenant for
the first time, see Add a Tenant-Specific
Inbound Email Server.

If you need to override a default global
server, see Override a System Default
Inbound Email Server.

To configure a global default server for
all tenants, see Create a Global Inbound
Email Server.

See Customize the Date for Email
Notification for Machine Expiration.

See Configure Notifications.
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Table 2-10. Checklist for Configuring Notifications (continued)

Task Required Role Details

U (Optional) Configure the templates for notifications Anyone with See Configuring Templates for
sent to machine owners concerning events that involve access to the Automatic laaS Emails.

their machines, such as lease expiration. directory

\Templates under
the vRealize
Automation server
install directory
(typically
%SystemDrive%
\Program Files
x86\VMware\vCAC
\Server) can
configure the
templates for
these email
notifications.

U You users are automatically subscribed to the All users See Subscribe to Notifications.
configured notifications.

If necessary, you can provide your users with
instructions about how to subscribe to the notifications
that you enabled. They can choose to subscribe to only
the notifications that are relevant to their roles.

Configuring Global Email Servers for Notifications

Tenant administrators can add email servers as part of configuring notifications for their own
tenants. As a system administrator, you can set up global inbound and outbound email servers
that appear to all tenants as the system defaults. If tenant administrators do not override these
settings before enabling notifications, vRealize Automation uses the globally configured email
servers.

Create a Global Inbound Email Server

System administrators create a global inbound email server to handle inbound email notifications,
such as approval responses. You can create only one inbound server, which appears as the
default for all tenants. If tenant administrators do not override these settings before enabling
notifications, vRealize Automation uses the globally configured email server.

Prerequisites

Log in to the vRealize Automation console as a system administrator.

Procedure

1 Select Administration > Email Servers.

2 Click the Add icon ().

3 Select Email - Inbound.
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Click OK.

Enter a name in the Name text box.

(Optional) Enter a description in the Description text box.
(Optional) Select the SSL check box to use SSL for security.

Choose a server protocol.

W 00 N o v b

Type the name of the server in the Server Name text box.

10 Type the server port number in the Server Port text box.

11 Type the folder name for emails in the Folder Name text box.
This option is required only if you choose IMAP server protocol.

12 Enter a user name in the User Name text box.

13 Enter a password in the Password text box.

14 Type the email address that vRealize Automation users can reply to in the Email Address text
box.

15 (Optional) Select Delete From Server to delete from the server all processed emails that are
retrieved by the notification service.

16 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

17 Click Test Connection.

18 Click Add.

Create a Global Outbound Email Server

System administrators create a global outbound email server to handle outbound email
notifications. You can create only one outbound server, which appears as the default for all
tenants. If tenant administrators do not override these settings before enabling notifications,
vRealize Automation uses the globally configured email server.

Prerequisites
Log in to the vRealize Automation console as a system administrator.
Procedure

1 Select Administration > Email Servers.

2 Click the Add icon ().

3 Select Email - Outbound.
4 Click OK.
5

Enter a name in the Name text box.
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6 (Optional) Enter a description in the Description text box.
7 Type the name of the server in the Server Name text box.
8 Choose an encryption method.
m  Click Use SSL.
m  Click Use TLS.
m  Click None to send unencrypted communications.
9 Type the server port number in the Server Port text box.
10 (Optional) Select the Required check box if the server requires authentication.
a Type a user name in the User Name text box.
b Type a password in the Password text box.

11 Type the email address that vRealize Automation emails should appear to originate from in
the Sender Address text box.

This email address corresponds to the user name and password you supplied.

12 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

13 Click Test Connection.

14 Click Add.

Add a Tenant-Specific Outbound Email Server

Tenant administrators can add an outbound email server to send notifications for completing
work items, such as approvals.

Each tenant can have only one outbound email server. If your system administrator has already
configured a global outbound email server, see Override a System Default Outbound Email
Server.

Prerequisites
m  Login to vRealize Automation as a tenant administrator.

m [|f the email server requires authentication, the specified user must be in an identity store and
the business group.

Procedure
1 Select Administration > Notifications > Email Servers.
2 Click the Add icon ().

3 Select Email - Outbound.

4 Click OK.
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Enter a name in the Name text box.
(Optional) Enter a description in the Description text box.

Type the name of the server in the Server Name text box.

0 N o u

Choose an encryption method.

m  Click Use SSL.

m  Click Use TLS.

m  Click None to send unencrypted communications.

9 Type the server port number in the Server Port text box.

10 (Optional) Select the Required check box if the server requires authentication.
a Type a user name in the User Name text box.

b Type a password in the Password text box.

11 Type the email address that vRealize Automation emails should appear to originate from in
the Sender Address text box.

This email address corresponds to the user name and password you supplied.

12 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

This option is available only if you enabled encryption.

m  Click Yes to accept self-signed certificates.
m  Click No to reject self-signed certificates.
13 Click Test Connection.

14 Click Add.

Add a Tenant-Specific Inbound Email Server

Tenant administrators can add an inbound email server so that users can respond to notifications
for completing work items, such as approvals.

Each tenant can have only one inbound email server. If your system administrator already
configured a global inbound email server, see Override a System Default Inbound Email Server.

Prerequisites
m  Login to vRealize Automation as a tenant administrator.

m  Verify that the specified user is in an identity store and in the business group.

Procedure

1 Select Administration > Notifications > Email Servers.

2 Click the Add icon ().
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3 Select Email - Inbound and click OK.

4 Configure the following inbound email server options.

Option Action

Name Enter a name for the inbound email server.
Description Enter a description of the inbound email server.
Security Select the Use SSL check box.

Protocol Choose a server protocol.

Server Name Enter the server name.

Server Port Enter the server port number.

5 Type the folder name for emails in the Folder Name text box.
This option is required only if you choose IMAP server protocol.

6 Enter a user name in the User Name text box.

7 Enter a password in the Password text box.

8 Type the email address that vRealize Automation users can reply to in the Email Address text
box.

9 (Optional) Select Delete From Server to delete from the server all processed emails that are
retrieved by the notification service.

10 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

This option is available only if you enabled encryption.

m  Click Yes to accept self-signed certificates.
m  Click No to reject self-signed certificates.
11 Click Test Connection.

12 Click Add.

Override a System Default Outbound Email Server

If the system administrator configured a system default outbound email server, the tenant
administrator can override this global setting.

Prerequisites

Log in to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Notifications > Email Servers.

2 Select the Outbound email server.
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Click Override Global.
Enter a name in the Name text box.
(Optional) Enter a description in the Description text box.

Type the name of the server in the Server Name text box.
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Choose an encryption method.

m  Click Use SSL.

m  Click Use TLS.

m  Click None to send unencrypted communications.

8 Type the server port number in the Server Port text box.

9 (Optional) Select the Required check box if the server requires authentication.
a Type a user name in the User Name text box.

b Type a password in the Password text box.

10 Type the email address that vRealize Automation emails should appear to originate from in
the Sender Address text box.

This email address corresponds to the user name and password you supplied.

11 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

This option is available only if you enabled encryption.

m  Click Yes to accept self-signed certificates.
m  Click No to reject self-signed certificates.
12 Click Test Connection.

13 Click Add.

Override a System Default Inbound Email Server

If the system administrator has configured a system default inbound email server, tenant
administrators can override this global setting.

Prerequisites

Log in to vRealize Automation as a tenant administrator.

Procedure
1 Select Administration > Notifications > Email Servers.
2 Select the Inbound email server in the Email Servers table.

3 Click Override Global.
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4 Enter the following inbound email server options.

Option Action

Name Enter the name of the inbound email server.
Description Enter a description of the inbound email server.
Security Select the SSL check box to use SSL for security.
Protocol Choose a server protocol.

Server Name Enter the server name.

Server Port Enter the server port number.

5 Type the folder name for emails in the Folder Name text box.
This option is required only if you choose IMAP server protocol.

6 Enter a user name in the User Name text box.

7 Enter a password in the Password text box.

8 Type the email address that vRealize Automation users can reply to in the Email Address text
box.

9 (Optional) Select Delete From Server to delete from the server all processed emails that are
retrieved by the notification service.

10 Choose whether vRealize Automation can accept self-signed certificates from the email
server.

This option is available only if you enabled encryption.

m Click Yes to accept self-signed certificates.
m  Click No to reject self-signed certificates.
11 Click Test Connection.

12 Click Add.

Revert to System Default Email Servers

Tenant administrators who override system default servers can revert the settings back to the
global settings.

Prerequisites

Log in to vRealize Automation as a tenant administrator.
Procedure

1 Select Administration > Notifications > Email Servers.

2 Select the email server to revert.

3 Click Revert to Global.
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4 Click Yes.

Configure Notifications

Each user determines whether to receive notifications, but tenant administrators determine which
events trigger notifications.

Prerequisites
m  Login to vRealize Automation as a tenant administrator.

m  Verify that a tenant administrator or system administrator configured an outbound email
server. See Add a Tenant-Specific Outbound Email Server.

Procedure
1 Select Administration > Notifications > Scenarios.
2 Select one or more notifications.

3 Click Activate.

Results

Users who subscribe to notifications in their preference settings now receive the notifications.

Customize the Date for Email Notification for Machine Expiration
You can specify when to send an email notification prior to a machine expiration date.

You can change the setting that defines the number of days before a machine's expiration date
that vRealize Automation sends an expiration notification email. The email notifies users of a
machine's expiration date. By default, the setting is 7 days prior to machine expiration.

Procedure
1 Login to the vRealize Automation server by using credentials with administrative access.
2 Navigate to and open the /etc/vcac/setenv-user file.

3 Add the following line to the file to specify the number of days prior to machine expiration,
where 3 in this example specifies 3 days prior to machine expiration.

VCAC_OPTS="$VCAC_OPTS -Dlease.enforcement.prearchive.notification.days=3"
4 Restart the vCAC services on the virtual appliance by running the following command:

service vcac-server restart

What to do next

If you are working in a high availability load balancer environment, repeat this procedure for all
the virtual appliances in the HA environment.
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Configuring Templates for Automatic laaS Emails

You can configure notification emails to be sent to machine owners about various vRealize
Automation events that involve their machines.

The events that trigger notifications can include the expiration or approaching expiration of
archive periods and virtual machine leases.

For information about configuring and enabling or disabling vRealize Automation email
notifications, see the following blog article and Knowledge Base articles:

m  Email Customization in vRealize Automation
m  Customizing email templates in vRealize Automation (2088805)

m  Examples for customizing email templates in vRealize Automation (2102019)

Subscribe to Notifications

If your administrators have configured notifications, you are automatically subscribed.
Notification events can include the successful completion of a catalog request or a required
approval.

If you must manually subscribe, you can enable your notifications.

Prerequisites

Log in to vRealize Automation.

Procedure

1 Click Preferences.

2 Select the Enabled check box for the Email protocol in the Notifications table.
3 Click Apply.

4 Click Close.

Create a Custom RDP File to Support RDP Connections for
Provisioned Machines

System administrators create a custom remote desktop protocol file that laaS architects use in
blueprints to configure RDP settings. You create the RDP file and provide architects with the full
pathname for the file so they can include it in blueprints, then a catalog administrator entitles
users to the RDP action.

Note If you are using Internet Explorer with Enhanced Security Configuration enabled, you
cannot download . rdp files.

Prerequisites

Log in to the laaS Manager Service as an administrator.
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Procedure

)

Set your current directory to <vRA_installation_dir>\Rdp.
Copy the file Default. rdp and rename it to Console.rdp in the same directory.

Open the Console. rdp file in an editor.
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Add RDP settings to the file.
For example, connect to console:i:1.

5 If you are working in a distributed environment, log in as a user with administrative privileges
to the laaS Host Machine where the Model Manager Website component is installed.

6 Copy the Console. rdp file to the directory vRA_installation_dir\Server\Website\Rdp.
7 Add the VirtualMachine.Rdp.File custom property to the blueprint.

Your laaS architects can add the RDP custom properties to Windows machine blueprints, and
then catalog administrators can entitle users to the Connect Using RDP action. See Add RDP
Connection Support to Your Windows Machine Blueprints.

Scenario: Add Datacenter Locations for Cross Region Deployments

As a system administrator, you want to define locations for your Boston and London datacenters
so your fabric administrators can apply the appropriate locations to compute resources in each
datacenter. When your blueprint architects create blueprints, they can enable the locations
feature so users can choose to provision machines in Boston or London when they fill out their
catalog item request forms.

You have a datacenter in London, and a datacenter in Boston, and you do not want users in
Boston provisioning machines on your London infrastructure or vice versa. To ensure that Boston
users provision on your Boston infrastructure, and London users provision on your London
infrastructure, you want to allow users to select an appropriate location for provisioning when
they request machines.

L __ﬂ‘ o
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Applies locations to Emables locations
8 Creates locations 8 compute resources faature
Fabric Blueprint
adrmmstrartor @ You are here administrator architect

You cannot filter datacenter locations in the xml file based on the tenant or business group.
When working in a multi-tenant environment, you can use property definitions to filter based on
the tenant or business group. For information about using property definitions, see blog post
How to use dynamic property definitions.
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Procedure
1 Login to yourlaaS Web Server host using administrator credentials.
This is the machine on which you installed the laaS Website component.

2 Edit the file WebSite\XmlData\DataCenterLocations.xml in the Windows server install
directory (typically %SystemDrive%\Program Files x86\VMware\vCAC\Server).

3 Edit the CustomDataType section of the file to create Data Name entries for each location.

<CustomDataType>
<Data Name="London" Description="London datacenter" />
<Data Name="Boston" Description="Boston datacenter" />
</CustomDataType

4 Save and close the file.
5 Restart the manager service.

6 If you have more than one laaS Web Server host, repeat this procedure on each redundant
instance.

Results

Your fabric administrator can apply the appropriate location to compute resources located in
each datacenter. See Scenario: Apply a Location to a Compute Resource for Cross Region
Deployments .

What to do next

You can add the Vrm.DataCenter.Location property to a blueprint, or enable the Display
Location on Request option in the blueprint, to require that the user supply a datacenter location
when they request machine provisioning.

Configuring vRealize Orchestrator

vRealize Orchestrator is an automation and management engine that extends vRealize
Automation to support XaaS and other extensibility. You can configure and use the vRealize
Orchestrator server that is preconfigured in the vRealize Automation appliance, or you can
deployvRealize Orchestrator as an external server instance and associate that external instance
with vRealize Automation.

vRealize Orchestrator allows administrators and architects to develop complex automation tasks
by using the workflow designer, and then access and run the workflows from vRealize
Automation.

vRealize Orchestrator can access and control external technologies and applications by using
vRealize Orchestrator plug-ins.

Configuring vRealize Automation to use vRealize Orchestrator makes it possible to publish
Orchestrator workflows in the vRealize Orchestrator service catalog as part of the XaaS blueprint
management.
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If you want to run Orchestrator workflows to extend the management of laaS machines, you
must configure vRealize Orchestrator as an endpoint.
Configuration Privileges

System and tenant administrators can configure vRealize Automation to use an external or the
embedded vRealize Orchestrator server.

In addition, system administrators can also determine the workflow folders that are available to
each tenant.

Tenant administrators can configure the vRealize Orchestrator plug-ins as endpoints.

Role VRealize Orchestrator-Related Configuration Privileges

System administrators ®m  Configure the vRealize Orchestrator server for all tenants.

m  Define the default vRealize Orchestrator workflow folders per tenant.

Tenant administrators m  Configure the vRealize Orchestrator server for their own tenant.

m  Add vRealize Orchestrator plug-ins as endpoints.

Configure the Embedded vRealize Orchestrator Server

The vRealize Automation Appliance includes a preconfigured instance of vRealize Orchestrator.
The vRealize Orchestrator server service is running by default but you must start the
configuration service manually to access the Control Center.

Prerequisites

Deploy the vRealize Automation Appliance. For deatils, see Deploy the vRealize Automation
Appliance in Installing vRealize Automation.

Procedure

1 Login to the vRealize Automation console as a system administrator or tenant
administrator.

2 Select Administration > VRO Configuration > Server Configuration.

3 Click Use the default Orchestrator server.

Results

Connections to the embedded vRealize Orchestrator server are now configured. The vCAC
workflows folder and the related utility actions are automatically imported. The vCAC > ASD
workflows folder contains workflows for configuring endpoints and creating resource mappings.

Configure the Default Workflow Folder for a Tenant

System administrators can group workflows in different folders and then define workflow
categories per tenant. By doing this, a system administrator can grant users from different
tenants access to different workflow folders on the same vRealize Orchestrator server.
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Prerequisites

Log in to the vRealize Automation console as a system administrator.

Procedure

1 Select Administration > Advanced Services > Default vRO Folder.

2 Click the name of the tenant you want to edit.

3 Browse the vRealize Orchestrator workflow library and select a folder.
4

Click Add.

Results

You defined the default vRealize Orchestrator workflow folder for a tenant.

What to do next

Repeat the procedure for all of the tenants for which you want to define a default workflow
folder.

Log in to the vRealize Orchestrator Configuration Interface

To edit the configuration of the default vRealize Orchestrator instance embedded in vRealize
Automation, you must start the vRealize Orchestrator configuration service and log in to the
vRealize Orchestrator configuration interface.

The vRealize Orchestrator configuration service is not started by default in the vRealize
Automation appliance. You must start the vRealize Orchestrator configuration service to access
the vRealize Orchestrator configuration interface.

Procedure

1 Start the vRealize Orchestrator Configuration service.
a Login to the vRealize Automation appliance Linux console as root.
b Enter service vco-configurator start and press Enter.

2 Connect to the vRealize Automation URL in a Web browser.

3 Click vRealize Orchestrator Control Center.

You are redirected to https://vra-va-
hostname.domain.name_or_load_balancer_address:8283/vco-controlcenter.

4 Loginto the vRealize Orchestrator Control Center.

The user name is configured by the vRealize Automation appliance administrator.

Log in to the vRealize Orchestrator Client

To perform general administration tasks or to edit and create workflows in the default vRealize
Orchestrator instance, you must log in to the vRealize Orchestrator client.
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The vRealize Orchestrator client interface is designed for developers with administrative rights
who want to develop workflows, actions, and other custom elements.

Procedure

1 Connect to the vRealize Automation URL in a Web browser.

2 Click vRealize Orchestrator Client.

The client file is downloaded.

3 Click the download and following the prompts.

4 On the vRealize Orchestrator log in page, enter the IP or the domain name of the vRealize
Automation appliance in the Host name text box, and 443 as the default port number.
For example, enter vrealize_automation_appliance_ip:443.

5 Login by using the vRealize Orchestrator Client user name and password.

The credentials are the default tenant administrator user name and password.
6 In the Certificate Warning window select an option to handle the certificate warning.

The vRealize Orchestrator client communicates with the vRealize Orchestrator server by
using an SSL certificate. A trusted CA does not sign the certificate during installation. You
receive a certificate warning each time you connect to the vRealize Orchestrator server.

Option Description

Ignore Continue using the current SSL certificate.

The warning message appears again when you reconnect to the same
VvRealize Orchestrator server, or when you try to synchronize a workflow
with a remote vRealize Orchestrator server.

Cancel Close the window and stop the login process.

Install this certificate and do not Select this check box and click lgnore to install the certificate and stop
display any security warnings for it receiving security warnings.
anymore.

You can change the default SSL certificate with a certificate signed by a CA. For more
information about changing SSL certificates, see Installing and Configuring VMware vRealize
Orchestrator.

What to do next

You can import a package, develop workflows, or set root access rights on the system. See
Using the VMware vRealize Orchestrator Client and Developing with VMware vRealize
Orchestrator.

Configure an External vRealize Orchestrator Server

You can set up vRealize Automation to use an external vRealize Orchestrator server.
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System administrators can configure the default vRealize Orchestrator server globally for all
tenants. Tenant administrators can configure the vRealize Orchestrator server only for their
tenants.

Connections to external vRealize Orchestrator server instances require the user account to have
view and run permissions in vRealize Orchestrator.

m  Single Sign-On authentication. The user information is passed to vRealize Orchestrator with
the XaaS request and the user is granted view and run permissions for the requested
workflow.

m Basic authentication. The provided user account must be a member of a vRealize
Orchestrator group with view and run permissions or the member of the vcoadmins group.

Prerequisites

m Install and configure an external vRealize Orchestrator Appliance. See Installing and
Configuring vRealize Orchestrator in the vRealize Orchestrator Information Center at https://
www.vmware.com/support/pubs/orchestrator_pubs.html.

m  Login to the vRealize Automation console as a system administrator or tenant
administrator.

m  Configure the default workflow folder. See Configure the Default Workflow Folder for a

Tenant.
Procedure
1 Select Administration > VRO Configuration > Server Configuration.
2 Click Use an external Orchestrator server.
3 Enter a name and, optionally, a description.
4 Enter the IP or the DNS name of the machine on which the vRealize Orchestrator server runs

in the Host text box.

Note If the external Orchestrator is configured to work in cluster mode, enter the IP address
or host name of the load balancer virtual server that distributes the client requests across the
Orchestrator servers in the cluster.

5 Enter the port number to communicate with the external vRealize Orchestrator server in the
Port text box.

The default port for vRealize Orchestrator is 8281.
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6 Select the authentication type.

Option Description
Single Sign-On Connects to the vRealize Orchestrator server by using vCenter Single Sign-
on.

This option is applicable only if you configured the vRealize Orchestrator
and vRealize Automation to use a common vCenter Single Sign-On instance.

Basic Connects to the vRealize Orchestrator server with the user name and
password that you enter in the User name and Password text boxes.

The account that you provide must be a member of the vRealize
Orchestrator vcoadmins group or a member of a group with view and run
permissions.

7 Click Test Connection.

8 Click OK.

Results

You configured the connection to the external vRealize Orchestrator server, and the vCAC
workflows folder and the related utility actions are automatically imported. The vCAC > ASD
workflows folder contains workflows for configuring endpoints and creating resource mappings.

What to do next

Log in to the vRealize Orchestrator Client

Configuring Resources

You can configure resources such as endpoints, reservations, and network profiles to support
vRealize Automation blueprint definition and machine provisioning.

Checklist for Configuring laaS Resources

laaS administrators and fabric administrators configure laaS resources to integrate existing
infrastructure with vRealize Automation and to allocate infrastructure resources to vRealize
Automation business groups.

You can use the Configuring laaS Resources Checklist to see a high-level overview of the
sequence of steps required to configure laaS resources.
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A =1

Create Fabric
Groups and
Fabric Administrator

Store Create
Credentials Endpoints

& e

Fabric
Administrator

Table 2-11. Checklist for Configuring laaS Resources

VRealize

Task Automation Role Details
U Create endpoints for your infrastructure to bring laaS administrator ~ Choosing an Endpoint Scenario.
resources under vRealize Automation management.
U Create a fabric group to organize infrastructure laaS administrator  Create a Fabric Group.
resources into groups and assign one or more
administrators to manage those resources as your
vRealize Automation fabric administrators.
U Configure machine prefixes used to create names for Fabric Configure Machine Prefixes.
machines provisioned through vRealize Automation. administrator
U (Optional) Create network profiles to configure Fabric Creating a Network Profile.
network settings for provisioned machines. administrator
O Allocate infrastructure resources to business groups m  laaS Configuring Reservations and
by creating reservations and, optionally, reservation and administrator Reservation Policies.
storage reservation profiles. if also

configured as

a Fabric

administrator

m  Fabric
administrator

Configuring Endpoints

You create and configure the endpoints that allow vRealize Automation to communicate with
your infrastructure.

Endpoints definitions are categorized based on type:
s Cloud

The cloud category contains the vCloud Air, vCloud Director, Amazon EC2, and OpenStack
endpoint types

= |PAM
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This category is only visible if you have registered a third-party IPAM endpoint type such as
Infoblox IPAM in a vRealize Orchestrator workflow.

= Management
This category contains the vRealize Operations Manager endpoint only.
= Network and Security
This category contains the Proxy and NSX endpoint types.
A Proxy endpoint can be associated to an Amazon, vCloud Air, or vCloud Director endpoint.
An NSX endpoint can be associated to a vSphere endpoint.
m  Orchestration
This category contains the vRealize Orchestrator endpoint only.
m Storage
This category contains the NetApp ONTAP endpoint.
s Virtual

The virtual category contains the vSphere, Hyper-V (SCVMM), and KVM (RHEV) endpoint
types.

You can configure additional endpoint types in vRealize Orchestrator and use them with
supported endpoint types in vRealize Automation. You can also import, and export, endpoints
programmatically.

For information about working with endpoints after upgrade or migration, see Considerations
When Working With Upgraded or Migrated Endpoints.

Choosing an Endpoint Scenario

Choose an endpoint scenario based on the target endpoint type.
For information about available endpoint settings, see Endpoint Settings Reference.

Table 2-12. Choosing an Endpoint Scenario

Endpoint More Information

vSphere Create a vSphere Endpoint

NSX Create an NSX Endpoint and Associate to a vSphere
Endpoint

vCloud Air (Subscription or OnDemand) Create a vCloud Air Endpoint

vCloud Director Create a vCloud Director Endpoint

vRealize Orchestrator Create a vRealize Orchestrator Endpoint

vRealize Operations Create a vRealize Operations Manager Endpoint

Third party IPAM provider Create a Third-Party IPAM Provider Endpoint

Microsoft Azure Create a Microsoft Azure Endpoint
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Table 2-12. Choosing an Endpoint Scenario (continued)

Endpoint More Information
Puppet Create a Puppet Endpoint
Amazon m  Create an Amazon Endpoint

m  (Optional) Add an Amazon Instance Type

OpenStack Create an OpenStack Endpoint

Proxy Create a Proxy Endpoint and Associate to a Cloud
Endpoint

Hyper-V (SCVMM) Create a Hyper-V (SCVMM) Endpoint

KVM (RHEV) Endpoint Settings Reference

NetApp ONTAP m  Space-Efficient Storage for Virtual Provisioning

m  Endpoint Settings Reference
Hyper-V (Standalone), XenServer or Xen Pool Master Create a Hyper-V, XenServer, or Xen Pool Endpoint

Import endpoints Import or Export Endpoints Programmatically

Endpoint Settings Reference

Use endpoint settings to define location and access credentials for data collection and service
catalog deployment.

General Tab

Most vRealize Automation endpoints contain the following options. Settings that are unique to a
particular endpoint type are noted.

Table 2-13. General Tab Settings

Setting Description
Name Enter the endpoint name.
Description Enter the endpoint description.
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Table 2-13. General Tab Settings (continued)

Setting

Address

Integrated credentials

User name

Password

OpenStack project

Organization

Access key ID

Secret access key

VMware, Inc.

Description

Enter the endpoint address using the endpoint-specific address format.

m  For a KVM (RHEV) or NetApp ONTAP endpoint, the address must be
of one of the following formats:

B https://FQDN
B https://IP_address

For example: https://mycompany—kvmrhevl.mycompany.local or
netapp-1.mycompany.local.

m  For an OpenStack endpoint, the address must be of the format
https:// FQDN/powervc/openstack/ service. For example:
https://openstack.mycompany.com/powervc/openstack/admin.

m  For an OpenStack endpoint, the address must be of one of the
following formats:

B https://FQDN:500
B https://IP_address:500

m  For a vSphere endpoint, the address must be of the format https://
host/sdk .

m  For an NSX endpoint, the address must be of the format https://host.

m  For a vRealize Orchestrator endpoint, the address must be of the
https protocol and include the fully qualified name or IP address of the
VRealize Orchestrator server and thevRealize Orchestrator port
number, for example https://vrealize-automation-appliance-

hostname:443/vco.

m  For a vRealize Operations endpoint, the address must be of the
format https://host/suite-api.

If you choose to use your vSphere integrated credentials you do not need
to enter a user name and password.

This setting applies to vSphere endpoints only.

Enter the administrator-level user name that you stored for the endpoint
in the endpoint-specific format as suggested in the user interface.

Enter the administrator-level password that you stored for the endpoint.

Enter an OpenStack tenant name.

This setting applies to OpenStack endpoints only.

If you are an organization administrator, you can enter a vCloud Director
organization name.

This setting applies tovCloud Director only.

Enter the Amazon AWS key ID.

This setting applies to Amazon endpoints only.

Enter your Amazon AWS secret access key.

This setting applies to Amazon endpoints only.
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Table 2-13. General Tab Settings (continued)

Setting Description

Port Enter the port value to connect to on the proxy endpoint address.
This setting applies to Proxy endpoints only.

Priority Enter a priority value as an integer greater than or equal to 1. The lower
value specifies a higher priority.

The priority value is associated to the embedded
VMware.VCenterOrchestrator.Priority custom property.

This setting applies to vRealize Orchestrator endpoints only.

Properties Tab

All endpoint types use a properties tab to capture custom properties or property groups and
settings. For examples of custom properties for specific endpoint types, see Custom Properties
Reference.

Association Tab

You can create an association to an NSX endpoint or a Proxy endpoint, depending on the
endpoint you are associating from. You can associate a vSphere endpoint with an NSX endpoint
to assign NSX settings to the vSphere endpoint. You can also associate a vCloud Air, vCloud
Director, or Amazon endpoint with a proxy endpoint to assign proxy settings to the vCloud Air,
vCloud Director, or Amazon endpoint.

Test Connection

You can use a test connection action to validate the credentials, host endpoint address, and

certificate for a vSphere, NSX, or vRealize Operations Manager endpoint. See Considerations
When Using Test Connection.

Create a vSphere Endpoint

You can create endpoints that allow vRealize Automation to communicate with the vSphere

environment and discover compute resources, collect data, and provision machines. You can
optionally associate NSX settings to the vSphere endpoint by associating to an NSX endpoint.

If you upgraded or migrated a vSphere endpoint that was using an NSX manager, a new NSX
endpoint is created that contains an association between the source vSphere endpoint and a
new NSX endpoint.

If your vSphere environment is integrated with NSX, see Create an NSX Endpoint and Associate
to a vSphere Endpoint.

For more information about validating the connection and certificate trust, see Considerations
When Using Test Connection.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m  You must install a vSphere proxy agent to manage your vSphere endpoint, and you must use
the same exact name for your endpoint and agent. For information about installing the agent,
see Installing vRealize Automation.

VMware, Inc. 207



Configuring vRealize Automation

m |f you plan to use a vSphere endpoint to deploy VMs from OVF templates, verify that your
credentials include the vSphere privilege VApp.Import in the vCenter associated with the
endpoint.

The VApp.Import privilege allows you to deploy a vSphere machine by using settings
imported from an OVF. Details about this vSphere privilege are available in the vSphere SDK
documentation.

If the OVF is hosted on a Web site, see Create a Proxy Endpoint for OVF Host Web Site.

m If you want to configure additional NSX network and security settings for the vSphere
endpoint, create an NSX endpoint. You can associate to the NSX endpoint as you create the
vSphere endpoint. See Create an NSX Endpoint and Associate to a vSphere Endpoint.

Procedure

1 Select Infrastructure > Endpoints > Endpoints.
2 Select New > Virtual > vSphere.

3 Enter a name in the Name text box.

The name must match the endpoint name provided to the vSphere proxy agent during
installation or data collection fails.

4 (Optional) Enter a description in the Description text box.
5 Enter the URL for the vCenter Server instance in the Address text box.

The URL must be of the type: https://hostname/sdk or https://IP_address/sdk.
For example, https://vsphereA/sdk.

6 Enter your vSphere administrator-level user name and password or instead use your vSphere
integrated credentials.

Provide credentials with permission to modify custom attributes.
The user name format is domain\username.

Select Use Integrated Credentials to use the vSphere proxy agent's service account to
connect to the vCenter Server.

If you choose to use your vSphere integrated credentials you do not need to enter a user
name and password.

7 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

8 (Optional) To configure NSX network and security settings for the endpoint, click
Associations and associate to an existing NSX endpoint.

You must have at least one NSX endpoint to create an association.

VMware, Inc. 208


https://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.ResourcePool.html#importVApp
https://www.vmware.com/support/developer/vc-sdk/visdk41pubs/ApiReference/vim.ResourcePool.html#importVApp

Configuring vRealize Automation

9 (Optional) Click Test Connection to validate the credentials, host endpoint address, and
certificate trust. The action also checks that the manager service and agent are running so
that endpoint can be data-collected. The OK action tests for these same conditions.

The Test Connection action returns information about any of the following conditions:
m Certificate error
If the certificate is not found, trusted, or has expired, you are prompted to accept a
certificate thumbprint. If you do not accept the thumbprint, you can still save the endpoint
but machine provisioning might fail.
m  Agent error
The associated vSphere agent is not found. The agent must be running for the test to
succeed.
m  Host error
The specified endpoint address is not reachable or the associated manager service is not
running. The manager service must be running for the test to succeed.
m  Credentials error
The specified user name and password combination is invalid for the endpoint at the
specified address.
= Timeout
The test action could not complete in the allowed two-minute time period.
If the Test Connection action fails, you can still save the endpoint but machine provisioning
might fail.
If there is a trusted certificate issue, for example the certificate has expired, you are
prompted to accept a certificate thumbprint.

10 Click OK to save the endpoint.

The OK action tests for the same conditions as the Test Connection action. If it finds any of
the preceding conditions, it returns a message. If it can save, it leaves the error on the screen
for you to review.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

Note Do not rename vSphere data centers after the initial data collection or provisioning might

fail.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create an NSX Endpoint and Associate to a vSphere Endpoint
You can create an NSX endpoint and associate its NSX settings to an existing vSphere endpoint.
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If you upgraded or migrated a vSphere endpoint that was using an NSX manager, a new NSX
endpoint is created that contains an association between the source vSphere endpoint and a
new NSX endpoint.

For information about validating the NSX connection and certificate trust, see Considerations
When Using Test Connection.

Prerequisites

Log in to vRealize Automation as an laaS administrator.

You must install a vSphere proxy agent to manage your vSphere endpoint, and you must use
the same exact name for your endpoint and agent. For information about installing the agent,
see Installing vRealize Automation.

Configure your NSX network settings. See Configuring Network and Security Component
Settings.

Create a vSphere Endpoint.

In preparation for using NSX network, security, and load balancing capabilities in vRealize
Automation, when using NSX Manager credentials you must use the NSX Manager administrator

account.

Procedure

1 Select Infrastructure > Endpoints > Endpoints.

2 Select New > Network and Security > NSX.

3 Enter a name in the Name text box.

4 (Optional) Enter a description in the Description text box.

5 Enter the URL for the NSX instance in the Address text box.
The URL must be of the type: https://hostname or https://IP_address.
For example, https://nsx-manager.local.

6 Enter the NSX administrator-level user name and password that are stored for the NSX
endpoint.

7 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

8 To associate the NSX network and security settings to an existing vSphere endpoint, click

Associations and select an existing vSphere endpoint.
You must create the vSphere endpoint before you can create the association.

You can only associate an NSX endpoint to one vSphere endpoint. This association constraint
means that you cannot provision a universal on-demand network and attach it to vSphere
machines that are provisioned on different vCenters.
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9 (Optional) Click Test Connection to validate the credentials, host endpoint address, and
certificate trust. The action also checks that the manager service and agent are running so
that endpoint can be data-collected. The OK action tests for these same conditions.

The Test Connection action returns information about any of the following conditions:
m Certificate error

If the certificate is not found, trusted, or has expired, you are prompted to accept a
certificate thumbprint. If you do not accept the thumbprint, you can still save the endpoint
but machine provisioning might fail.

m  Agent error

The associated vSphere agent is not found. The agent must be running for the test to
succeed.

m  Host error

The specified endpoint address is not reachable or the associated manager service is not
running. The manager service must be running for the test to succeed.

m  Credentials error

The specified user name and password combination is invalid for the endpoint at the
specified address.

= Timeout
The test action could not complete in the allowed two-minute time period.

If the Test Connection action fails, you can still save the endpoint but machine provisioning
might fail.

If there is a trusted certificate issue, for example the certificate has expired, you are
prompted to accept a certificate thumbprint.

10 Click OK to save the endpoint.

The OK action tests for the same conditions as the Test Connection action. If it finds any of
the preceding conditions, it returns a message. If it can save, it leaves the error on the screen
for you to review.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create a vCloud Air Endpoint
You can create a vCloud Air endpoint for a an OnDemand or subscription service. You can

optionally associate proxy settings to the vCloud Director endpoint by associating to a Proxy
endpoint.
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For information about vCloud Air Management Console, see vCloud Air documentation.

Note Reservations defined for vCloud Air endpoints and vCloud Director endpoints do not
support the use of network profiles for provisioning machines.

For vCloud Air endpoints, the Organization name and the vDC name must be identical for a
vCloud Air subscription instance.

For information about associating proxy settings to your endpoint, see Create a Proxy Endpoint
and Associate to a Cloud Endpoint.

Prerequisites

Log in to vRealize Automation as an laaS administrator.

Verify that you have Virtual Infrastructure Administrator authorization for your vCloud Air
subscription service or OnDemand account.

If you want to configure additional security and force connections to pass through a proxy
server, create a Proxy endpoint. You can associate to the Proxy endpoint as you create the
vCloud Director endpoint. See Create a Proxy Endpoint and Associate to a Cloud Endpoint.

Procedure

—t

Hh W N

Select Infrastructure > Endpoints > Endpoints.

Select New > Cloud > vCloud Air.

Enter a name and, optionally, a description.

Accept the default vCloud Air endpoint address in the Address text box or enter a new one.

The default vCloud Air endpoint address is https://vca.vmware.com, as specified in the
Default URL for vCloud Air endpoint global property.

Enter your administrator-level user name and password.

The credentials must be those of thevCloud Air subscription service or OnDemand account
administrator.

The user name format is domain\username.

Provide credentials for an organization administrator with rights to connect by using VMware
Remote Console.

(Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

(Optional) To configure additional security and force connections to pass through a proxy
server, click Associations and associate to an existing Proxy endpoint.

You must have at least one Proxy endpoint to create an association.

Click OK.
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What to do next

Create a Fabric Group.

Create a vCloud Director Endpoint

You can create a vCloud Director endpoint to manage all of the vCloud Director virtual data
centers (vDCs) in your environment, or you can create separate endpoints to manage each
vCloud Director organization. You can optionally associate proxy settings to the vCloud Director
endpoint by associating to a Proxy endpoint.

For information about Organization vDCs, see vCloud Director documentation.

Do not create a single endpoint and individual organization endpoints for the same vCloud
Director instance.

vRealize Automation uses a proxy agent to manage vSphere resources.

Note Reservations defined for vCloud Air endpoints and vCloud Director endpoints do not
support the use of network profiles for provisioning machines.

For information about associating proxy settings to your endpoint, see Create a Proxy Endpoint
and Associate to a Cloud Endpoint.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m |f you want to configure additional security and force connections to pass through a proxy
server, create a Proxy endpoint. You can associate to the Proxy endpoint as you create the
vCloud Director endpoint. See Create a Proxy Endpoint and Associate to a Cloud Endpoint.

Procedure

-

Select Infrastructure > Endpoints > Endpoints.
Select New > Cloud > vCloud Director.

Enter a name and, optionally, a description.

H W N

Enter the URL of the vCloud Director server in the Address text box.
The URL must be of the type FQDN or IP_address.

For example, https://mycompany.com.

5 Enter your administrator-level user name and password.

m  To connect to the vCloud Director server and specify the organization for which the user
has the administrator role, use organization administrator credentials. With these
credentials, the endpoint can access only the associated organization vDCs. You can add
endpoints for each additional organization in the vCloud Director instance to integrate
with vRealize Automation.

VMware, Inc. 213



Configuring vRealize Automation

m  To allow access to all Organization vDCs in the vCloud Director instance, use system
administrator credentials for a vCloud Director and leave the Organization text box
empty.

6 If you are an organization administrator, you can enter a vCloud Director organization name
in the Organization text box.

Option Description

Discover all Organization vCDs If you have implemented vCloud Director in a private cloud, you can leave
the Organization text box blank to allow the application to discover all the
available Organization vDCs.

Separate endpoints for each Enter a vCloud Director organization name in the Organization text box.
Organization vCD

The Organization name matches your vCloud Director Organization name, which might also
appear as your virtual data center (vDC) name. If you are using a Virtual Private Cloud, then
this name is a unique identifier in the M123456789-12345 format. In a dedicated cloud, it is the
given name of the target vDC.

If you are connecting directly to vCloud Director at the system level, for example leaving the
Organization field blank, you need system administrator credentials. If you are entering an
Organization in the endpoint, you need a user who has Organization Administrator
credentials in that organization.

Provide credentials with rights to connect by using VMware Remote Console.

m  To manage all organizations with a single endpoint, provide credentials for a system
administrator.

m  To manage each organization virtual datacenter (vDC) with a separate endpoint, create
separate organization administrator credentials for each vDC.

Do not create a single system-level endpoint and individual organization endpoints for the
same vCloud Director instance.

7 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

8 (Optional) To configure additional security and force connections to pass through a proxy
server, click Associations and associate to an existing Proxy endpoint.

You must have at least one Proxy endpoint to create an association.

9 Click OK.

What to do next

Create a Fabric Group.

Create an Amazon Endpoint
You can create an endpoint to connect to an Amazon instance. You can optionally associate

proxy settings to the Amazon endpoint by associating to a Proxy endpoint.
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vRealize Automation provides several Amazon instance types for you to use when creating
blueprints, but if you want to import your own instance types see Add an Amazon Instance Type.

For information about associating proxy settings to your endpoint, see Create a Proxy Endpoint
and Associate to a Cloud Endpoint.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m If you want to configure additional security and force connections to pass through a proxy
server, create a Proxy endpoint. You can associate to the Proxy endpoint as you create the
Amazon endpoint. See Create a Proxy Endpoint and Associate to a Cloud Endpoint.

Procedure
1 Select Infrastructure > Endpoints > Endpoints.
2 Select New > Cloud > Amazon EC2.
3 Enter a name and, optionally, a description.
Typically this name indicates the Amazon account that corresponds to this endpoint.
4 Enter the administrative-level access key ID for the Amazon endpoint.

Only one endpoint can be associated with an Amazon access key ID.

To obtain the access key needed to create the Amazon endpoint, you must either request a
key from a user who has AWS Full Access Administrator credentials or be additionally
configured with the AWS Full Access Administrator policy. See Amazon documentation for
details.

5 Enter the secret access key for the Amazon endpoint.

6 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

7 (Optional) To configure additional security and force connections to pass through a proxy
server, click Associations and associate to an existing Proxy endpoint.

You must have at least one Proxy endpoint to create an association.

8 Click OK.

Results

After you create the endpoint, vRealize Automation begins collecting data from the Amazon Web
Services regions.

What to do next
Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Add an Amazon Instance Type
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Several instance types are supplied with vRealize Automation for use with Amazon blueprints. An
administrator can add and remove instance types.

The machine instance types managed by laaS administrators are available to blueprint architects
when they create or edit an Amazon blueprint. Amazon machine images and instance types are
made available through the Amazon Web Services product.

Prerequisites

Log in to vRealize Automation as an laaS administrator.

Procedure

1 Click Infrastructure > Administration > Instance Types.

2 Click New.

3 Add anew instance type, specifying the following parameters.

Information about the available Amazon instances types and the setting values that you can
specify for these parameters is available from Amazon Web Services documentation in EC2
Instance Types - Amazon Web Services (AWS) at aws.amazon.com/ec2 and Instance Types
at docs.aws.amazon.com.

= Name

m APl name

m  Type Name

m |O Performance Name
m CPUs

s Memory (GB)

m  Storage (GB)

s Compute Units
4 Click the Save icon (@).

Results
When laaS architects create Amazon Web Services blueprints, they can use your custom
instance types.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create a Proxy Endpoint and Associate to a Cloud Endpoint
You can create a proxy endpoint and associate its proxy settings to a vCloud Air, vCloud

Director, or Amazon endpoint.
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If you upgraded or migrated a vCloud Air, vCloud Director, or Amazon endpoint that was using a
proxy manager, a new vCloud Air, vCloud Director, or Amazon endpoint is created that contains
an association between the vCloud Air, vCloud Director, or Amazon endpoint and a new Proxy
endpoint.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.
m Create one of the following endpoint types:

m  Create a vCloud Air Endpoint

m  Create an Amazon Endpoint

m  Create a vCloud Director Endpoint

You must have at least one vCloud Air, vCloud Director, or Amazon endpoint to create an
association from the Proxy endpoint.

Procedure

-

Select Infrastructure > Endpoints > Endpoints.

Select New > Network and Security > Proxy.

Enter a name in the Name text box.

(Optional) Enter a description in the Description text box.

Enter the URL for the installed proxy agent in the Address text box.

Enter the port number to use for connecting to the proxy server in the Port text box.

Enter your administrator-level user name and password.

0 N o v b W N

(Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

9 To associate the proxy settings to a vCloud Air, vCloud Director, or Amazon endpoint, click
Associations and select one or more endpoints.

You must have at least one vCloud Air, vCloud Director, or Amazon endpoint to create an
association.

You can associate the Proxy endpoint to more than one endpoint.

10 Click OK.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.
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Create a Proxy Endpoint for OVF Host Web Site

You can create a proxy endpoint to use when importing OVF to a vSphere machine component
in a blueprint or as a value set for an Image component profile when the OVF is hosted on a Web
site.

For information about configuring for OVF deployment, see Create a vSphere Endpoint and
Configuring a Blueprint to Provision from an OVF.

Prerequisites

m  Login to vRealize Automation as an laaS administrator.

Procedure

)

Select Infrastructure > Endpoints > Endpoints.

Select New > Network and Security > Proxy.

Enter a name in the Name text box.

(Optional) Enter a description in the Description text box.

Enter the URL for the Web site that is hosting the OVF in the Address text box.

o u b W N

Enter the port number to use for connecting to the Web site proxy server in the Port text
box.

N

Enter your administrator-level user name and password.

8 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

9 Click OK.

Results

You can now use the endpoint to define the Web site at which to obtain OVF. For details, see
Define Blueprint Settings for a vSphere Component By Using an OVF and Define an Image Value
Set for a Component Profile By Using an OVF.

Create a vRealize Orchestrator Endpoint

You can create a vRealize Orchestrator endpoint to connect to a vRealize Orchestrator server.

You can configure multiple endpoints to connect to different vRealize Orchestrator servers, but
you must configure a priority for each endpoint.

When executing vRealize Orchestrator workflows, vRealize Automation tries the highest priority
vRealize Orchestrator endpoint first. If that endpoint is not reachable, then it proceeds to try the
next highest priority endpoint until a vRealize Orchestrator server is available to run the
workflow.

Prerequisites

m  Login to vRealize Automation as an laaS administrator.
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Procedure

)

H W N

8

Select Infrastructure > Endpoints > Endpoints.
Select New > Orchestration > vRealize Orchestrator.
Enter a name and, optionally, a description.

Enter a URL with the fully qualified name or IP address of the vRealize Orchestrator server
and the vRealize Orchestrator port number.

The transport protocol must be HTTPS. If no port is specified, the default port 443 is used.

To use the default vRealize Orchestrator instance embedded in the vRealize Automation
appliance, type https://vrealize-automation-appliance-hostname:443/vco.

Provide your vRealize Orchestrator credentials in the User name and Password text boxes to
connect to the vRealize Orchestrator endpoint.

The credentials you use should have Execute permissions for any vRealize Orchestrator
workflows to call from laaS.

To use the default vRealize Orchestrator instance embedded in the vRealize Automation
appliance, the user name is administrator@vsphere.local and the password is the
administrator password that was specified when configuring SSO.

Enter an integer greater than or equal to 1in Priority text box.
A lower value specifies a higher priority.

(Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

Click OK.

Configuring vRealize Orchestrator Endpoints for Networking

If you are using vRealize Automation workflows to call vRealize Orchestrator workflows, you must
configure the vRealize Orchestrator instance or server as an endpoint.

For information about adding a vRealize Orchestrator endpoint, see Create a vRealize
Orchestrator Endpoint.

You can associate a vRealize Orchestrator endpoint with a machine blueprint to make sure that
all of the vRealize Orchestrator workflows for machines provisioned from that blueprint are run
using that endpoint.

vRealize Automation by default includes an embedded vRealize Orchestrator instance. It is
recommended that you use the embedded instance as your vRealize Orchestrator endpoint for
running vRealize Automation workflows in a production or test environment or when creating a
proof of concept.

It is also recommended that you use this vRealize Orchestrator endpoint for running vRealize
Automation workflows in a production environment.
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The vRealize Orchestrator plug-in is automatically installed with vRealize Orchestrator 7.1 and
later. There is no separate vRealize Orchestrator plug-in to install.

Create a vRealize Operations Manager Endpoint

You can create a vRealize Operations Manager endpoint to connect to a vRealize Operations
Manager host suite API.

For information about validating the vRealize Operations Manager connection and certificate
trust, see Considerations When Using Test Connection.

Prerequisites

m  Login to vRealize Automation as an laaS administrator.

Procedure

1 Select Infrastructure > Endpoints > Endpoints.

2 Select New > Management > vRealize Operations Manager.

3 Enter a name and, optionally, a description.

4 Enter the URL for the vRealize Operations Manager server in the Address text box.
The URL must be of the format: https://hostname/suite-api.

5 Enter your vRealize Operations Manager user name and password credentials.

6 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

7 (Optional) Click Test Connection to validate the credentials, host endpoint address, and
certificate trust. The action also checks that the manager service and agent are running so
that endpoint can be data-collected. The OK action tests for these same conditions.

The Test Connection action returns information about any of the following conditions:
m Certificate error

If the certificate is not found, trusted, or has expired, you are prompted to accept a
certificate thumbprint. If you do not accept the thumbprint, you can still save the endpoint
but machine provisioning might fail.

= Agent error

The associated vSphere agent is not found. The agent must be running for the test to
succeed.

m  Host error

The specified endpoint address is not reachable or the associated manager service is not
running. The manager service must be running for the test to succeed.

m  Credentials error

The specified user name and password combination is invalid for the endpoint at the
specified address.
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= Timeout
The test action could not complete in the allowed two-minute time period.

If the Test Connection action fails, you can still save the endpoint but machine provisioning
might fail.

If there is a trusted certificate issue, for example the certificate has expired, you are
prompted to accept a certificate thumbprint.

8 Click OK.

Create a Third-Party IPAM Provider Endpoint
If you registered and configured a third-party IPAM endpoint type in vRealize Orchestrator, you
can create an endpoint for that IPAM solution provider in vRealize Automation.

If you imported a vRealize Orchestrator package for providing an external IPAM solution and
registered the IPAM endpoint type in vRealize Orchestrator, you can select that IPAM endpoint
type when you create a vRealize Automation endpoint.

Note This example is based on use of the Infoblox IPAM plug-in, which is available for download
at the VMware Solution Exchange. You can also use this procedure if you created your own IPAM
provider package using the VMware-supplied IPAM Solution SDK. The procedure for importing
and configuring your own third-party IPAM solution package is the same as described in the
prerequisites.

The first IPAM endpoint for vRealize Automation is created when you register the endpoint type
for the IPAM solution provider plug-in in vRealize Orchestrator.

Prerequisites

m  Obtain and Import a Third-Party IPAM Provider Package in vRealize Orchestrator.

m  Run Workflow to Register Third-Party IPAM Endpoint Type in vRealize Orchestrator.
m  Login to vRealize Automation as an laaS administrator.

For this example, create an Infoblox IPAM endpoint using an endpoint type that you registered in
vRealize Orchestrator for your third-party IPAM provider plug-in or package.

Procedure
1 Select Infrastructure > Endpoints > Endpoints.
2 Select New > IPAM > IPAM endpoint type.

Select a registered external IPAM provider endpoint type such as Infoblox. External IPAM
provider endpoints are only available if you imported a third-party vRealize Orchestrator
package, and run the package workflows to register the endpoint type.

For Infoblox IPAM, only primary IPAM endpoint types are listed. You can specify secondary
IPAM endpoint types by using custom properties.
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For this example, select a registered external IPAM endpoint type, for example Infoblox
NIOS.

3 Enter a name and, optionally, a description.

4 Enter the location of the registered IPAM endpoint in the Address text box using the
provider-specific URL format, for example https:/host_name/name.

For example, you might create several IPAM endpoints, such as https://nsx62-scale-
infoblox and https://nsx62-scale-infoblox2, when you registered the IPAM endpoint
type in vRealize Orchestrator. Enter a primary registered endpoint type. To also specify one
or more secondary IPAM endpoints, you can use custom properties to emulate the extensible
attributes that are specific to the IPAM solution provider.

5 Enter the user name and password required to access the IPAM solution provider account.

The IPAM solution provider account credentials are required to create, configure, and edit the
endpoint when working in vRealize Automation. vRealize Automation uses the IPAM endpoint
credentials to communicate with the specified endpoint type, for example Infoblox, to
allocate IP addresses and perform other operations. This behavior is similar to how vRealize
Automation uses vSphere endpoint credentials.

6 (Optional) Click Properties and add endpoint properties that are meaningful to the specific
IPAM solution provider.

Each IPAM solution provider, for example Infoblox and Bluecat, use unique extensible
attributes that you can emulate by using vRealize Automation custom properties. For
example, Infoblox uses extensible attributes to differentiate primary and secondary
endpoints.

7 Click OK.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create a Microsoft Azure Endpoint
You can create a Microsoft Azure endpoint to facilitate a credentialed connection between

VRealize Automation and an Azure deployment.

An endpoint establishes a connection to a resource, in this case an Azure instance, that you can
use to create virtual machine blueprints. You must have an Azure endpoint to use as the basis of
blueprints for provisioning Azure virtual machines. If you use multiple Azure subscriptions, you
need endpoints for each subscription ID.

As an alternative, you can create an Azure connection directly from vRealize Orchestrator using
the Add an Azure Connection command located under Library > Azure > Configuration in the
vRealize Orchestrator workflow tree. For most scenarios, creating a connection through the
endpoint configuration as described herein is the preferred option.
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Azure endpoints are supported by vRealize Orchestrator and XaaS functionality. You can create,
delete, or edit an Azure endpoint. Note that if you make any changes to an existing endpoint and
do not run any updates on the Azure portal through the updated connection for several hours,
then you must restart the vRealize Orchestrator service using the service vco-service restart
command. Failure to restart the service may result in errors.

Prerequisites

m  Configure a Microsoft Azure instance and obtain a valid Microsoft Azure subscription from
which you can use the subscription ID. See http://www.vaficionado.com/2016/11/using-new-
microsoft-azure-endpoint-vrealize-automation-7-2/ for more information about configuring
Azure and obtaining a subscription ID.

m  Verify that your vRealize Automation deployment has at least one tenant and one business
group.

m Create an Active Directory application as described in https://azure.microsoft.com/en-us/
documentation/articles/resource-group-create-service-principal-portal.

m  Make note of the following Azure related information, as you will need it during endpoint and
blueprint configuration.

m  subscription ID

m  tenantID

m storage account name

m resource group name

= |ocation

m  virtual network name

m client application ID

m client application secret key
m virtual machine image URN

m  There are unique settings required for creating and deploying cloud applications for Azure in
the China environment. For related information, see https://docs.microsoft.com/en-us/azure/
china/china-get-started-developer-guide. When creating a vRealize Automation Azure
endpoint for China, the service URL, login URL, and storage URL must be specified as follows:

m  Service URL: https://management.chinacloudapi.cn
m  Login URL: https://login.chinacloudapi.cn/
m  Storage URL: https://storage_account_name.blob.core.chinacloudapi.cn/

The vRealize Automation Azure implementation supports a subset of the Microsoft Azure
supported regions. See Azure Supported Regions.

m  Login to vRealize Automation as a tenant administrator.
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Procedure

1 Select Administration > VRO Configuration > Endpoints.

Click the New icon (“i').

On the Plug-in tab, click the Plug-in drop-down menu and select Azure Plug-in.
Click Next.

Enter a name and, optionally, a description.

Click Next.

N o u b~ W N

Populate the text boxes on the Details tab as appropriate for the endpoint.

Parameter Description
Connection settings
Azure Connection

Connection name Unigue name for the new endpoint connection. This
name appears in the vRealize Orchestrator interface to
help you identify a particular connection.

Azure subscription id The identifier for your Azure subscription. The ID defines
the storage accounts, virtual machines and other Azure
resources to which you have access.

Resource manager settings

Azure service URI The URI through which you gain access to your Azure
instance. The default value of https://
management.azure.com/ is appropriate for many typical
implementations.

Azure storage URI The URI through which you gain access to your Azure
storage instance.

Tenant Id The Azure tenant ID that you want the endpoint to use.

Client Id The Azure client identifier that you want the endpoint to
use. This is assigned when you create an Active
Directory application.

Client secret The key used with an Azure client ID. This key is
assigned when you create an Active Directory
application.

Login URL The URL used to access the Azure instance. The default

value of https://login.windows.net/ is appropriate for
many typical implementations.

Proxy Settings

Proxy host If your company uses a proxy Web server, enter the host
name of that server.

Proxy port If your company uses a proxy Web server, enter the port
number of that server.
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8 (Optional) Click Properties and add supplied custom properties, property groups, or your
own custom property definitions.

9 Click Finish.

What to do next

Create appropriate resource groups, storage accounts, and network security groups in Azure.
You should also create load balancers if appropriate for your implementation.

Action Options

Create an Azure resource group m  Create the resource group using the Azure portal. See
the Azure documentation for specific instructions.

m  Use the appropriate vRealize Orchestrator workflow
found under the Library/Azure/Resource/Create
resource group.

m  |In vRealize Automation, create and publish an XaaS
blueprint that contains the vRealize Orchestrator
workflow. You can request the resource group after
attaching it to the service and entitlements. Note that
the Resource Group resource type is not supported or
managed by vRealize Automation.

Create an Azure storage account m  Use Azure to create a storage account. See the Azure
documentation for specific instructions.

m  Use the appropriate vRealize Orchestrator workflow
found under Library/Azure/Storage/Create storage
account.

B |n vRealize Automation, create and publish an XaaS
blueprint that contains the vRealize Orchestrator
workflow. You can request the storage account after
attaching it to the service and entitlements.

Create an Azure network security group m  Use Azure to create a security group. See the Azure
documentation for specific instructions.

m  Use the appropriate vRealize Orchestrator workflow
found under the Library/Azure/Network/Create
Network security group.

® |In vRealize Automation, create and publish an XaaS
blueprint that contains the vRealize Orchestrator
workflow. You can request the security group after
attaching it to the service and entitlements.

Azure Supported Regions
The vRealize Automation Azure implementation supports a subset of the Microsoft Azure
supported regions.

The following Azure regions are supported by the Azure implementation within vRealize
Automation.
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B East Asia ®  Australia East

B Southeast Asia B Australia Southeast
m  Central US ®  South India

m  EastUS ®  Central India

m EastUS2 m  West India

m West US m  Canada Central
. West US 2 m Canada East

m  North Central US m  West Central US
m  South Central US m  Korea Central

m North Europe m  Korea South

m  West Europe m UK West

m  Japan West m UK South

m  Japan East m  China East

m  Brazil South m  China North

Create a Puppet Endpoint
You can create a Puppet endpoint to support addition of Puppet configuration management

components to vSphere virtual machines. These components enable you to use a Puppet Master
to enforce configuration management on virtual machines.

An endpoint establishes a connection to an external resource, in this case a Puppet Master
instance. The endpoint enables you to place Puppet configuration management components on
vSphere virtual machine blueprints. Provisioned virtual machines based on these blueprints
contain a Puppet agent that facilitates control by the associated Puppet Master.

For more information about the Puppet plug-in and a demo of its configuration, see https://
www.youtube.com/watch?v=P-VglzE9o0-o0.

Prerequisites
m Install and configure Puppet Enterprise as appropriate for your environment.

m  Download and install the Puppet plug-in version 3.0 on your vRealize Orchestrator
deployment. You can download the plug-in from https://marketplace.vmware.com/vsx/
solutions/puppet-plugin-for-vrealize-automation?ref=search. See https://
docs.puppet.com/pe/latest/vro_intro.html for information about installing and using the plug-
in.

Procedure

1 Select Administration > vRO Configuration > Endpoints.

Click the New icon (“i').
On the Plug-in tab, click the Plug-in drop-down menu and select Puppet Plug-in.
Click Next.

Enter a name and, optionally, a description.

o u h~h W N

Click Next.
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7 Populate the text boxes on the Details tab as appropriate for the endpoint.

Parameter

Display name for this Puppet Master

Hostname or IP address

SSH Port

SSH RBAC and Username

SSH and RBAC Password

Use sudo for shell commands on this master?

8 Click OK.

Results

Description

The name of the Puppet Master associated with the
endpoint connection . This name appears in the vRealize
Orchestrator interface to help you identify a particular
connection.

The FQDN or IP address of the Puppet Master used by
this endpoint.

The port defined for use with secure communication for
this Puppet Master.

The role based access control username required to
connect with the Puppet Master.

The role based access control username required for
secure configuration with the Puppet Master.

Select this option if you want administrators to be able to
use Sudo commands on Linux servers for security
options on virtual machines based on this endpoint..

You can now add Puppet configuration management components to vSphere blueprints so that
you can deploy vSphere virtual machines that contain Puppet agents.

Create a Hyper-V (SCVMM) Endpoint
You can create endpoints to allow vRealize Automation to communicate with your SCVMM
environment and discover compute resources, collect data, and provision machines.

Prerequisites

Log in to vRealize Automation as an laaS administrator.

You must install and configure a DEM agent to manage your Hyper-V (SCVYMM) endpoint. For
information, see SCVMM requirements information in the Installing vRealize Automation.

For related information, see Preparing Your SCVMM Environment.

Procedure

1

2
3
4
5

Select Infrastructure > Endpoints > Endpoints.
Select New > Virtual > Hyper-V (SCVMM).

Enter a name in the Name text box.

(Optional) Enter a description in the Description text box.

Enter the URL for the endpoint in the Address text box.

The URL must be of the type: FQDN or IP_address.

For example: mycompany—scvmml.mycompany.local.
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6 Enter the administrative-level user name and password that you stored for this endpoint.
If you did not already store the credentials, you can do so now.

7 (Optional) Click Properties and add supplied custom properties, property groups, or your
own property definitions for the endpoint.

8 Click OK.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create an OpenStack Endpoint
You create an endpoint to allow vRealize Automation to communicate with your OpenStack

instance.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m  Verify that your vRealize Automation DEMs are installed on a machine that meets the
OpenStack or PowerVC requirements. See Installing vRealize Automation.

m  Verify that your flavor of OpenStack is currently supported. See vRealize Automation
Support Matrix.

After you upgrade or migrate from an earlier vRealize Automation installation, if data collection
fails for OpenStack endpoints you can add the
VMware.Endpoint.Openstack.IdentityProvider.Domain.Name custom property to each
Keystone V3 OpenStack endpoint to specify a valid domain name and enable data collection.

Procedure

1 Select Infrastructure > Endpoints > Endpoints.
2 Select New > Cloud > OpenStack.

3 Enter a name and, optionally, a description.

4

Enter the URL for the endpoint in the Address text box.

Option Description

PowerVC The URL must be of the format http://myPowerVC.com:5000 or
http://FQDN:5000.

Openstack The URL must be of the format FQDN:5000 or IP_address:5000. Do not
include the /v2.0 suffix in the endpoint address.
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5 Enter your administrative-level user name and password.

The credentials you provide must have the administrator role in the OpenStack tenant
associated with the endpoint.

6 Enter an OpenStack tenant name in the OpenStack project text box.

If you set up multiple endpoints with different OpenStack tenants, create reservation policies
for each tenant. This ensures that machines are provisioned to the appropriate tenant
resources.

7 Click Properties and add supplied custom properties, property groups, or your own property
definitions for the endpoint.

If Keystone V3 is in effect, add the
VMware.Endpoint.Openstack.IdentityProvider.Domain.Name custom property to designate
a specific domain.

8 Click OK.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Create a Hyper-V, XenServer, or Xen Pool Endpoint
You can create endpoints to allow vRealize Automation to communicate with the Hyper-V,

XenServer, or Xen pool main environment and discover compute resources, collect data, and
provision machines.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m A system administrator must install a proxy agent with stored credentials that correspond to
your endpoint. See Installing vRealize Automation.

Procedure
1 Select Infrastructure > Endpoints > Agents.

2 Enter the fully qualified DNS name of your Hyper-V server, Xen server, or Xen main pool in
the Compute resource text box.

Note For a Xen pool endpoint, you must enter the name of the main pool. To avoid duplicate
entries in the vRealize Automation compute resource table, specify an address that matches
the configured Xen pool main address. For example, if the Xen pool main address uses the
host name, enter the host name and not the FQDN. If the Xen pool main address uses FQDN,
then enter the FQDN.
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3 Select the proxy agent that your system administrator installed for this endpoint from the
Proxy agent name drop-down menu.

4 (Optional) Enter a description in the Description text box.

5 Click OK.

Results

vRealize Automation collects data from your endpoint and discovers your compute resources.

What to do next

Add the compute resources from your endpoint to a fabric group. See Create a Fabric Group.

Considerations When Using Test Connection

You can use a test connection action to validate the credentials, host endpoint address, and
certificate for a vSphere, NSX, or vRealize Operations Manager endpoint.

The action also checks that the manager service and agent are running so that endpoint can be
data-collected.

The Test Connection action returns information about any of the following conditions:
m Certificate error

If the certificate is not found, trusted, or has expired, you are prompted to accept a certificate
thumbprint. If you do not accept the thumbprint, you can still save the endpoint but machine
provisioning might fail.

= Agent error

The associated vSphere agent is not found. The agent must be running for the test to
succeed.

m  Host error

The specified endpoint address is not reachable or the associated manager service is not
running. The manager service must be running for the test to succeed.

m  Credentials error

The specified user name and password combination is invalid for the endpoint at the
specified address.

= Timeout
The test action could not complete in the allowed two-minute time period.

If you receive errors when running Test Connection on upgraded or migrated endpoints, see
Considerations When Working With Upgraded or Migrated Endpoints for steps needed to
establish certificate trust.
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Import or Export Endpoints Programmatically

To programmatically import and export endpoints in vRealize Automation 7.3 or later you must
use either new vRealize Automation endpoint-configuration-service REST APIs or use vRealize
CloudClient.

The vRealize CloudClient documentation contains all applicable command line formatting,
samples, and usage information.

You can download the vRealize CloudClient application and documentation from the vRealize
CloudClient product page of the https://developercenter.vmware.com/tool/cloudclient.

Viewing Endpoint Sources and Running Data Collection

You can view the machine and compute resource that is associated with a specific endpoint. You
can also manually start data collection.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m  Verify that at least one endpoint exists.

Procedure
1 Select Infrastructure > Endpoints > Endpoints.
2 Select an existing endpoint row and click Actions.

Select any one of the following available actions.

m Click View Compute Resources to open the Infrastructure > Compute Resource page.
You can use this page to view and edit compute resource settings.

m Click View Machines to open the Infrastructure > Managed Machines page.
m Click Data Collection to open the Data Collection page and start data collection for the
endpoint. You can refresh the page to display the current status of the request.
Considerations When Working With Upgraded or Migrated Endpoints

After you upgrade or migrate from a pre-vRealize Automation 7.3 release, the following
considerations are important to understand and act on.

This information applies to endpoints that were upgraded or migrated to this vRealize
Automation release.

= When you upgrade or migrate from a pre-vRealize Automation 7.3 release, each vCloud Air,
vCloud Director, and Amazon endpoint that contains proxy settings is associated to a new
proxy endpoint that contains its proxy settings.
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After upgrade or migration, the new Proxy endpoint name is Proxy_YYYYY where YYYYYis a
hash of the proxy's URL, port, and credentials. If you used the same proxy settings (for
example the same URL, port, and credentials) for a different endpoint (for example, a vCloud
Air or Amazon endpoint), after upgrade or migration there is only one Proxy endpoint and an
association between the vCloud Air and Amazon endpoint and the new Proxy endpoint. A
proxy endpoint can be associated to more than one Amazon, vCloud Air or vCloud Director
endpoint.

. When you upgrade or migrate vSphere endpoints that contain NSX manager settings, each
vSphere endpoint is associated to a new NSX endpoint that contains its NSX manager
settings.

After upgrade or migration, the NSX endpoint name is NSX_XXXXX where XXXXX is the
name of the parent vSphere endpoint in the pre-vRealize Automation 7.3 release.

= When vRealize Automation upgrade or migration is finished, an infrastructure administrator
can change the new NSX and Proxy endpoint names.

m  The default security setting for upgraded or migrated endpoints is not to accept untrusted
certificates.

m  After upgrading or migrating from an earlier vRealize Automation installation, if you were
using untrusted certificates you must perform the following steps for all vSphere and NSX
endpoints to enable certificate validation. Otherwise, the endpoint operations fail with
certificate errors. For more information, see VMware Knowledge Base articles Endpoint
communication is broken after upgrade to vRA 7.3 (2150230) at http://kb.vmware.com/kb/
2150230 and How to download and install vCenter Server root certificates to avoid Web
Browser certificate warnings (2108294) at http://kb.vmware.com/kb/2108294.

a After upgrade or migration, log in to the vRealize Automation vSphere agent machine and
restart your vSphere agents by using the Services tab.

Migration might not restart all agents, so manually restart them if needed.

b Wait for at least one ping report to finish. It takes a minute or two for a ping report to
finish.

¢ When the vSphere agents have started data collection, log in to vRealize Automation as
an laaS administrator.

d Click Infrastructure > Endpoints > Endpoints.
e Edit a vSphere endpoint and click Test Connection.
f If a certificate prompt appears, click OK to accept the certificate.

If a certificate prompt does not appear, the certificate might currently be correctly stored
in a trusted root authority of the Windows machine hosting service for the endpoint, for
example as a proxy agent machine or DEM machine.

g Click OK to apply the certificate acceptance and save the endpoint.

h Repeat this procedure for each vSphere endpoint.
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i Repeat this procedure for each NSX endpoint.

If the Test Connection action is successful but some data collection or provisioning
operations fail, you can install the same certificate on all the agent machines that serve the
endpoint and on all DEM machines. Alternatively, you can uninstall the certificate from
existing machines and repeat the preceding procedure for the failing endpoint.

The vRealize Automation REST APIs that were used to programmatically create, edit, and
delete endpoints in vRealize Automation 7.2 and earlier are no longer supported in vRealize
Automation 7.3 and later. To programmatically create, edit, and delete endpoints in vRealize
Automation 7.3 or later you must use either new vRealize Automation endpoint-
configuration-service REST APIs or use vRealize CloudClient.

After you upgrade or migrate from an earlier vRealize Automation installation, if data
collection fails for OpenStack endpoints you can add the
VMware.Endpoint.Openstack.IdentityProvider.Domain.Name custom property to each
Keystone V3 OpenStack endpoint to specify a valid domain name and enable data collection.

When you upgrade a third-party IPAM endpoint, such as Infoblox IPAM, the vRealize
Orchestrator package that contains the RegisterIPAMEndpoint workflow is upgraded. You
might need to rerun the workflow in vRealize Orchestrator when the vRealize Automation
upgrade is finished.

To make a credentials change to multiple endpoints, you can either edit the endpoints
individually or use vRealize CloudClient to perform a bulk update.

Some endpoint types, such as vCloud Air and vCloud Director, cannot be upgraded or
migrated directly from vRealize Automation 6.2.x to vRealize Automation 7.3 or greater.

After a successful upgrade or migration to vRealize Automation 7.3, if the Infrastructure >
Endpoints page does not show any endpoints or only shows some endpoint types and
endpoints, see Knowledge Base Article 2150252 for a suggested workaround.

Considerations When Deleting Endpoints

You can delete certain endpoint types under certain conditions.

You can delete endpoints that have not been data-collected.

You can delete an OpenStack, Amazon and VRO endpoint if it has been data collected, but
has no reservations. Other endpoint types cannot be deleted if they have been data
collected.

You can delete a third-party IPAM endpoint if it has no association to a network profile.
When deleting a vSphere endpoint, the confirmation prompt lists the following dependencies:
m  The endpoint has been data-collected.

m  The endpoint is referenced in a reservation that maps to a compute resource. You cannot
delete an endpoint is referenced in a reservation. Reservations require a compute
resource.
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m  The endpoint contains a template that is referenced in an existing blueprint.
The blueprint is not deleted when you delete the endpoint.
m  The endpoint is used by virtual machines that are in use.

m  You can delete endpoints programmatically by using either the new CREATE, EDIT, and
DELETE vRealize Automation endpoint-configuration-service REST APIs introduced in
vRealize Automation 7.3 or by using vRealize CloudClient. You cannot delete endpoints by
using the pre-vRealize Automation 7.3 endpoint-configuration-service REST APIs.

Troubleshooting Attached vSphere Endpoint Cannot be Found

When data collection fails for a vSphere endpoint, it can be due to a mismatch between the
proxy name and the endpoint name.

Problem

Data collection fails for a vSphere endpoint. The log messages return an error similar to the
following:

This exception was caught: The attached endpoint
'vCenter' cannot be found.
Cause

The endpoint name you configure in vRealize Automation must match the endpoint name
provided to the vSphere proxy agent during installation. Data collection fails for a vSphere
endpoint if there is a mismatch between the endpoint name and the proxy agent name. Until an
endpoint with a matching name is configured, the log messages return an error similar to the
following:

This exception was caught: The attached endpoint
'expected endpoint name' cannot be found.
Solution
1 Select Infrastructure > Monitoring > Log.
2 Look for an Attached Endpoint Cannot be Found error message.

For example,

This exception was caught: The attached endpoint
'expected endpoint name' cannot be found.

3 Edit your vSphere endpoint to match the expected endpoint name shown in the log message.
a Select Infrastructure > Endpoints > Endpoints.

b Click the name of the endpoint to edit.
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¢ Enter the expected endpoint name in the Name text box.

d Click OK.
Solution

The proxy agent can commute with the endpoint and data collection is successful.

Create a Fabric Group

You can organize infrastructure resources into fabric groups and assign one or more fabric
administrators to manage the resources in the fabric group.

Fabric groups are required for virtual and cloud endpoints. You can grant the fabric administrator
role to multiple users by either adding multiple users one at a time or by choosing an identity
store group or custom group as your fabric administrator.

Prerequisites
m  Login to vRealize Automation as an laaS administrator.

m Create at least one endpoint. See Choosing an Endpoint Scenario.

Procedure

)

Select Infrastructure > Fabric Groups.
Click New Fabric Group.
Enter a name in the Name text box.

(Optional) Enter a description in the Description text box.

a b~ W N

Enter a user name or group name in the Fabric administrators text box and press Enter.
Repeat this step to add multiple users or groups to the role.
6 Click one or more Compute resources to include in your fabric group.

Only resources that exist on the clusters you select for your fabric group are discovered
during data collection. For example, only templates that exist on the clusters you select are
discovered and available for cloning on reservations you create for business groups.

7 Click OK.

Results
Fabric administrators can now configure machine prefixes. See Configure Machine Prefixes.

Users who are currently logged in to the vRealize Automation must log out and log back in to the
vRealize Automation before they can navigate to the pages to which they have been granted
access.
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Configure Machine Prefixes

You can create machine prefixes that are used to create names for machines provisioned
through vRealize Automation. A machine prefix is required when defining a machine component
in the blueprint design canvas.

A prefix is a base name to be followed by a counter of a specified number of digits. When the
digits are all used, vRealize Automation rolls back to the first number.

Machine prefixes must conform to the following limitations:

m  Contain only the case-insensitive ASCII letters a through z, the digits O through 9, and the
hyphen (-).

= Not begin with a hyphen.
m  No other symbols, punctuation characters, or blank spaces can be used.

= No longer than 15 characters, including the digits, to conform to the Windows limit of 15
characters in host names.

Longer host names are truncated when a machine is provisioned, and updated the next time
data collection is run. However, for WIM provisioning names are not truncated and
provisioning fails when the specified name is longer than 15 characters.

m  VRealize Automation does not support multiple virtual machines of the same name in a single
instance. If you choose a naming convention that causes an overlap in machine names,
vRealize Automation does not provision a machine with the redundant name. If possible,
vRealize Automation skips the name that is already in use and generates a new machine
name using the specified machine prefix. If a uniqgue name cannot be generated, provisioning
fails.

Prerequisites

Log in to vRealize Automation as a fabric administrator.

Procedure

1 Click Infrastructure > Administration > Machine Prefixes.
2 Click New.

3 Enter the machine prefix in the Name text box.

4

Specify if the machine prefix is displayed in all tenants or only in the current tenant in the
Visibility column.

Ul

Enter the number of counter digits in the Number of Digits text box.

6 Enter the counter start number in the Next Number text box.

7 Click the Save icon (@).
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Results

Tenant administrators can create business groups so that users can access vRealize Automation
to request machines.

Creating a Network Profile

A network profile contains IP information such as gateway, subnet, and address range. vRealize
Automation uses vSphere DHCP or a specified IPAM provider to assign IP addresses to the
machines it provisions.

You can create a network profile to define a type of available network, including external
network profiles and templates for on-demand network address translation (NAT) and routed
network profiles that build NSX logical switches and appropriate routing settings for a new
network path. Network profiles are required when adding network components to a blueprint.

Network profiles are used to configure network settings when machines are provisioned.
Network profiles also specify the configuration of NSX Edge devices that are created when you
provision machines. You identify a network profile when you create reservations and blueprints.
In a reservation, you can assign a network profile to a network path and specify any one of those
paths for a machine component in a blueprint.

A blueprint creator specifies an appropriate network profile when defining network components
in the blueprint. You can use an existing network profile and an on-demand NAT or routed
network profile as you define network adapters and load balancers for the provisioning machine.

Network profiles also support third party IP Address Management (IPAM) providers, such as
Infoblox. When you configure a network profile for IPAM, your provisioned machines can obtain
their IP address data, and related information such as DNS and gateway, from the configured
IPAM solution. You can use an external IPAM package for a third party provider, such as Infoblox,
to define an IPAM endpoint for use with a network profile.

Note If you are using a third-party IPAM provider and want to specify on which network to
deploy your machine, use a separate network profile for each VLAN to avoid the known issue
described in Knowledge Base Article 2148656.

If you do not use a third-party IPAM provider, but instead use the vRealize Automation-supplied
IPAM endpoint, you can specify the ranges of IP addresses that network profiles can use. Each IP
address in the specified ranges that are allocated to a machine is reclaimed for reassignment
when the machine is destroyed. You can create a network profile to define a range of static IP
addresses that can be assigned to machines. When provisioning virtual machines by cloning or
by using kickstart/autoYaST provisioning, the requesting machine owner can assign static IP
addresses from a predetermined range.
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You can assign a network profile to a specific network path on a reservation. For some machine
component types, such as vSphere, you can assign a network profile when you create or edit
blueprints.

Note While you cannot change the network profile of a deployed virtual machine, you can
change the network to which the VM is connected. If the network is associated to a different
network profile, vRealize Automation assigns an IP address from that network profile to the VM.
However the VM continues to use the old IP address until you update the IP address on the guest
operating system. Alternatively you can use the Reconfigure action on the deployed VM, which
also requires you to update the IP address on the guest operating system.

If you specify a network profile in a reservation and a blueprint, the blueprint value takes
precedence. For example, if you specify a network profile in the blueprint by using the
VirtualMachine.NetworkN.ProfileName custom property and in a reservation that is used by the
blueprint, the network profile specified in the blueprint takes precedence. However, if the custom
property is not used in the blueprint, and you select a network profile for a machine NIC, vRealize
Automation uses the reservation network path for the machine NIC for which the network profile
is specified.

For more information about these network types, see NSX Administration Guide in the NSX
Information Center at https://www.vmware.com/support/pubs/nsx_pubs.html.
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Table 2-14. Available Network Types for a vRealize Automation Network Profile

Network Type Description

External Existing network configured on the vSphere server. They are the external part of the NAT and routed
networks types. An external network profile can define a range of static IP addresses available on the
external network.

You can use IP ranges obtained from the supplied VMware IPAM endpoint or from a third-party IPAM
service provider endpoint that you have registered and configured in vRealize Orchestrator, such as
Infoblox IPAM. An IP range is created from an IP block during allocation.

An external network profile with a static IP range is a prerequisite for NAT and routed networks.

See Creating an External Network Profile For an Existing Network.

NAT On-demand network created during provisioning. NAT networks that use one set of IP addresses for
external communication and another set for internal communications.

With one-to-one NAT networks, every virtual machine is assigned an external IP address from the
external network profile and an internal IP address from the NAT network profile. With one-to-many
NAT networks, all machines share a single IP address from the external network profile for external
communication.

You can use IP ranges obtained from the supplied VMware IPAM endpoint or from a third-party IPAM
service provider endpoint that you have registered and configured in vRealize Orchestrator, such as
Infoblox IPAM. An IP range is created from an IP block during allocation.

A NAT network profile defines local and external networks that use a translation table for mutual
communication.

See Creating a NAT Network Profile For an On-Demand Network.
Routed On-demand network created during provisioning. Routed networks contain a routable IP space
divided across subnets that are linked together using Distributed Logical Router (DLR).

Every new routed network has the next available subnet assigned to it and is associated with other
routed networks that use the same network profile. The virtual machines that are provisioned with
routed networks that have the same routed network profile can communicate with each other and the
external network.

You can use IP ranges obtained from the supplied VMware IPAM endpoint or from a third-party IPAM
service provider endpoint that you have registered and configured in vRealize Orchestrator, such as
Infoblox IPAM. An IP range is created from an IP block during allocation.

A routed network profile defines a routable space and available subnets.

See Creating a Routed Network Profile For an On-Demand Network.

Using Network Profiles to Control IP Address Ranges

You can use network profiles to assign static IP addresses from a predefined range to virtual
machines that are provisioned by cloning, by using Linux kickstart or autoYaST, or to cloud
machines that are provisioned in OpenStack by using kickstart.

By default, vRealize Automation uses Dynamic Host Configuration Protocol (DHCP) to assign IP
addresses to provisioned machines.

You can create network profiles to define a range of static IP addresses that you can assign to
machines. You can assign network profiles to specific network paths on a reservation. Machines
that are provisioned by cloning or by kickstart or autoYaST and are attached to a network path
with an associated network profile are provisioned with an assigned static IP address. For
provisioning with a static IP address assignment, you must use a customization specification.
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You can assign a network profile to a vSphere machine component in a blueprint by adding an
existing, on-demand NAT, or on-demand routed network component to the design canvas and
selecting a network profile to which to connect the vSphere machine component. You can also
assign network profiles to blueprints by using the custom property
VirtualMachine.NetworkN.ProfileName, where N is the network identifier.

You can optionally use the supplied vRealize Automation IPAM or a registered and configured
third-part IPAM service provider endpoint in your network profile to obtain and configure IP
addresses. For information about external IPAM requirements, see Checklist For Providing Third-
Party IPAM Provider Support.

When you select a third-party IPAM service provider endpoint in a network profile, vRealize
Automation retrieves IP ranges from the registered external IPAM provider endpoint, such as
Infoblox. It then allocates IP values from that endpoint. The specified range subnet mask is used
to allocate subnets from the IP block.

If you specify a network profile in a reservation and a blueprint, the blueprint value takes
precedence. For example, if you specify a network profile in the blueprint by using the
VirtualMachine.NetworkN.ProfileName custom property and in a reservation that is used by the
blueprint, the network profile specified in the blueprint takes precedence. However, if the custom
property is not used in the blueprint, and you select a network profile for a machine NIC, vRealize
Automation uses the reservation network path for the machine NIC for which the network profile
is specified.

Understanding CSV File Format for Importing Network Profile IP Addresses

You can import IP address network ranges to a vRealize Automation network profile by using a
properly formatted CSV file.

The CSV file entries must adhere to the following format.

CSV Field Description
ip_address An IP address in IPv4 format.

machine_name Name of a managed machine in vRealize Automation. If the field is empty, the default is no name. If the
field is empty, the status field value cannot be Allocated.

status Allocated or Unallocated, case-sensitive. If the field is empty, the default value is Unallocated. If the
status is Allocated, the machine_name field cannot be empty.

NIC_offset A non-negative integer. Optional.
The following example entry does not specify a NIC offset:
100.10.100.1,mymachine01,Allocated

Import IP Addresses To a Network Profile From a CSV File
You can add IP addresses to a network profile range by importing a properly formatted CSV file.

You can also change the addresses in the network profile range by editing the range in vRealize
Automation or by importing a changed or different CSV file.
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You can add or change the IP addresses in a network profile range by importing from a CSV file
or by entering values manually. Alternatively, you can allow a third-party IPAM provider to supply
IP addresses.

m  Import an initial range of IP addresses into a vRealize Automation network profile.
= Apply the imported values to create our first named network range in the network profile.
m  Delete one or more IP addresses from the network range vRealize Automation.

= Import a changed or different CSV file to examine how the network range values are
changed.

You cannot use the Import from CSV option for network profiles that use a third-party IPAM
endpoint because the IP addresses are managed by the third-party IPAM provider, not by
vRealize Automation.

Prerequisites
m  Login to vRealize Automation as a fabric administrator.

m Create a CSV file containing IP addresses for import to a network range. See Create an
External Network Profile by Using A Third-Party IPAM Provider and Understanding CSV File
Format for Importing Network Profile IP Addresses.

Procedure
1 Select Infrastructure > Reservations > Network Profiles.
2 Click New and select a network profile type from the drop-down menu.
For this example, select External.
3 Enter My Network Profile with CSV in the Name text box.
4 Enter Testing network range IP addresses with CSV in the Description text box.

The CSV file import option applies to settings on the Network Ranges and IP Addresses tab
pages. so we will move quickly through the first two tabs to enter basic network profile
information.

Optionally select a configured IPAM endpoint if you have one available. If not, skip this step.
Enter an appropriate IP address value in the Subnet mask and Gateway text boxes.

Click the DNS tab.

0 N o u

Enter applicable information such as a DNS suffix and click the Network Ranges tab.
The Import from CVS option is available when you click the Network Ranges tab.

9 Click New to enter a new network range name and IP address range manually or click Import
from CSV to import the IP address information from a properly formatted CSV file.

m  Click New.

a Enter a network range name.
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b Enter a network range description.

¢ Enter the start IP address of the range.

d Enter the end IP address of the range.
m  Click Import from CSV.

a Browse to and select the CSV file or drag the CSV file into the Import from CSV
dialog box.

A row in the CSV file has the format ip_address, machine_name, status, NIC offset.
For example:

100.10.100.1,mymachine®1,Allocated

CSV Field Description
ip_address An IP address in IPv4 format.

machine_name Name of a managed machine in vRealize Automation. If the field is empty, the default is no
name. If the field is empty, the status field value cannot be Allocated.

status Allocated or Unallocated, case-sensitive. If the field is empty, the default value is
Unallocated. If the status is Allocated, the machine_name field cannot be empty.

NIC_offset A non-negative integer. Optional.

b Click Apply.

10 Click OK.

1"

12

The IP range name appears in the defined ranges list. The IP addresses in the range appear in
the defined IP addresses list.

The uploaded IP addresses appear on the IP Addresses page when you click Apply or after
you save and then edit the network profile.

Click the IP Addresses tab to display the IP address data for the specified range address
space.

If you imported the IP address information from a CSV file, the range name is generated as
Imported from CSV.

(Optional) Select IP address information from the Network range drop-down menu to filter IP
address entries.

You can display information about all defined network ranges, the network ranges imported
from a CSV file, or a named network range. Details include the start IP address, machine
name, last modification date and timestamp, and IP status.

What to do next

If you import IP addresses from a CSV file again, the previous IP addresses are replaced with the
information from the imported CSV file.
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Creating an External Network Profile For an Existing Network

You can create external network profiles to specify network settings to configure existing
networks for provisioning machines, including the configuration of NSX Edge devices to be used
during provisioning.

You can use the supplied vRealize Automation IPAM provider endpoint or a third-party IPAM

provider endpoint, such as Infoblox, that you have registered in vRealize Orchestrator.
Create an External Network Profile By Using the Supplied IPAM Endpoint
You can create an external network profile to define network properties and a range of static IP

addresses for use when provisioning machines on an existing network.

You can define one or more network ranges of static IP addresses in the network profile for use
in provisioning a machine. If you do not specify a range, you can use a network profile as a
network reservation policy to select a reservation network path for a virtual machine network
card (vNIC).

For information about creating an external network profile and using an external IPAM provider
endpoint, see Create an External Network Profile by Using A Third-Party IPAM Provider.

Procedure

1 Specify External Network Profile Information By Using the Supplied IPAM Endpoint

An external network profile identifies network properties and settings for an existing
network. An external network profile is a requirement of NAT and routed network profiles.

2 Configure External Network Profile IP Ranges By Using the Supplied IPAM Endpoint

You can define one or more network ranges of static IP addresses in the network profile for
use in provisioning a machine. If you do not specify a range, you can use a network profile
as a network reservation policy to select a reservation network path for a virtual machine
network card (vNIC).

What to do next

You can assign a network profile to a network path in a reservation or a blueprint architect can
specify the network profile in a blueprint. You can use the external network profile when you
create an on-demand NAT or routed network profile.

Specify External Network Profile Information By Using the Supplied IPAM Endpoint
An external network profile identifies network properties and settings for an existing network. An
external network profile is a requirement of NAT and routed network profiles.

For information about how you can create an external network profile by obtaining IPAM address
information from a registered third-party IPAM endpoint such as Infoblox, see Checklist For
Providing Third-Party IPAM Provider Support and Create an External Network Profile by Using A
Third-Party IPAM Provider. Use the following procedure to create a network profile by using the
VMware internal IPAM endpoint.

Prerequisites

m  Login to vRealize Automation as a fabric administrator.
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Procedure

1 Select Infrastructure > Reservations > Network Profiles.

2 Click New and select Existing or External from the drop-down menu.

3 Enter a name and, optionally, a description.

4 Accept the default IPAM endpoint value for the supplied vRealize Automation IPAM
endpoint.

5 Enter an IP subnet mask in the Subnet mask text box.
The subnet mask specifies the size of the entire routable address space that you want to
define for your network profile.
For example, enter 255.255.0.0.

6 Enter an Edge or routed gateway address in the Gateway text box.
Use a standard IPv4 address format. For example, enter 10.10.110.1.
The gateway IP address defined in the network profile is assigned to the NIC during
allocation. If no value is assigned in the Gateway text box in the network profile, then you
must use the VirtualMachine.Network0.Gateway custom property when provisioning the
Edge machine.

7 Click the DNS tab.

8 Enter DNS and WINS values as needed.

DNS values are used for DNS name registration and resolution. The DNS and WINS fields are

optional if you are using an internal IPAM endpoint. If you are using an external IPAM
endpoint, the DNS and WINS values are provided by the third-party IPAM provider.

a (Optional) Enter a Primary DNS server value.

b (Optional) Enter a Secondary DNS server value.
c (Optional) Enter a DNS suffixes value.

d (Optional) Enter a DNS search suffixes value.

e (Optional) Enter a Preferred WINS server value.

f  (Optional) Enter an Alternate WINS server value.

What to do next

You can configure IP ranges for static IP addresses. See Configure External Network Profile IP
Ranges By Using the Supplied IPAM Endpoint.

Configure External Network Profile IP Ranges By Using the Supplied IPAM Endpoint
You can define one or more network ranges of static IP addresses in the network profile for use
in provisioning a machine. If you do not specify a range, you can use a network profile as a
network reservation policy to select a reservation network path for a virtual machine network
card (vNIC).
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You can define IP range values manually, from an imported CSV file, or by using IP addresses
supplied by an external IPAM provider. You can combine manually defined IP ranges and IP
addresses imported via CSV. For example, you can define some ranges by using the user
interface and others by importing from a CSV file.

If you import from a CSV file a second time, regardless of the CSV file name, the IP ranges
imported from the previous CSV file import are erased and the new IP range information is
added. Thus the previous import is overwritten when you import a second or more time. You can
repeat the process of updating a CSV file and re-importing that CSV file into the network profile
indefinitely.

If an external network profile does not have IP ranges defined, you can use it to specify which
network is picked for a virtual network card (vNIC). If you are using the existing network profile in
a routed or NAT network profile, it must have at least one static IP range.

Prerequisites

Specify External Network Profile Information By Using the Supplied IPAM Endpoint.

Procedure
1 Click the Network Ranges tab.

2 Click New to enter a new network range name and IP address range manually or click Import
from CSV to import the IP address information from a properly formatted CSV file.

m  Click New.
a Enter a network range name.
b Enter a network range description.
c Enter the start IP address of the range.
d Enter the end IP address of the range.
m  Click Import from CSV.

a Browse to and select the CSV file or drag the CSV file into the Import from CSV
dialog box.

A row in the CSV file has the format ip_address, machine_name, status, NIC offset.
For example:

100.10.100.1,mymachine®1,Allocated

CSV Field Description
ip_address An IP address in IPv4 format.

machine_name Name of a managed machine in vRealize Automation. If the field is empty, the default is no
name. If the field is empty, the status field value cannot be Allocated.
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CSV Field Description

status Allocated or Unallocated, case-sensitive. If the field is empty, the default value is
Unallocated. If the status is Allocated, the machine_name field cannot be empty.

NIC_offset A non-negative integer. Optional.

b Click Apply.
Click OK.

The IP range name appears in the defined ranges list. The IP addresses in the range appear in
the defined IP addresses list.

The uploaded IP addresses appear on the IP Addresses page when you click Apply or after
you save and then edit the network profile.

Click the IP Addresses tab to display the IP address data for the specified range address
space.

If you imported the IP address information from a CSV file, the range name is generated as
Imported from CSV.

(Optional) Select IP address information from the Network range drop-down menu to filter IP
address entries.

You can display information about all defined network ranges, the network ranges imported
from a CSV file, or a named network range. Details include the start IP address, machine
name, last modification date and timestamp, and IP status.

(Optional) Select a status type from the IP status drop-down menu to filter IP address entries
to only those that match the selected IP status. Status settings are allocated, unallocated,
destroyed, and expired.

For IP addresses that are in an expired or destroyed state, you can click Reclaim to make
those IP address ranges available for allocation. You must save the profile for the reclamation
to take effect. Addresses are not reclaimed immediately, so the status column does not
immediately change from Expired or Destroyed to Allocated.

Click OK to complete the network profile.

Results

You can assign a network profile to a network path in a reservation or a blueprint architect can
specify the network profile in a blueprint. If you created an external network profile, you can use
the external network profile when creating a NAT or routed network profile.

Create an External Network Profile by Using A Third-Party IPAM Provider

You can use a third-party IPAM provider solution that you have imported, configured, and
registered in vRealize Orchestrator to obtain IP addresses from that third-party provider.

You can create an external network profile that uses a registered third-party IPAM solution
provider endpoint to obtain gateway, subnet mask, and DHCP/WINS settings.
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You can define one or more network ranges of static IP addresses in the network profile for use
in provisioning a machine. If you do not specify a range, you can use a network profile as a
network reservation policy to select a reservation network path for a virtual machine network
card (vNIC).

For information about how to create an external network profile without using an IPAM provider
or by using the supplied internal IPAM provider endpoint, see Create an External Network Profile
By Using the Supplied IPAM Endpoint.

Procedure

1 Specify External Network Profile Information By Using a Third-Party IPAM Endpoint

An external network profile identifies network properties and settings for an existing
network. An external network profile is a requirement of NAT and routed network profiles. If
you registered and configured an IPAM endpoint in vRealize Orchestrator, you can specify
that IP address information be supplied by an IPAM provider.

2 Configure External Network Profile IP Ranges By Using a Third-Party IPAM Endpoint

You can define one or more network ranges of static IP addresses in the network profile for
use in provisioning a machine. If you do not specify a range, you can use a network profile
as a network reservation policy to select a reservation network path for a virtual machine
network card (vNIC).

What to do next

You can assign a network profile to a network path in a reservation or a blueprint architect can
specify the network profile in a blueprint. You can use the external network profile when you
create an on-demand NAT or routed network profile.

Specify External Network Profile InNformation By Using a Third-Party IPAM Endpoint

An external network profile identifies network properties and settings for an existing network. An
external network profile is a requirement of NAT and routed network profiles. If you registered
and configured an IPAM endpoint in vRealize Orchestrator, you can specify that IP address
information be supplied by an IPAM provider.

Prerequisites

m  Verify that you imported and configured an external IPAM provider plug-in in vRealize
Orchestrator and registered the IPAM provider endpoint type in vRealize Orchestrator. In this
example, the supported external IPAM solution provider is Infoblox. See Checklist For
Providing Third-Party IPAM Provider Support.

m Create a Third-Party IPAM Provider Endpoint.

m  Configure the vRealize Orchestrator Appliance with the registered IPAM Endpoint workflow
as the standalone Orchestrator in the global tenant (administrator @ vsphere.local ).

m  Login to vRealize Automation as a fabric administrator.
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Procedure

1 Select Infrastructure > Reservations > Network Profiles.

2 Click New and select Existing or External from the drop-down menu.
3 Enter a name and, optionally, a description.
4

If you have configured one or more third-party IPAM provider endpoints, select a third-party
IPAM endpoint in the IPAM endpoint drop-down menu.

When you select a third-party IPAM provider endpoint that you have registered in vRealize
Orchestrator, IP addresses are obtained from the specified IPAM service provider. IP
specifications such as subnet mask and DNS/WINS options are not available because their
functions are controlled by the selected third-party IPAM endpoint.

What to do next
You can now define network ranges for IP addresses to complete the network profile definition.

Configure External Network Profile IP Ranges By Using a Third-Party IPAM Endpoint

You can define one or more network ranges of static IP addresses in the network profile for use
in provisioning a machine. If you do not specify a range, you can use a network profile as a
network reservation policy to select a reservation network path for a virtual machine network
card (vNIC).

You can define IP ranges by using the IP addresses that are supplied by a third-party IPAM
provider.
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vRealize Automation only saves external IPAM range IDs in the database, not range details. If you
edit a network profile on this page or on a blueprint, vRealize Automation calls the IPAM service
to get range details based on the selected range IDs.

Note There is a known issue with some third-party IPAM providers in which a query can time out
when returning network ranges, resulting in an empty list. As a workaround, you can provide
search criteria to avoid the timeout and obtain the network range information.

For example, depending on your IPAM provider, you may be able to add a property named VLAN
to each network in the IPAM provider application and assign a value to that property, such as 4.
You could then filter on the property and value, for example VLAN=4, in the Select Network

Range text box on the vRealize Automation network profile page.
New Network Profile - External
(Create a netwark profilé B manage one or moné named ranges of static IPvd netwark addressas

General | Network Ranges

Address space: ~ B

X A4 Select Network Range

V0LAN=S 9

_' Staf P - End iP Hama Description

As an alternative, you can increase the timeout setting by using the following procedure:

1 On each of the vRealize Automation appliance cnodes, open the /etc/vcac/webapps/o0lln-
gateway-service/WEB-INF/classes/META-INF/spring/root/olln—-gateway-service-
context.xml file.

2 Change the timeout value from 30 seconds to a higher number.

3 Restart vcac-server by entering service vcac-server restart.

Prerequisites

Specify External Network Profile Information By Using a Third-Party IPAM Endpoint.

Procedure

1 Click the Network Ranges tab to create a new network range or select an existing network
range.

Details about the selected range appear, including each name, description, and start and end
IP address. Status-related information is also provided.

2 Select an address space from the list of all addresses spaces that are available for the
endpoint from the Address space drop-down menu.

3 Click Add and select one or more available network ranges for the specified address space.

Selecting a network range may result in an empty list when using a third-party IPAM provider.
For details, see Knowledge Base article 2148656 at http://kb.vmware.com/kb/2148656.
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4 Click OK.

The IP range name appears in the defined ranges list. The IP addresses in the range appear in
the defined IP addresses list.

The uploaded IP addresses appear on the IP Addresses page when you click Apply or after
you save and then edit the network profile.

5 Click OK to complete the network profile.

What to do next

You can assign a network profile to a network path in a reservation or a blueprint architect can
specify the network profile in a blueprint.

Creating a Routed Network Profile For an On-Demand Network

You can create an on-demand routed network profile that uses either the supplied vRealize
Automation IPAM endpoint or a properly configured and registered third-party IPAM endpoint.

A routed network profile represent routeable IP space that is divided across multiple networks.
Each new routed network allocates the next available subnet from the routable IP space. A
routed network can access all other routed networks that use the same network profile. Each
routed subnet can access all other subnets created by the same network profile.

For a third-party IPAM provider, the routable IP space is created and managed by the third-party
IPAM provider. The network administrator uses a third-party IPAM provider to define a routable
IP space and create an IP block for it. You can select one or more IP blocks retrieved from the
third-party IPAM provider when you create or edit a routed network profile.

When a new instance of a routed network profile is allocated from the third-party IPAM provider,
vRealize Automation calls the provider to reserve the next available subnet and creates a range,
using IP blocks that are determined by the routed network profile and the subnet size. The
resulting range is used to allocate IP addresses for machines that are assigned to the routed
network in the same deployment.

Create a Routed Network Profile By Using the Supplied IPAM Endpoint

When using a routed network profile with the supplied IPAM endpoint, you can define a routable
IP space and available subnets for an on-demand routed network.

Using the supplied vRealize Automation IPAM endpoint, you can assign ranges of static IP
addresses and a base IP address to the routed network profile.
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You can use IP ranges obtained from the supplied VMware IPAM endpoint or from a third-party
IPAM service provider endpoint that you have registered and configured in vRealize
Orchestrator, such as Infoblox IPAM. An IP range is created from an IP block during allocation.

Procedure

1 Specify Routed Network Profile Information with the vRealize Automation IPAM Endpoint

The network profile information identifies the routed network properties, its underlying
external network profile, and other values used in provisioning the network when using the
supplied IPAM endpoint.

2 Configure Routed Network Profile IP Ranges with the vRealize Automation IPAM Endpoint

You can define one or more ranges of static IP addresses for use in provisioning a network.

Specify Routed Network Profile Information with the vRealize Automation IPAM Endpoint

The network profile information identifies the routed network properties, its underlying external
network profile, and other values used in provisioning the network when using the supplied IPAM
endpoint.

If you want to create a routed network profile by using a third-party IPAM endpoint, see Specify
Routed Network Profile Information with a Third-Party IPAM Endpoint.

Prerequisites
m  Login to vRealize Automation as a fabric administrator.

m Create an external network profile. See Create an External Network Profile By Using the
Supplied IPAM Endpoint.

Procedure

)

Select Infrastructure > Reservations > Network Profiles.
Click New and select Routed from the drop-down menu.

Enter a name and, optionally, a description.

Hh W N

Accept the default IPAM endpoint value for the supplied vRealize Automation IPAM
endpoint.

5 Select an existing external network profile from the External Network Profile drop-down
menu.

6 Enter the subnet mask in the Subnet mask text box that is associated with the external
network profile.

The subnet mask specifies the size of the entire routable address space that you want to
define for your network profile.

For example, enter 255.255.0.0.
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Select a value in the Range subnet mask text box drop-down menu to determine how ranges
are generated by the Generate Ranges option on the IP Ranges page.

For example, enter 255.255.255.0.

The range subnet mask defines how you want to partition that space into individual address
blocks that are allocated to every deployment instance of that network profile. When
choosing a value for the range subnet mask, consider the number of deployments that you
expect to use the routed network.

A range is used for each deployment that uses a routed network profile. The number of
available routed ranges is equal to the subnet mask divide by the range subnet mask, for
example 255.255.0.0/255.255.255.0 = 256.

Enter the first available IP address in the Base IP text box.

This option is not available if you select a for third-party endpoint.

For example, enter 120.120.0.1.
Click the DNS tab.
Enter DNS and WINS values as needed.

DNS values are used for DNS name registration and resolution. The DNS and WINS fields are
optional if you are using an internal IPAM endpoint. If you are using an external IPAM
endpoint, the DNS and WINS values are provided by the third-party IPAM provider.

a (Optional) Enter a Primary DNS server value.

b (Optional) Enter a Secondary DNS server value.
c (Optional) Enter a DNS suffixes value.

d (Optional) Enter a DNS search suffixes value.

e (Optional) Enter a Preferred WINS server value.

f  (Optional) Enter an Alternate WINS server value.

What to do next

Configure Routed Network Profile IP Ranges with the vRealize Automation IPAM Endpoint.

Configure Routed Network Profile IP Ranges with the vRealize Automation IPAM Endpoint
You can define one or more ranges of static IP addresses for use in provisioning a network.

During provisioning, every new routed network allocates the next available range and uses it as
its IP space.

Prerequisites

Specify Routed Network Profile Information with the vRealize Automation IPAM Endpoint.
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Procedure

1 Click the Network Ranges tab to create a new network range or select an existing network
range.

Details about the selected range appear, including each name, description, and start and end
IP address. Status-related information is also provided.

2 Click Generate Ranges to generate network ranges based on the subnet mask, range subnet
mask, and base IP address information that you entered on the General tab.

Starting with the base IP address, vRealize Automation generates ranges based on the range
subnet mask.

For example, vRealize Automation generates ranges of 255 IP ranges if the subnet mask is
255.255.0.0 and the range subnet mask is 255.255.255.0 using the name Rangel through
Rangen.

3 Click OK.

Create a Routed Network Profile By Using a Third-Party IPAM Endpoint
When you use a routed network profile with a third-party IPAM endpoint, routable IP space is

created and managed by the third-party IPAM provider.

When you use a third-party IPAM endpoint in your routed network profile, the provider creates
new IP ranges for each instance of the on-demand network.

You can use IP ranges obtained from the supplied VMware IPAM endpoint or from a third-party
IPAM service provider endpoint that you have registered and configured in vRealize
Orchestrator, such as Infoblox IPAM. An IP range is created from an IP block during allocation.

Procedure

1 Specify Routed Network Profile Information with a Third-Party IPAM Endpoint

The network profile information identifies the routed network properties, its underlying
external network profile, and other values used in provisioning the network when using a
third-party IPAM endpoint.

2 Configure Routed Network Profile IP Ranges with a Third-Party IPAM Endpoint

You can manage one or more named ranges of static IPv4 network addresses for use in
provisioning a network.

Specify Routed Network Profile Information with a Third-Party IPAM Endpoint

The network profile information identifies the routed network properties, its underlying external
network profile, and other values used in provisioning the network when using a third-party IPAM
endpoint.

Prerequisites

m  Login to vRealize Automation as a fabric administrator.
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m  Create an external network profile. See Create an External Network Profile By Using the
Supplied IPAM Endpoint or Create an External Network Profile by Using A Third-Party IPAM
Provider.

m  Create and configure a third-party IPAM endpoint. See Create a Third-Party IPAM Provider
Endpoint.

Procedure

-

Select Infrastructure > Reservations > Network Profiles.
Click New and select Routed from the drop-down menu.

Enter a name and, optionally, a description.

H W N

If you have configured one or more third-party IPAM provider endpoints, select a third-party
IPAM endpoint in the IPAM endpoint drop-down menu.

When you select a third-party IPAM provider endpoint that you have registered in vRealize
Orchestrator, IP addresses are obtained from the specified IPAM service provider. IP
specifications such as subnet mask and DNS/WINS options are not available because their
functions are controlled by the selected third-party IPAM endpoint.

5 Select an existing external network profile from the External Network Profile drop-down
menu.

Only external network profiles that are configured to use the specified IPAM endpoint are
listed and available to select.

6 Select a value in the Range subnet mask text box drop-down menu to determine how many
network subnets are created for provisioning.

For example, enter 255.255.255.0.

The range subnet mask defines how you want to partition that space into individual address
blocks that are allocated to every deployment instance of that network profile. When
choosing a value for the range subnet mask, consider the number of deployments that you
expect to use the routed network.

A range is used for each deployment that uses a routed network profile. The number of
available routed ranges is equal to the subnet mask divide by the range subnet mask, for
example 255.255.0.0/255.255.255.0 = 256.

7 Click the IP Blocks tab to define an address space and manage one or more named ranges of

static IPv4 network addresses.

The available IP blocks are the source for IP ranges that are created or allocated for on-
demand routing.

What to do next
Configure Routed Network Profile IP Ranges with a Third-Party IPAM Endpoint.

Configure Routed Network Profile IP Ranges with a Third-Party IPAM Endpoint
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You can manage one or more named ranges of static IPv4 network addresses for use in
provisioning a network.

During provisioning, each new routed network allocates the next available range and uses that
allocated range as its IP space. The IP blocks are obtained from the third-party IPAM provider.
During provisioning, a routed network is allocated from the block with a subnet mask that
matches the provided range subnet mask.

Prerequisites

Specify Routed Network Profile Information with a Third-Party IPAM Endpoint.

Procedure

1 Select an address space from the Address space drop-down menu to limit the available IP
blocks that are available for provisioning.

After you add one or more IP blocks in the section below the Address space text box, you
can no longer select an Address space value. A routed network profile cannot span more
than one address space.

2 Add one or more IP blocks, or IPAM provider ranges, by using the provider-specific search
syntax or selecting from the Search drop-down menu.

The IP blocks are retrieved from the third-party IPAM provider.

Selecting a network range may result in an empty list when using a third-party IPAM provider.
For details, see Knowledge Base article 2148656 at http://kb.vmware.com/kb/2148656.

a Click Add.
b Click Search.
¢ Enter search syntax or select one or more IP blocks from the drop-down menu.
d Click OK.
3 Click Apply.
4 Click OK.

Creating a NAT Network Profile For an On-Demand Network

You can create an on-demand NAT network profile that uses either the supplied vRealize

Automation IPAM endpoint or a properly configured and registered third-party IPAM endpoint.
Create a NAT Network Profile By Using the Supplied IPAM Endpoint
You can create an on-demand NSX NAT network profile r